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Safety information
Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.
Do not place or use this product near water or wet locations.
This product uses a ground fault circuit interrupter (GFCI). Monthly testing of the GFCI is recommended.
CAUTION—POTENTIAL INJURY: This product uses a laser. Use of controls or adjustments or performance of
procedures other than those specified herein may result in hazardous radiation exposure.
This product uses a printing process that heats the print media, and the heat may cause the media to release emissions.
You must understand the section in your operating instructions that discusses the guidelines for selecting print media
to avoid the possibility of harmful emissions.
CAUTION—POTENTIAL INJURY: The lithium battery in this product is not intended to be replaced. There is a
danger of explosion if a lithium battery is incorrectly replaced. Do not recharge, disassemble, or incinerate a
lithium battery. Discard used lithium batteries according to the manufacturer's instructions and local
regulations.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
CAUTION—POTENTIAL INJURY: The printer weighs more than 55 kg (121 lb), and requires at least four persons
or a properly rated mechanical handling system to lift it safely.
CAUTION—POTENTIAL INJURY: Before moving the printer, follow these guidelines to avoid personal injury or
printer damage:

• Turn the printer off using the power switch, and then unplug the power cord from the wall outlet.
• Disconnect all cords and cables from the printer before moving it.
• Lift the printer off the optional drawer, and set it aside instead of trying to lift the drawer and printer at the same
time.
Note: Use the handholds located on both sides of the printer to lift it off the optional drawer.
Use only the power cord provided with this product or the manufacturer's authorized replacement.
Use only the telecommunications (RJ‑11) cord provided with this product or a 26 AWG or larger replacement when
connecting this product to the public switched telephone network.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
CAUTION—SHOCK HAZARD: Make sure that all external connections (such as Ethernet and telephone system
connections) are properly installed in their marked plug-in ports.
This product is designed, tested, and approved to meet strict global safety standards with the use of specific
manufacturer's components. The safety features of some parts may not always be obvious. The manufacturer is not
responsible for the use of other replacement parts.
CAUTION—POTENTIAL INJURY: Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not
subject the power cord to abrasion or stress. Do not pinch the power cord between objects such as furniture
and walls. If any of these things happen, a risk of fire or electrical shock results. Inspect the power cord regularly
for signs of such problems. Remove the power cord from the electrical outlet before inspecting it.
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Refer service or repairs, other than those described in the user documentation, to a professional service person.
CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer, unplug
the power cord from the wall outlet and disconnect all cables from the printer before proceeding.
CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the fax feature, power cord, or telephone, during a lightning
storm.
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input
option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and
faxes, you may need additional furniture. For more information, see www.lexmark.com/multifunctionprinters.
SAVE THESE INSTRUCTIONS.
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Learning about the printer
Thank you for choosing this printer!
We've worked hard to make sure it will meet your needs.
To start using your new printer right away, use the setup materials that came with the printer, and then skim the User’s
Guide to learn how to perform basic tasks. To get the most out of your printer, read the User’s Guide carefully, and
make sure you check the latest updates on our Web site.
We're committed to delivering performance and value with our printers, and we want to make sure you're satisfied. If
you do encounter any problems along the way, one of our knowledgeable support representatives will be delighted to
help you get back on track fast. And if you find something we could do better, please let us know. After all, you are the
reason we do what we do, and your suggestions help us do it better.

Finding information about the printer
What are you looking for?

Find it here

Initial setup instructions:

Setup documentation—The setup documentation came
with the printer and is also available on the Lexmark Web
site at http://support.lexmark.com.

• Connecting the printer
• Installing the printer software
Additional setup and instructions for using the printer:

•
•
•
•
•
•
•
•

Selecting and storing paper and specialty media
Loading paper
Configuring printer settings

User's Guide and Quick Reference Guide—The guides are
available on the Software and Documentation CD.
For updates, visit our Web site at
http://support.lexmark.com.

Viewing and printing documents and photos
Setting up and using the printer software
Configuring the printer on a network
Caring for and maintaining the printer
Troubleshooting and solving problems

Instructions for:

• Connecting the printer to an Ethernet network
• Troubleshooting printer connection problems
Help using the printer software

Networking Guide—Open the Software and
Documentation CD, and then look for Printer and
Software Documentation under the Pubs folder. From
the list of publications, click the Networking Guide link.
Windows or Mac Help—Open a printer software program
or application, and then click Help.
Click

?

to view context‑sensitive information.

Notes:

• Help is automatically installed with the printer
software.

• The printer software is located in the printer
program folder or on the desktop, depending on
your operating system.
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What are you looking for?

Find it here

The latest supplemental information, updates, and customer
support:

Lexmark Support Web site—
http://support.lexmark.com

•
•
•
•
•

Documentation
Driver downloads
Live chat support
E‑mail support
Voice support

Note: Select your country or region, and then select
your product to view the appropriate support site.
Support telephone numbers and hours of operation for
your country or region can be found on the Support Web
site or on the printed warranty that came with your
printer.
Record the following information (located on the store
receipt and at the back of the printer), and have it ready
when you contact customer support so that they may
serve you faster:

•
•
•
•
Warranty information

Machine Type number
Serial number
Date purchased
Store where purchased

Warranty information varies by country or region:

• In the US—See the Statement of Limited Warranty
included with this printer, or at
http://support.lexmark.com.

• In other countries and regions—See the printed
warranty that came with your printer.

Selecting a location for the printer
CAUTION—POTENTIAL INJURY: The printer weighs more than 55 kg (121 lb), and requires at least four persons
or a properly rated mechanical handling system to lift it safely.
When selecting a location for the printer, leave enough room to open trays, covers, and doors. If you plan to install any
options, then leave enough room for them also. It is important to:

• Make sure airflow in the room meets the latest revision of the ASHRAE 62 standard.
• Provide a flat, sturdy, and stable surface.
• Keep the printer:
– Away from the direct airflow of air conditioners, heaters, or ventilators
– Free from direct sunlight, humidity extremes, or temperature fluctuations
– Clean, dry, and free of dust
• Allow the following recommended amount of space around the printer for proper ventilation:
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1
3

1

460 mm (18.1 in.)

2

640 mm (25.2 in.)

3

460 mm (18.1 in.)

4

200 mm (7.9 in.)

5

1724 mm (67.9 in.)

2

Printer configurations
Basic model
1

2

3
4

5

6
7
8

1

Scanner

2

Printer control panel
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Standard exit bin

4

Multipurpose feeder

5

Tray 1 (standard tray)

6

Tray 2

7

Tray 3

8

Tray 4
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Configured model

1

2

1

Finisher

2

High capacity feeder

Basic functions of the scanner
The scanner provides copy, fax, and scan-to-network capability for large workgroups. You can:

•
•
•
•
•

Make quick copies, or change the settings on the printer control panel to perform specific copy jobs.
Send a fax using the printer control panel.
Send a fax to multiple fax destinations at the same time.
Scan documents and send them to your computer, an e-mail address, a flash drive, or an FTP destination.
Scan documents and send them to another printer (PDF by way of FTP).
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Understanding the ADF and scanner glass
Automatic Document Feeder (ADF)

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

You can use the ADF or the scanner glass to scan documents.

Using the ADF
The Automatic Document Feeder (ADF) can scan multiple pages, including duplex pages. When using the ADF:

•
•
•
•
•
•

Load the document into the ADF faceup, short edge first.
Load up to 50 sheets of plain paper in the ADF input tray.
Scan sizes from 148 x 210 mm (5.8 x 8.3 in.) to 215.9 x 355.6 mm (8.5 x 14 in.).
Scan documents with mixed page sizes (letter and legal).
Scan media weights from 52 to 120 g/m2 (14 to 32 lb).
Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine clippings)
into the ADF. Place these items on the scanner glass.

Using the scanner glass
The scanner glass can be used to scan or copy single pages or book pages. When using the scanner glass:

• Place a document facedown on the scanner glass in the upper left corner.
• Scan or copy documents up to 215.9 x 355.6 mm (8.5 x 14 in.).
• Copy books up to 25.4 mm (1 in.) thick.
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Understanding the printer control panel
1
2
1
4

GHI

7

2

ABC

5

JKL

8

3

DEF

6

3

MNO

9

PQRS

TUV

WXYZ

*

ABC

0

#

4
5
6
10

Item

9

8

7

Description

1

Display

View scanning, copying, faxing, and printing options as well as status and error
messages.

2

Keypad

Enter numbers, letters, or symbols on the display.

3

Dial Pause

• Press

to cause a two- or three-second dial pause in a fax number. In the Fax
To field, a Dial Pause is represented by a comma (,).
II

• From the home screen, press II to redial a fax number.
• The button functions only within the Fax menu or with fax functions. When outside
of the Fax menu, fax function, or home screen, pressing
4

Back

II

causes an error beep.

In the Copy menu, press
to delete the right-most digit of the value in the Copy
Count. The default value of 1 appears if the entire number is deleted by pressing
numerous times.
to delete the right-most digit of a number entered
In the Fax Destination List, press
to delete an entire shortcut entry. Once an entire line
manually. You can also press
is deleted, another press of
causes the cursor to move up one line.
to delete the character to the left of the cursor.
In the E-mail Destination List, press
If the character is in a shortcut, then the shortcut is deleted.
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Item

Description

5

Home

6

Start

• Press
to initiate the current job indicated on the display.
• From the home screen, press
to start a copy job with the default settings.
• If pressed while a job is scanning, the button has no effect.

7

Indicator light

•
•
•
•

8

Press

Stop

to return to the home screen.

Off—The power is off.
Blinking green—The printer is warming up, processing data, or printing.
Solid green—The printer is on, but idle.
Blinking red—Operator intervention is needed.

Stops all printer activity
A list of options is offered once Stopped appears on the display.

9

Front USB port

Insert a USB flash drive to send data to the printer.

10

Common Access Card
reader

An option that limits the use of certain printer functions to authenticated users. A
common access card is required for use.

Understanding the home screen
After the printer is turned on and a short warm-up period occurs, the display shows the following basic screen which
is referred to as the home screen. Use the home screen buttons to initiate an action such as copying, faxing, or scanning;
to open the menu screen; or to respond to messages.
1

2
8
HELD JOBS

Ready

Touch any button to begin.

7

6

5

4

3
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Description
Opens the Copy menus
Note: From the home screen, you can also access the Copy menus by pressing a number on
the keypad.

2

E-mail

Opens the E-mail menus

3

Menus

Opens the menus. These menus are available only when the printer is in the Ready state.

4

FTP

Opens the File Transfer Protocol (FTP) menus
Note: This function must be set up by your system support person. Once it is set up, it
appears as a display item.

5

Status message bar

• Shows the current printer status such as Ready or Busy.
• Shows printer conditions such as Toner Low.
• Shows intervention messages to give instructions on what you should do so the printer can
continue processing, such as Close door or Insert print cartridge.

6

Status/Supplies

7

8

Appears on the display whenever the printer status includes a message requiring intervention.
Touch this button to access the messages screen for more information on the message,
including how to clear it.
Opens a context-sensitive Help feature within the display touch screens

Fax

Opens the Fax menus

Other buttons that may appear on the home screen:
Display item

Function

Release Held Faxes

If this button is shown, then there are held faxes with a scheduled hold
time previously set. To access the list of held faxes, touch this button.

Search Held Jobs

Searches on any of the following items and returns search results:

•
•
•
•
•

User names for held or confidential print jobs
Job names for held jobs, excluding confidential print jobs
Profile names
Bookmark container or job names
USB container or job names for supported extensions only

Held Jobs

Opens a screen containing all the held jobs

Lock Device

This button appears on the screen when the printer is unlocked and
Device Lockout Personal Identification Number (PIN) has been set.
Touching this button opens a PIN entry screen. Entering the correct
PIN locks the printer control panel (touch screen and hard buttons).
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Display item

Function

Unlock Device

This button appears on the screen when the printer is locked. The
printer control panel buttons and shortcuts cannot be used while it
appears.
Touching this button opens a PIN entry screen. Entering the correct
PIN unlocks the printer control panel (touch screen and hard buttons).

Cancel Jobs

Opens the Cancel Jobs screen. The Cancel Jobs screen shows three
headings: Print, Fax, and Network.
The following items are available under the Print, Fax, and Network
headings:

•
•
•
•
•

Print job
Copy job
Fax profile
FTP
E-mail send

Each heading has a list of jobs shown in a column under it which can
show only three jobs per screen. Each job appears as a button which
you can touch to access information about the job. If more than three
jobs exist in a column, then an arrow appears enabling you to scroll
through the jobs.

Using the touch-screen buttons
Note: Depending on your options and administrative setup, your screens and buttons may vary from those shown.

Sample touch screen

Button

Function

Home

Returns to the home screen
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Button

Function

Scroll down

Opens a drop‑down list

Left scroll decrease Scrolls to another value in decreasing order

Right scroll increase Scrolls to another value in increasing order

Left arrow

Scrolls left

Right arrow

Scrolls right

Submit

Saves a value as the new user default setting

Back

Navigates back to the previous screen

Other touch-screen buttons
Button

Function

Down arrow

Moves down to the next screen
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Button

Function

Up arrow

Moves up to the next screen

Unselected radio button

This is an unselected radio button. The radio button is gray to show it is unselected.

Selected radio button

This is a selected radio button. The radio button is blue to show it is selected.

Cancel Jobs

Opens the Cancel Jobs screen. The Cancel Jobs screen shows three headings: Print,
Fax, and Network.
The following items are available under the Print, Fax, and Network headings:

•
•
•
•
•

Print job
Copy job
Fax profile
FTP
E-mail send

Each heading has a list of jobs shown in a column under it which can show only three
jobs per screen. Each job appears as a button which you can touch to access
information about the job. If more than three jobs exist in a column, then an arrow
appears enabling you to scroll through the jobs.
Continue

Cancel

Select

Touch this button when more changes need to be made for a job or after clearing
a paper jam.

• Cancels an action or a selection
• Cancels out of a screen and returns to the previous screen

Selects a menu or menu item
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Features
Feature

Description

Menu trail line:

A Menu trail line is located at the top of each menu screen. This feature acts as a
trail, showing the path taken to arrive at the current menu. It gives the exact location
within the menus.

Menus > Settings > Copy Settings >
Number of Copies

Touch any of the underlined words to return to that menu or menu item.
The Number of Copies is not underlined since this is the current screen. If you touch
an underlined word on the Number of Copies screen before the Number of Copies
is set and saved, then the selection is not saved, and it does not become the user
default setting.
Attendance message alert

If an attendance message occurs which closes a function, such as copy or fax, then
a solid red dot appears over the function button on the home screen. This indicates
that an attendance message exists.
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Minimizing your printer's environmental impact
Lexmark is committed to environmental sustainability and is continually improving its printers to reduce their impact
on the environment. We design with the environment in mind, engineer our packaging to reduce materials, and provide
collection and recycling programs. For more information, see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycling
By selecting certain printer settings or tasks, you may be able to reduce your printer's impact even further. This chapter
outlines the settings and tasks that may yield a greater environmental benefit.

Saving paper and toner
Using recycled paper and other office papers
As an environmentally conscious company, Lexmark supports the use of recycled office paper produced specifically for
use in laser (electrophotographic) printers. In 1998, Lexmark presented to the US government a study demonstrating
that recycled paper produced by major mills in the US fed as well as non-recycled paper. However, no blanket statement
can be made that all recycled paper will feed well.
Lexmark consistently tests its printers with recycled paper (20–100% post-consumer waste) and a variety of test paper
from around the world, using chamber tests for different temperature and humidity conditions. Lexmark has found no
reason to discourage the use of today's recycled office papers, but generally the following property guidelines apply
to recycled paper.

• Low moisture content (4–5%)
• Suitable smoothness (100–200 Sheffield units, or 140–350 Bendtsen units, European)
Note: Some much smoother papers (such as premium 24 lb laser papers, 50–90 Sheffield units) and much
rougher papers (such as premium cotton papers, 200–300 Sheffield units) have been engineered to work very
well in laser printers, despite surface texture. Before using these types of paper, consult your paper supplier.

• Suitable sheet-to-sheet coefficient of friction (0.4–0.6)
• Sufficient bending resistance in the direction of feed
Recycled paper, paper of lower weight (<60 g/m2 [16 lb bond]) and/or lower caliper (<3.8 mils [0.1 mm]), and paper
that is cut grain-short for portrait (or short-edge) fed printers may have lower bending resistance than is required for
reliable paper feeding. Before using these types of paper for laser (electrophotographic) printing, consult your paper
supplier. Remember that these are general guidelines only and that paper meeting these guidelines may still cause
paper feeding problems in any laser printer (for example, if the paper curls excessively under normal printing
conditions).
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Saving energy
Adjusting Power Saver
To save energy, you can decrease the number of minutes before the printer enters Power Saver mode.
Available settings range from 1–240 minutes.
Factory default setting

Printer machine type

1 minute

X860

5 minutes

X862

60 minutes

X864

Using the Embedded Web Server
1 Type the printer IP address in the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page or the menu settings
pages and locate the IP address in the TCP/IP section.

2 Click Settings, and then click General Settings.
3 Click Timeouts.
4 In the Power Saver field, enter the number of minutes you want the printer to wait before it enters Power Saver
mode.

5 Click Submit.
Using the printer control panel
1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Settings.
4 Touch General Settings.
5 Touch the arrows until Timeouts appears.
6 Touch Timeouts.
7 Touch the arrows next to Power Saver Mode to select the number of minutes you want the printer to wait
before it enters Power Saver mode.

8 Touch Submit.
9 Touch

.

Reducing printer noise
Use Quiet Mode to reduce the printer noise.
Note: See the table for the multiple settings that change when you select a Quiet Mode setting.
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Choose

To

On

Reduce printer noise.

• Print jobs will process at one‑half the normal processing
speed.

• Printer engine motors do not start until a job is ready to
print. There will be a short delay before the first page is
printed.

• Fans run at reduced speed or are turned off.
• If your printer has faxing capability, fax sounds are
reduced or disabled, including those made by the fax
speaker and ringer. The fax is placed in standby mode.

• The alarm control and cartridge alarm sounds are turned
off.

• The printer will ignore the Advance Start command.
Off

Use factory default settings. This setting supports the
performance specifications for your printer.

To select a Quiet Mode setting:

1 On the home screen, touch

.

2 Touch Settings.
3 Touch General Settings.
4 Touch Quiet Mode.
5 Touch the arrows to select a setting.
6 Touch Submit.
Submitting changes appears.

Recycling
Lexmark provides collection programs and environmentally progressive approaches to recycling. For more information,
see:

• The Notices chapter
• The Environmental Sustainability section of the Lexmark Web site at www.lexmark.com/environment
• The Lexmark recycling program at www.lexmark.com/recycle

Recycling Lexmark products
To return Lexmark products for recycling:

1 Visit our Web site at www.lexmark.com/recycle.
2 Find the product type you want to recycle, and then select your country or region from the list.
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3 Follow the instructions on the computer screen.
Note: Printer supplies and hardware not listed in a Lexmark collection program may be recycled through your local
recycling center. Contact your local recycling center to determine the items they accept.

Returning Lexmark cartridges for reuse or recycling
The Lexmark Cartridge Collection Program diverts millions of Lexmark cartridges from landfills annually by making it
both easy and free for Lexmark customers to return used cartridges to Lexmark for reuse or recycling. One hundred
percent of the empty cartridges returned to Lexmark are either reused or demanufactured for recycling. Boxes used
to return the cartridges are also recycled.
To return Lexmark cartridges for reuse or recycling, follow the instructions that came with your printer or cartridge and
use the prepaid shipping label. You can also do the following:

1 Visit our Web site at www.lexmark.com/recycle.
2 From the Toner Cartridges section, select your country or region from the list.
3 Follow the instructions on the computer screen.
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Additional printer setup
Installing internal options
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
You can customize your printer connectivity and memory capacity by adding optional cards.

Available internal options
• Memory cards
– Printer memory
– Flash memory
– Fonts
• Firmware cards
– Bar Code and Forms
– IPDS and SCS/TNe
– PrintCryptionTM
– PRESCRIBE
• Printer hard disk
• LexmarkTM Internal Solutions Ports (ISP)
– RS-232-C Serial ISP
– Parallel 1284-B ISP
– MarkNetTM N8150802.11 b/g/n Wireless ISP
– MarkNet N8130 10/100 Fiber ISP
– MarkNet N8120 10/100/1000 Ethernet ISP
• MarkNet N8110 V-34 Fax Card
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Accessing the system board to install internal options
Note: This task requires a flathead screwdriver.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Loosen the screw(s) on the access panel located on the back of the printer.

2 Remove the panel from the printer, and set it aside.
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3 Use the illustration below to locate the appropriate connector.
Warning—Potential Damage: System board electronic components are easily damaged by static electricity.
Touch something metal on the printer before touching any system board electronic components or connectors.

1
2

1

Flash memory and firmware card connectors

2

Memory card connector

Installing a memory card
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.
An optional memory card can be purchased separately and attached to the system board. To install the memory card:

1 Access the system board.
Note: This task requires a flathead screwdriver.

2 Unpack the memory card.
Note: Avoid touching the connection points along the edge of the card.
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3 Open the memory card connector latches.

4 Align the notch on the memory card with the ridge on the connector.

5 Push the memory card straight into the connector until it clicks into place.

6 Reattach the system board cover.
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Installing a flash memory or firmware card
The system board has two connections for an optional flash memory or firmware card. Only one of each may be installed,
but the connectors are interchangeable.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
Warning—Potential Damage: System board electronic components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.

1 Access the system board.
Note: This task requires a flathead screwdriver.

2 Unpack the card.
Note: Avoid touching the connection points along the edge of the card.

3 Holding the card by its sides, align the plastic pins on the card with the holes on the system board.
1

2

1

Plastic pins

2

Metal pins

4 Push the card firmly into place.
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Notes:

• The entire length of the connector on the card must touch and be flush against the system board.
• Be careful not to damage the connectors.
5 Reattach the system board cover.

Installing an internal print server or port interface card
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
Warning—Potential Damage: System board electrical components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.
Note: A #2 Phillips screwdriver is needed to install an internal print server or port interface card.
An internal print server allows connection from the printer to the local area network (LAN). An optional port interface
card expands the ways the printer can connect to a computer or external print server.

1 Access the system board.
2 Unpack the internal print server or port interface card.
3 Remove the metal plate on the system board tray that covers the connector slot and save the metal plate.

4 Align the connector on the internal print server or port interface card with the connector on the system board.
Note: The cable connectors on the side of the optional card must fit through the opening in the faceplate.
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5 Push the internal print server or port interface card firmly into the card connector on the system board.
6 Insert a screw into the hole on the right side of the connector slot. Gently tighten the screw to secure the card to
the system board tray.

7 Reinstall the system board.

Installing a printer hard disk
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.
Warning—Potential Damage: System board electrical components and hard disks are easily damaged by static
electricity. Touch something metal on the printer before touching any system board electronic components,
connectors, or the hard disk.
Note: A #2 Phillips screwdriver is needed to attach the hard disk to the mounting plate.

1 Access the system board.
2 Remove the mounting plate, hard disk, ribbon cable, and attachment screws from the package.
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3 Attach the ribbon cable to the hard disk.

4 Attach the mounting plate to the hard disk with the screws.

5 Press the ribbon cable connector into the hard disk connector on the system board.
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6 Flip the hard disk over, and then press the three posts on the mounting plate into the holes on the system board.
The hard disk snaps into place.

7 Reinstall the system board.

Reinstalling the system board
Warning—Potential Damage: System board electrical components are easily damaged by static electricity. Touch
something metal on the printer before touching any system board electronic components or connectors.
Note: This operation requires a #2 Phillips screwdriver.

1 Gently insert the system board into the printer.

1

2
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2 Replace the cover screws, and then turn them clockwise.

3 Tighten the screws firmly.

Installing hardware options
Order of installation
CAUTION—TIPPING HAZARD: Floor-mounted configurations require additional furniture for stability. You must
use either a printer stand or printer base if you are using a high-capacity input tray, a duplex unit and an input
option, or more than one input option. If you purchased a multifunction printer (MFP) that scans, copies, and
faxes, you may need additional furniture. For more information, see www.lexmark.com/multifunctionprinters.
Install the printer and any options you have purchased in the following order:
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

•
•
•
•
•

Printer stand or caster base
2,000‑sheet dual trays and high capacity feeder
Standard or optional 500‑sheet trays
Duplex unit
Printer
CAUTION—POTENTIAL INJURY: The printer weighs more than 55 kg (121 lb), and requires at least four persons
or a properly rated mechanical handling system to lift it safely.

For more information on installing a printer stand, caster base, or 2,000‑sheet tray, see the setup documentation that
came with the option.
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Installing optional trays
The printer supports the following optional input sources:

•
•
•
•

2 Tray Module (two 500‑sheet trays)
2,000‑sheet dual input trays
2,000‑sheet high capacity feeder
Duplex unit
CAUTION—POTENTIAL INJURY: The printer weighs more than 55 kg (121 lb), and requires at least four persons
or a properly rated mechanical handling system to lift it safely.
CAUTION—SHOCK HAZARD: If you are accessing the system board or installing optional hardware or memory
devices sometime after setting up the printer, then turn the printer off, and unplug the power cord from the
wall outlet before continuing. If you have any other devices attached to the printer, then turn them off as well,
and unplug any cables going into the printer.

1 Unpack the optional tray, and remove all packing material.
2 Place the tray in the location chosen for the printer.
Note: If you are installing more than one optional tray, the 2,000‑sheet dual input trays must always be installed
as the first optional trays (configuring from the bottom up).
Note: The optional 500‑sheet trays and optional 2,000‑sheet dual input trays are interchangeable.

4
4

3
3

1
1
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1

Tray 3 and Tray 4 (500-sheet trays or 2,000-sheet dual input trays)

2

Tray 1 and Tray 2 (500-sheet trays)

3

Tray 5 (2,000-sheet high capacity feeder)
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Duplex unit

Note: Optional trays lock together when stacked. Remove stacked trays one at a time from the top down.

3 Align the printer with the tray, and then lower the printer into place.

4 Turn the printer back on.
5 Set the printer software to recognize the optional input source. For more information, see “Updating available
options in the printer driver” on page 39.

Attaching cables
Connect the printer to the computer using a USB cable or Ethernet cable.
Be sure to match the following:

• The USB symbol on the cable with the USB symbol on the printer
• The appropriate Ethernet cable to the Ethernet port
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USB port

Ethernet port

Verifying printer setup
• Print a menu settings page to verify that all printer options are installed correctly. A list of installed options appears
toward the bottom of the page. If an option you installed is not listed, then it is not installed correctly. Remove the
option and install it again.

• Print a network setup page to verify that your printer is correctly connected to the network. This page also provides
important information that aids network printing configuration.

Printing a menu settings page
Print a menu settings page to review the current menu settings and to verify printer options are installed correctly.
Note: If you have not made any menu item settings changes yet, then the menu settings page lists all the factory
default settings. Once you select and save other settings from the menus, they replace the factory default settings as
user default settings. A user default setting remains in effect until you access the menu again, choose another value,
and save it. To restore the factory default settings, see “Restoring the factory default settings” on page 216.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Reports.
4 Touch Menu Settings Page.
The menu settings page prints and the printer returns to the home screen.
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Printing a network setup page
If the printer is attached to a network, then print a network setup page to verify the network connection. This page
also provides important information that aids network printing configuration.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Reports.
4 Touch Network Setup Page.
The network setup page prints and the printer returns to the home screen.

5 Check the first section on the network setup page, and confirm that Status is “Connected.”
If Status is “Not Connected,” the LAN drop may not be active, or the network cable may be malfunctioning. Consult
a system support person for a solution, and then print another network setup page.

Setting up the printer software
Installing the printer software
Notes:

• If you installed the printer software on the computer before but need to reinstall the software, then uninstall
the current software first.

• Close all open software programs before installing the printer software.
1 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using a Software and Documentation CD and the installation dialog does not appear, then do the following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK.

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter, or click OK.
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In Macintosh
Click the CD icon on the desktop.
Note: D is the letter of your CD or DVD drive.

3 Click Install, and then follow the instructions on the computer screen.

Updating available options in the printer driver
When any hardware options are installed, you may need to manually add the options in the printer driver to make
them available for use.

For Windows users
1 Open the printers folder.
In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type control printers > OK
In Windows 7 or earlier

a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type control printers.
c Press Enter, or click OK.
2 Depending on your device, do either of the following:
• Press and hold the printer you want to update.
• Right‑click the printer you want to update.
3 From the menu that appears, do either of the following:
• For Windows 7 or later, select Printer properties.
• For earlier versions, select Properties.
4 Click the Configuration tab.
5 Do either of the following:
• Click Update Now ‑ Ask Printer.
• Under Configuration Options, manually add any installed hardware options.
6 Click Apply.

For Macintosh users
1 From the Apple menu, navigate to either of the following:
• System Preferences > Print & Scan > select your printer > Options & Supplies > Driver
• System Preferences > Print & Fax > select your printer > Options & Supplies > Driver
2 Add any installed hardware options, and then click OK.
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Setting up wireless printing
Follow these instructions if your printer model is wireless.
Note: A Service Set Identifier (SSID) is a name assigned to a wireless network. Wireless Encryption Protocol (WEP)
and Wi-Fi Protected Access (WPA) are types of security used on a network.

Preparing to set up the printer on a wireless network
Notes:

• Make sure your access point (wireless router) is turned on and is working properly.
• Do not connect the installation or network cables until prompted to do so by the setup software.
Make sure you have the following information before setting up the printer on a wireless network:

• SSID—The SSID is also referred to as the network name.
• Wireless Mode (or Network Mode)—The mode is either infrastructure or ad hoc.
• Channel (for ad hoc networks)—The channel defaults to automatic for infrastructure networks.
Some ad hoc networks will also require the automatic setting. Check with your system support person if you are
not sure which channel to select.

• Security Method—There are four basic options for Security Method:
– WEP key
If your network uses more than one WEP key, then enter up to four in the provided spaces. Select the key
currently in use on the network by selecting the default WEP transmit key.

– WPA or WPA2 preshared key or passphrase
WPA includes encryption as an additional layer of security. The choices are AES or TKIP. Encryption must be set
for the same type on the router and on the printer, or the printer will not be able to communicate on the
network.

– 802.1X–RADIUS
If you are installing the printer on an 802.1X network, then you may need the following:

•
•
•
•

Authentication type
Inner authentication type
802.1X user name and password
Certificates

– No security
If your wireless network does not use any type of security, then you will not have any security information.
Note: Using an unsecured wireless network is not recommended.
Notes:

– If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter, and then look for the network name. If you cannot find the SSID or the
security information for your network, then see the documentation that came with the access point or contact
your system support person.
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– To find the WPA/WPA2 preshared key or passphrase for the wireless network, see the documentation that
came with the access point, see the Embedded Web Server associated with the access point, or consult your
system support person.

Installing the printer on a wireless network (Windows)
Before installing the printer on a wireless network, make sure:

• Your wireless network is set up and is working properly.
• The computer you are using is connected to the same wireless network where you want to set up the printer.
1 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.

1

2

Note: Make sure the printer and the computer are fully on and ready.
Warning—Potential Damage: Do not connect the USB cable until instructed to do so on the computer screen.

2 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

3 Double‑click the software installer package.
Wait for the installation dialog to appear.
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If you are using the Software and Documentation CD and the installation dialog does not appear, then do the
following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter or click OK.
Note: D is the letter of your CD or DVD drive.

4 Click Install, and then follow the instructions on the computer screen.
5 Select Wireless connection when asked to choose a connection type.
6 From the Wireless Configuration dialog, select Guided Setup (Recommended).
Note: Choose Advanced Setup only if you want to customize your installation.

7 Temporarily connect a USB cable between the computer on the wireless network and the printer.

Note: After the printer is configured, the software will instruct you to disconnect the temporary USB cable so
you can print wirelessly.

8 Follow the instructions on the computer screen.
Note: For more information on allowing other computers on the network to use the wireless printer, see the
Networking Guide.

Installing the printer on a wireless network (Macintosh)
Note: Make sure to disconnect the Ethernet cable when installing the printer on a wireless network.

Prepare to configure the printer
1 Connect the power cord to the printer, then to a properly grounded electrical outlet, and then turn on the printer.
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1

2

2 Locate the printer MAC address.
a From the printer control panel, navigate to:
> Reports >

> Network Setup Page >

or
> Reports > Network Setup Page

b In the Standard Network Card section, look for UAA (MAC).
Note: You will need this information later.

Enter the printer information
1 Access the AirPort options:
In Mac OS X version 10.5 or later
From the Apple menu, navigate to either of the following:

• System Preferences > Network > Wi‑Fi
• System Preferences > Network > AirPort
In Mac OS X version 10.4
From the Finder, navigate to:
Applications > Internet Connect > AirPort

2 From the Network Name pop‑up menu, select print server [yyyyyy], where the y’s are the last six digits of the MAC
address located on the MAC address sheet.

3 Open a Web browser.
4 From the Bookmarks menu, select Show or Show All Bookmarks.
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5 Under COLLECTIONS, select Bonjour or Rendezvous, and then double‑click the printer name.
Note: The application referred to as Rendezvous in Mac OS X version 10.2 is now called Bonjour by Apple Inc.

6 From the Embedded Web Server, navigate to the location of the wireless settings information.
Configure the printer for wireless access
1 Type the network name (SSID) in the appropriate field.
2 Select Infrastructure as your Network Mode setting if you are using an access point (wireless router).
3 Select the type of security you want to use to protect the wireless network.
4 Enter the security information necessary for the printer to connect to the wireless network.
5 Click Submit.
6 Open the AirPort application on the computer:
In Mac OS X version 10.5 or later
From the Apple menu, navigate to either of the following:

• System Preferences > Network > Wi‑Fi
• System Preferences > Network > AirPort
In Mac OS X version 10.4
From the Finder, navigate to:
Applications > Internet Connect > AirPort

7 From the Network pop‑up menu, select the name of the wireless network.
Configure your computer to use the printer wirelessly
To print on a network printer, each Macintosh user must install a custom printer driver file and create a print queue in
the Printer Setup Utility or Print Center.

1 Install a printer driver file on the computer:
a Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

b
c
d
e
f

Double‑click the installer package for the printer.
Follow the instructions on the computer screen.
Select a destination, and then click Continue.
From the Easy Install screen, click Install.
Type the user password, and then click OK.
All necessary applications are installed in the computer.

g Click Close when the installation is complete.
2 Add the printer:
a For IP printing:
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In Mac OS X version 10.5 or later
1 From the Apple menu, navigate to either of the following:

• System Preferences > Print & Scan
• System Preferences > Print & Fax
2
3
4
5

Click +.
If necessary, click Add Printer or Scanner or Add Other Printer or Scanner.
Click the IP tab.
Type the IP address of the printer in the address field, and then click Add.

In Mac OS X version 10.4
1 From the Finder, navigate to:
Applications > Utilities
2 Double‑click Printer Setup Utility or Print Center.
3 From the Printer List, choose Add, and then click IP Printer.
4 Type the IP address of the printer in the address field, and then click Add.

b For AppleTalk printing:
Notes:

• Make sure AppleTalk is activated on your printer.
• This feature is supported only in Mac OS X version 10.5 or earlier.
In Mac OS X version 10.5
1 From the Apple menu, navigate to:
System Preferences > Print & Fax
2 Click +, and then navigate to:
AppleTalk > select the printer from the list > Add
In Mac OS X version 10.4
1 From the Finder, navigate to:
Applications > Utilities
2 Double‑click Printer Setup Utility or Print Center.
3 From the Printer List, click Add.
4 Click Default Browser tab > More Printers.
5 From the first pop‑up menu, select AppleTalk.
6 From the second pop‑up menu, select Local AppleTalk Zone.
7 Select the printer from the list, and then click Add.

Installing the printer on an Ethernet network
Note: Make sure you have completed the initial setup of the printer.
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For Windows users
1 Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer.
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

2 Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using the Software and Documentation CD and the installation dialog does not appear, then do the
following:

In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier
a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type D:\setup.exe.
c Press Enter or click OK.
Note: D is the letter of your CD or DVD drive.

3 Click Install, and then follow the instructions on the computer screen.
Note: To configure the printer using a static IP address, IPv6, or scripts, select Advanced Options >
Administrator Tools.

4 Select Ethernet connection, and then click Continue.
5 Attach the Ethernet cable when instructed to do so.
6 Select the printer from the list, and then click Continue.
Note: If the configured printer does not appear in the list, then click Modify Search.

7 Follow the instructions on the computer screen.

For Macintosh users
1 Allow the network DHCP server to assign an IP address to the printer.
2 Obtain the printer IP address either:
• From the printer control panel
• From the TCP/IP section in the Network/Ports menu
• By printing a network setup page or menu settings page, and then finding the TCP/IP section
Note: You will need the IP address if you are configuring access for computers on a different subnet than the printer.

3 Install the printer driver on the computer.
a Double‑click the installer package for the printer.
b Follow the instructions on the computer screen.
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c Select a destination, and then click Continue.
d From the Easy Install screen, click Install.
e Type the user password, and then click OK.
All the necessary applications are installed on the computer.

f Click Close when the installation is complete.
4 Add the printer.
• For IP printing:
In Mac OS X version 10.5 or later
a From the Apple menu, navigate to either of the following:
– System Preferences > Print & Scan
– System Preferences > Print & Fax
b Click +.
c If necessary, click Add Printer or Scanner or Add Other Printer or Scanner.
d Click the IP tab.
e Type the printer IP address in the address field, and then click Add.
In Mac OS X version 10.4 or earlier
a From the Finder, navigate to:
Applications > Utilities

b Double‑click Printer Setup Utility or Print Center.
c From the printer list, click Add, and then click IP Printer.
d Type the scanner IP address in the address field, and then click Add.
• For AppleTalk printing:
Notes:

– Make sure AppleTalk is activated on your printer.
– This feature is supported only in Mac OS X version 10.5 or earlier.
In Mac OS X version 10.5
a From the Apple menu, navigate to:
System Preferences > Print & Fax

b Click +, and then navigate to:
AppleTalk > select your printer > Add

In Mac OS X version 10.4 or earlier
a From the Finder, navigate to:
b
c
d
e

Applications > Utilities
Double‑click Printer Setup Utility or Print Center.
From the printer list, click Add.
Click Default Browser tab > More Printers.
From the first pop‑up menu, select AppleTalk.
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f From the second pop‑up menu, select Local AppleTalk Zone.
g Select the device from the list, and then click Add.
Note: If the scanner does not show up in the list, then you may need to add it using the IP address. For more
information, contact your system support person.

Changing port settings after installing a new network Internal
Solutions Port
When a new Lexmark Internal Solutions Port (ISP) is installed in the printer, the printer configurations on computers
that access the printer must be updated since the printer will be assigned a new IP address. All computers that access
the printer must be updated with this new IP address.
Notes:

• If the printer has a static IP address, then you do not need to make any changes to the computer configurations.
• If the computers are configured to use the network name, instead of an IP address, then you do not need to
make any changes to your computer configurations.

• If you are adding a wireless ISP to a printer previously configured for an Ethernet connection, then make sure
the printer is disconnected from the Ethernet network when you configure the printer to operate wirelessly. If
the printer is connected to the Ethernet network, then the wireless configuration completes, but the wireless
ISP is inactive. To activate the wireless ISP, disconnect the printer from the Ethernet network, turn off the
printer, and then turn it back on.

• Only one network connection is active at a time. To switch between Ethernet and wireless connection types,
turn off the printer, connect the cable (to switch to an Ethernet connection) or disconnect the cable (to switch
to a wireless connection), and then turn the printer back on.

For Windows users
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Open the printers folder.
In Windows 8
From the Search charm, type Run and then navigate to:
Apps list > Run > type control printers > OK

In Windows 7 or earlier
a Click
, or click Start and then click Run.
b In the Start Search or Run dialog, type control printers.
c Press Enter, or click OK.
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3 To select the printer that has changed, do either of the following:
• Press and hold the printer, and then select Printer properties.
• Right‑click the printer, and then select Printer properties (Windows 7 or later) or Properties (earlier versions).
Note: If there is more than one copy of the printer, then update all of them with the new IP address.

4 Click the Ports tab.
5 Select the port from the list, and then click Configure Port.
6 Type the new IP address in the “Printer Name or IP Address” field.
7 Click OK > Close.

For Macintosh users
1 Open a Web browser, and then type the printer IP address in the address field.
Notes:

• View the printer IP address on the printer control panel. The IP address appears as four sets of numbers
separated by periods, such as 123.123.123.123.

• If you are using a proxy server, then temporarily disable it to load the Web page correctly.
2 Add the printer.
• For IP printing:
a From the Apple menu, navigate to either of the following:
– System Preferences > Print & Scan
– System Preferences > Print & Fax
b Click +.
c Click the IP tab.
d Type the printer IP address in the address field, and then click Add.
• For AppleTalk printing:
Notes:

– Make sure AppleTalk is activated on your printer.
– This feature is supported only in Mac OS X version 10.5.
a From the Apple menu, navigate to:
System Preferences > Print & Fax

b Click +, and then navigate to:
AppleTalk > select the printer > Add

Setting up serial printing
Use serial printing to print when the computer is far from the printer or to print at a reduced speed.
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After installing the serial or communication (COM) port, configure the printer and the computer. Make sure you have
connected the serial cable to the COM port on your printer.

1 Set the parameters in the printer.
a From the printer control panel, navigate to the menu for the port settings.
b Locate the menu for the serial port settings, and then adjust the settings, if necessary.
c Save the modified settings, and then print a menu settings page.
2 Install the printer driver.
a Obtain a copy of the software installer package.
• From the Software and Documentation CD that came with your printer
• From our Web site:
Go to http://support.lexmark.com, and then navigate to:
SUPPORT & DOWNLOAD > select your printer > select your operating system

b Double‑click the software installer package.
Wait for the installation dialog to appear.
If you are using the Software and Documentation CD and the installation dialog does not appear, then do the
following:

In Windows 8
From the Search charm type run, and then navigate to:
Apps list > Run > type D:\setup.exe > OK

In Windows 7 or earlier
1 Click
or click Start, and then click Run.
2 In the Start Search or Run dialog, type D:\setup.exe.
3 Press Enter or click OK.
Note: D is the letter of your CD or DVD drive.

c
d
e
f
g

Click Install.
Follow the instructions on the computer screen.
Select Advanced, and then click Continue.
From the Configure Printer Connection dialog, select a port.
If the port is not in the list, then click Refresh, or navigate to:
Add port > select a port type > enter the necessary information > OK

h Click Continue > Finish.
3 Set the COM port parameters.
After installing the printer driver, set the serial parameters in the COM port assigned to the printer driver.
Note: Make sure the serial parameters in the COM port match the serial parameters you set in the printer.

a Open Device Manager.

In Windows 8
From the Search charm, type run and then navigate to:
Apps list > Run > type devmgmt.msc > OK

Additional printer setup

In Windows 7 or earlier
1 Click
or click Start, and then click Run.
2 In the Start Search or Run dialog, type devmgmt.msc.
3 Press Enter or click OK.
b Double‑click Ports (COM & LPT) to expand the list of available ports.
c Do either of the following:
• Press and hold the COM port where you attached the serial cable to your computer (example: COM1).
• Right‑click the COM port where you attached the serial cable to your computer (example: COM1).
d From the menu that appears, select Properties.
e On the Port Settings tab, set the serial parameters to the same serial parameters set in the printer.
Check the serial heading of the menu settings page for the printer settings.

f Click OK, and then close all the dialogs.
g Print a test page to verify printer installation.
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Loading paper and specialty media
This section explains how to load the 500- and 2000-sheet trays, and the multipurpose feeder. It also includes
information about paper orientation, setting the Paper Size and Paper Type, and linking and unlinking trays.

Setting the Paper Size and Paper Type
The Paper Size setting is determined by the position of the paper guides in the tray for all trays except the multipurpose
feeder. The Paper Size setting for the multipurpose feeder must be set manually. The factory default Paper Type setting
is Plain Paper. The Paper Type setting must be set manually for all trays that do not contain plain paper.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Paper Menu.
4 Touch Paper Size/Type.
5 Touch the arrows for the desired tray until the correct size or type setting appears.
6 Touch Submit.
7 Touch

to return to the home screen.

Configuring Universal paper settings
The Universal Paper Size is a user‑defined setting that lets you print on paper sizes that are not preset in the printer
menus. Set the Paper Size for the specified tray to Universal when the size you want is not available from the Paper
Size menu. Then, specify all of the following Universal size settings for your paper:

• Units of measure (millimeters or inches)
• Portrait Width
• Portrait Height
Note: The smallest supported Universal size is 98.4 x 89 mm (3.9 x 3.5 in.) ; the largest size is 297 x 431 mm (11.7 x 7
in.)

Specify a unit of measurement
1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Paper Menu.
4 Touch the down arrow until Universal Setup appears, and then touch Universal Setup.
5 Touch the left or right arrow to select the desired unit of measure.
6 Touch Portrait Width or Portrait Height.
7 Touch the arrows to select the desired width or height.
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8 Touch Submit to save your selection.
Submitting Selection appears, followed by the Paper menu.

9 Touch

to return to the home screen.

Loading the standard or optional 500‑sheet trays
The printer has two standard 500‑sheet trays (Tray 1 and Tray 2), and it may have one or more optional 500‑sheet trays.
All 500‑sheet trays support the same paper sizes and types. Paper may be loaded in the trays in either the long‑edge
or short‑edge orientation.

1 Pull the tray completely out.

2 Squeeze and slide the width and length guides to the correct positions for the paper size being loaded.
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3 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

4 Load the paper stack with the recommended print side faceup. Load the paper in either the long‑edge or short‑edge
orientation as shown.
Notes:

• Load sizes larger than A4 in the short‑edge orientation.
• Paper must be loaded in the short‑edge orientation to create booklets if the optional booklet finisher is
installed.
Long‑edge orientation

Short‑edge orientation

5 Make sure the paper guides are secure against the edges of the paper.
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6 Insert the tray.

7 If the paper type you loaded differs from the type that was previously loaded in the tray, then change the Paper
Type setting for the tray.

Loading A5 or Statement paper sizes
The printer trays cannot distinguish between A5‑ (148 x 210 mm) and Statement‑size (139.7 x 215.9 mm) paper when
both sizes are loaded in the printer trays. From the Size Sensing menu, specify which size you want the printer to detect.
Load either A5‑ or Statement‑size paper in the paper trays, but not both.
Note: The multipurpose feeder does not use auto‑size sensing and can support both A5‑ and Statement‑size print
jobs. The Size Sensing setting does not affect the multipurpose feeder settings.

1 Load either A5‑ or Statement‑size paper in a paper tray.
2 Turn the printer off.
3 Hold down

and

6 MNO

while turning the printer on.

4 Release the buttons when the screen with the Progress Bar appears.
The printer performs a power‑on sequence, and then Configuration Menu appears.

5 Touch the up or down arrow button until Size Sensing appears.
6 Touch Size Sensing.
7 Select Statement/A5.
8 Touch the left or right arrow button until the paper size you want appears.
9 Touch Submit.
10 Touch Exit Configuration Menu.

Loading paper and specialty media

56

Loading B5 or Executive paper sizes
The printer trays cannot distinguish between B5‑ and Executive‑size paper when both sizes are loaded in the trays.
From the Size Sensing menu, specify which size you want the printer to detect. Load either B5‑ or Executive‑size paper
in the paper trays, but not both.
Note: The multipurpose feeder does not use auto‑size sensing and can support both B5‑ and Executive‑size print
jobs. The Size Sensing setting does not affect the multipurpose feeder settings.

1 Load either B5‑ or Executive‑size paper in a paper tray.
2 Turn the printer off.
3 Hold down

and

6 MNO

while turning the printer on.

4 Release the buttons when the screen with the Progress Bar appears.
The printer performs a power‑on sequence, and then Configuration Menu appears.

5 Touch the up or down arrow button until Size Sensing appears.
6 Touch Size Sensing.
7 Select Select Executive/B5.
8 Touch the left or right arrow button until the paper size you want appears.
9 Touch Submit.
10 Touch Exit Configuration Menu.

Loading the 2000‑sheet high capacity feeder
The high capacity feeder can hold 2,000 sheets of letter, A4, Executive, and JIS B5 paper (80 g/m2 or 20 lb).

1 Pull the tray out.
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2 If you are loading paper with a different width or length, then adjust the width and length guides.

3 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.
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4 Load paper in the tray with the print side down.

X
MA

• Place pre-punched paper with the holes toward the left side of the tray.
• When loading letterhead, place the header toward the front of the tray.
5 Insert the tray.

Loading the 2,000-sheet dual input trays
The 2,000-sheet dual input drawer includes two trays: an 850-sheet tray and a 1,150-sheet tray. Although the trays are
different in appearance, they require the same process for loading paper.

1 Pull the tray out.
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2 Squeeze the length guide tab inward as shown, and slide the guide to the correct position for the paper size being
loaded.

3 Flex the sheets back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten the
edges on a level surface.

4 Load paper in the tray with the print side up.

Note: Make sure the paper is below the maximum fill line on the rear guide. Overloading may cause jams.

5 Insert the tray.
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Loading the multipurpose feeder
The multipurpose feeder can hold several sizes and types of print media, such as transparencies, postcards, note cards,
and envelopes. It can be used for single-page or manual printing or as an additional tray.
The icons on the multipurpose feeder show you how to load the multipurpose feeder with paper, how to turn an
envelope for printing, and how to load letterhead paper for simplex and duplex printing.
Note: Do not add or remove paper when the printer is printing from the multipurpose feeder or when the printer
control panel indicator light is blinking. Doing so may cause a jam.

1 Lower the multipurpose feeder.

2 Pull the tray extension out.
Note: Do not place objects on the multipurpose feeder. Also, avoid pressing down on it or applying excessive
force to it.

3 Slide the width guides to the outside of the feeder.
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4 Flex the sheets or envelopes back and forth to loosen them, then fan them. Do not fold or crease the paper.
Straighten the edges on a level surface.

5 Load the paper or specialty media into the feeder.
Note: Make sure the paper is below the maximum fill line. Overloading may cause jams.

6 Slide the width guides until they lightly rest against the edge of the paper.

7 Set the Paper Size and Paper Type for the multipurpose feeder (MP Feeder Size and MP Feeder Type) to the correct
value for the print media you loaded. For more information, see “Setting the Paper Size and Paper Type” on page 52.
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Loading letter‑ or A4‑size paper in the short-edge orientation

By default, the printer is set to recognize letter- or A4-size paper loaded in the long-edge orientation. If you want to
load letter- or A4-size paper in the short-edge orientation, make sure you enable Short-edge Printing.

1 Make sure the printer is off.
2 From the printer control panel, press and hold

and

6 MNO

while you turn the printer on.

3 Release both buttons when a progress bar appears on the display.
The printer performs its power-on sequence, and then the Configuration menu appears.

4 Press the up or down arrow until Short-edge Printing appears, and then press the arrow to the right of Short-edge
Printing.

5 Press the left or right arrows until you see Enable, and then press Submit.
Submitting Change appears.

6 Press Back.
7 Press Exit Config Menu.

Linking and unlinking trays
Linking trays
Tray linking is useful for large print jobs or multiple copies. When one linked tray is empty, paper feeds from the next
linked tray. When the Paper Size and Paper Type settings are the same for any trays, the trays are automatically linked.
The Paper Size setting is automatically sensed according to the position of the paper guides in each tray except the
multipurpose feeder. The Paper Size setting for the multipurpose feeder must be set manually from the Paper Size
menu. The Paper Type setting must be set for all trays from the Paper Type menu. The Paper Type menu and the Paper
Size menu are both available from the Paper Size/Type menu.

Unlinking trays
Unlinked trays have settings that are not the same as the settings of any other tray.
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To unlink a tray, change the following tray settings so that they do not match the settings of any other tray:

• Paper Type (for example: Plain Paper, Letterhead, Custom Type <x>)
Paper Type names describe the paper characteristics. If the name that best describes your paper is used by linked
trays, assign a different Paper Type name to the tray, such as Custom Type <x>, or define your own custom name.

• Paper Size (for example: letter, A4, statement)
Load a different paper size to change the Paper Size setting for a tray automatically. Paper Size settings for the
multipurpose feeder are not automatic; they must be set manually from the Paper Size menu.
Warning—Potential Damage: Do not assign a Paper Type name that does not accurately describe the type of paper
loaded in the tray. The temperature of the fuser varies according to the specified Paper Type. Paper may not be
properly processed if an inaccurate Paper Type is selected.

Assigning a custom paper type name
Assign a custom paper type name to a tray when linking or unlinking the tray.

1 Make sure the printer is on and Ready appears.
2 From the home screen, touch

.

3 Touch Paper Menu.
4 Touch Paper Size/Type.
5 Select the tray number or MP Feeder Type.
6 Touch the left or right arrow until Custom Type <x> or another custom name appears.
7 Touch Submit.

Changing a Custom Type <x> name
You can use the Embedded Web Server or MarkVisionTM to define a name other than Custom Type <x> for each of the
custom paper types that are loaded. When a Custom Type <x> name is changed, the menus display the new name
instead of Custom Type <x>.
To change a Custom Type <x> name from the Embedded Web Server:

1 Open a Web browser.
Note: The computer must be connected to the same network as the printer.

2 In the address bar, type the IP address of the network printer (for example,192.264.263.17).
3 Press Enter.
4 From the navigation panel of the initial page, click Configuration.
5 Click Paper Menu.
6 Click Custom Name.
7 Type a name for the paper type in a Custom Name <x> box.
Note: This custom name will replace a custom type <x> name under the Custom Types and Paper Size/Type
menus.
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8 Click Submit.
Submitting Selection appears.

9 Click Custom Types.
Custom Types appears, followed by your custom name.

10 Select a Paper Type setting from the picklist next to your custom name.
11 Click Submit.
Submitting Selection appears.
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Paper guidelines
Paper characteristics
The following paper characteristics affect print quality and reliability. Consider these characteristics when evaluating
new paper stock.

Weight
The printer can automatically feed paper weights from 60 to 220 g/m2 (16 to 58 lb bond) grain long. Paper lighter than
60 g/m2 (16 lb) might not be stiff enough to feed properly, causing jams. For best performance, use 75‑g/m2 (20‑lb
bond) grain long paper. For paper smaller than 182 x 257 mm (7 x 10 in.), we recommend 90 g/m2 (24 lb) or heavier
paper.
Note: Duplex is supported only for 60‑g/m2–120‑g/m2 (16‑lb–32‑lb bond) paper.

Curl
Curl is the tendency for paper to curl at its edges. Excessive curl can cause paper feeding problems. Curl can occur after
the paper passes through the printer, where it is exposed to high temperatures. Storing paper unwrapped in hot, humid,
cold, or dry conditions, even in the trays, can contribute to paper curling prior to printing and can cause feeding
problems.

Smoothness
Paper smoothness directly affects print quality. If paper is too rough, toner cannot fuse to it properly. If paper is too
smooth, it can cause paper feeding or print quality issues. Always use paper between 100 and 300 Sheffield points;
however, smoothness between 150 and 200 Sheffield points produces the best print quality.

Moisture content
The amount of moisture in paper affects both print quality and the ability of the printer to feed the paper correctly.
Leave paper in its original wrapper until it is time to use it. This limits the exposure of paper to moisture changes that
can degrade its performance.
Condition paper before printing by storing it in its original wrapper in the same environment as the printer for 24 to
48 hours before printing. Extend the time several days if the storage or transportation environment is very different
from the printer environment. Thick paper may also require a longer conditioning period.

Grain direction
Grain refers to the alignment of the paper fibers in a sheet of paper. Grain is either grain long, running the length of
the paper, or grain short, running the width of the paper.
For 60‑ to 135‑g/m2 (16‑ to 36‑lb bond) paper, grain long paper is recommended. For papers heavier than 135 g/m2,
grain short is recommended.
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Fiber content
Most high‑quality xerographic paper is made from 100% chemically treated pulped wood. This content provides the
paper with a high degree of stability resulting in fewer paper feeding problems and better print quality. Paper containing
fibers such as cotton can negatively affect paper handling.

Unacceptable paper
The following paper types are not recommended for use with the printer:

• Chemically treated papers used to make copies without carbon paper, also known as carbonless papers, carbonless
copy paper (CCP), or no carbon required (NCR) paper

• Preprinted papers with chemicals that may contaminate the printer
• Preprinted papers that can be affected by the temperature in the printer fuser
• Preprinted papers that require a registration (the precise print location on the page) greater than ±2.3 mm (±0.9 in.),
such as optical character recognition (OCR) forms
In some cases, registration can be adjusted with a software application to successfully print on these forms.

•
•
•
•
•

Coated papers (erasable bond), synthetic papers, thermal papers
Rough‑edged, rough or heavily textured surface papers, or curled papers
Recycled papers that fail EN12281:2002 (European)
Paper weighing less than 60 g/m2 (16 lb)
Multiple‑part forms or documents

Selecting paper
Using appropriate paper prevents jams and helps ensure trouble‑free printing.
To help avoid jams and poor print quality:

• Always use new, undamaged paper.
• Before loading paper, know the recommended print side of the paper. This information is usually indicated on the
paper package.

• Do not use paper that has been cut or trimmed by hand.
• Do not mix paper sizes, types, or weights in the same source; mixing results in jams.
• Do not use coated papers unless they are specifically designed for electrophotographic printing.

Selecting preprinted forms and letterhead
Use these guidelines when selecting preprinted forms and letterhead:

• Use grain long for 64–216 g/m2 (17–58 lb) paper.
• Use only forms and letterhead printed using an offset lithographic or engraved printing process.
• Avoid papers with rough or heavily textured surfaces.
Use papers printed with heat‑resistant inks designed for use in xerographic copiers. The ink must be able to withstand
temperatures up to 230°C (446°F) without melting or releasing hazardous emissions. Use inks that are not affected by
the resin in toner. Inks that are oxidation‑set or oil‑based generally meet these requirements; latex inks might not.
When in doubt, contact the paper supplier.
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Storing paper
Use these paper storage guidelines to help avoid jams and uneven print quality:

• For best results, store paper where the temperature is 21°C (70°F) and the relative humidity is 40%. Most label
manufacturers recommend printing in a temperature range of 18 to 24°C (65 to 75°F) with relative humidity between
40 and 60%.

• Store paper in cartons when possible, on a pallet or shelf, rather than on the floor.
• Store individual packages on a flat surface.
• Do not store anything on top of individual paper packages.

Supported paper sizes, types, and weights
The following tables provide information on standard and optional paper sources and the types of paper they support.
Note: For an unlisted paper size, configure a Universal Paper Size.

Supported paper sizes
Measurements apply to simplex (one‑sided) printing only. For duplex (two‑sided) printing, the minimum size is
139.7 x 210 mm (5.50 x 8.27 in.).

Basic input trays
Paper size

Dimensions

A4

210 x 297 mm (8.27 x 11.7 in.)

A51

148 x 210 mm (5.83 x 8.27 in.)

A62

105 x 148 mm (4.13 x 5.83 in.)

A3

297 x 420 mm (11.7 x 16.5 in.)

Statement1, 2

139.7 x 215.9 mm (5.5 x 8.5 in.)

Oficio (México)2

215.9 x 340.4 mm (8.5 x 13.4 in.)

JIS B53

182 x 257 mm (7.17 x 10.1 in.)

JIS B4

257 x 364 mm (10.1 x 14.3 in.)

Standard 500‑sheet trays (Tray 1 Multipurpose feeder
and Tray 2)

X

1 The printer trays cannot distinguish between A5‑

and statement‑size paper when both sizes are loaded in the printer trays.
From the Size Sensing menu, specify which size you want the printer to detect. Load either A5‑ or statement‑size paper in
the paper trays, but not both.

2
3

This paper size is supported only when the source is non‑size sensing or when size sensing is disabled.

The printer trays cannot distinguish between B5‑ and Executive‑size paper when both sizes are loaded in the trays. From
the Size Sensing menu, specify which size you want the printer to detect. Load either B5‑ or Executive‑size paper in the
paper trays, but not both.
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Dimensions

Letter

215.9 x 279.4 mm (8.5 x 11 in.)

Tabloid

279.4 x 431.8 mm (11 x 17 in.)

Legal

215.9 x 355.6 mm (8.5 x 14 in.)

Executive3

184.2 x 266.7 mm
(7.25 x 10.5 in.)

Folio

215.9 x 330.2 mm (8.5 x 13 in.)

Universal

182 x 431 mm (7.1 x 16.9 in.) to
139.7 x 297 mm (5.5 x 11.7 in.)
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Standard 500‑sheet trays (Tray 1 Multipurpose feeder
and Tray 2)

Note: Turn size
sensing off to
98.4 x 431.8 mm (3.8 x 17 in.) to
support universal
89 x 297 mm (3.5 x 11.7 in.) for
sizes that are close to the multipurpose feeder only.
standard media sizes.
148 x 431.8 mm (5.83 x 17 in.) to
140 x 297.2 mm (5.51 x 11.7 in.)
for the duplex unit only.
7 3/4 Envelope
(Monarch)

98.4 x 190.5 mm (3.875 x 7.5 in.) X

10 Envelope

104.8 x 241.3 mm (4.12 x 9.5 in.) X

DL Envelope

110 x 220 mm (4.33 x 8.66 in.)

X

C5 Envelope

162 x 229 mm (6.38 x 9.01 in.)

X

Other Envelope

98.4.7 x 431.8 mm (3.8 x 17 in.) X
to 89 x 297 mm (3.5 x 11.7 in.)

1 The printer trays cannot distinguish between A5‑

and statement‑size paper when both sizes are loaded in the printer trays.
From the Size Sensing menu, specify which size you want the printer to detect. Load either A5‑ or statement‑size paper in
the paper trays, but not both.

2
3

This paper size is supported only when the source is non‑size sensing or when size sensing is disabled.

The printer trays cannot distinguish between B5‑ and Executive‑size paper when both sizes are loaded in the trays. From
the Size Sensing menu, specify which size you want the printer to detect. Load either B5‑ or Executive‑size paper in the
paper trays, but not both.
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Optional input trays
Paper size

Dimensions

Optional
2,000‑sheet dual
input trays

Optional 2,000‑sheet high Duplex unit
capacity feeder

A4

210 x 297 mm
(8.27 x 11.7 in.)

A51

148 x 210 mm
(5.83 x 8.27 in.)

X

X

A62

105 x 148 mm
(4.13 x 5.83 in.)

X

X

A3

297 x 420 mm
(11.7 x 16.5 in.)

X

X

Statement1, 2

139.7 x 215.9 mm
(5.5 x 8.5 in.)

X

X

Oficio (México)2

215.9 x 340.4 mm
(8.5 x 13.4 in.)

X

X

JIS B53

182 x 257 mm
(7.17 x 10.1 in.)

JIS B4

257 x 364 mm
(10.1 x 14.3 in.)

X

X

Letter

215.9 x 279.4 mm
(8.5 x 11 in.)

Tabloid

279.4 x 431.8 mm
(11 x 17 in.)

X

X

Legal

215.9 x 355.6 mm
(8.5 x 14 in.)

X

X

Executive3

184.2 x 266.7 mm
(7.25 x 10.5 in.)

Folio

215.9 x 330.2 mm
(8.5 x 13 in.)

X

X

X

1 The printer trays cannot distinguish between A5‑

and statement‑size paper when both sizes are loaded in the printer trays.
From the Size Sensing menu, specify which size you want the printer to detect. Load either A5‑ or statement‑size paper in
the paper trays, but not both.

2
3

This paper size is supported only when the source is non‑size sensing or when size sensing is disabled.

The printer trays cannot distinguish between B5‑ and Executive‑size paper when both sizes are loaded in the trays. From
the Size Sensing menu, specify which size you want the printer to detect. Load either B5‑ or Executive‑size paper in the
paper trays, but not both.
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Paper size

Dimensions

Optional
2,000‑sheet dual
input trays

Optional 2,000‑sheet high Duplex unit
capacity feeder

Universal

182 x 431 mm
(7.1 x 16.9 in.) to
139.7 x 297 mm
(5.5 x 11.7 in.)

X

X

X

98.4 x 431.8 mm
X
(3.8 x 17 in.) to
89 x 297 mm
(3.5 x 11.7 in.) for the
multipurpose feeder
only.

X

X

148 x 431.8 mm
X
(5.83 x 17 in.) to
140 x 297.2 mm
(5.51 x 11.7 in.) for the
duplex unit only.

X

7 3/4 Envelope
(Monarch)

98.4 x 190.5 mm
(3.875 x 7.5 in.)

X

X

X

10 Envelope

104.8 x 241.3 mm
(4.12 x 9.5 in.)

X

X

X

DL Envelope

110 x 220 mm
(4.33 x 8.66 in.)

X

X

X

C5 Envelope

162 x 229 mm
(6.38 x 9.01 in.)

X

X

X

Other Envelope

98.4.7 x 431.8 mm
(3.8 x 17 in.) to
89 x 297 mm
(3.5 x 11.7 in.)

X

X

X

Note: Turn size
sensing off to
support universal
sizes that are close
to standard media
sizes.

1 The printer trays cannot distinguish between A5‑

and statement‑size paper when both sizes are loaded in the printer trays.
From the Size Sensing menu, specify which size you want the printer to detect. Load either A5‑ or statement‑size paper in
the paper trays, but not both.

2

This paper size is supported only when the source is non‑size sensing or when size sensing is disabled.

3

The printer trays cannot distinguish between B5‑ and Executive‑size paper when both sizes are loaded in the trays. From
the Size Sensing menu, specify which size you want the printer to detect. Load either B5‑ or Executive‑size paper in the
paper trays, but not both.

Supported paper types and weights
The printer engine supports 38–128 g/m2 (16–32 lb) paper weights.
Note: Labels, transparencies, envelopes, and card stock always print at reduced speed.
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Paper type

Standard
Multipurpose
500‑sheet trays tray
(Tray 1 and Tray
2)
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Optional
500‑sheet
trays

Optional
2,000‑sheet
dual input
trays

Optional
2,000‑sheet
high capacity
feeder

Duplex unit

Paper
Card stock
Transparencies

X

Paper Labels
Bond
Letterhead
Envelopes

X

X

X

X

X
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Printing
This chapter covers printing, printer reports, and job cancelation. Selection and handling of paper and specialty media
can affect how reliably documents print. For more information, see “Avoiding jams” on page 233 and “Storing paper”
on page 67.

Printing a document
1 Load paper into a tray or drawer.
2 From the Paper menu, set the Paper Type and Paper Size to the type and size of paper you have loaded.
3 Do one of the following:

For Windows users
a
b
c
d
e
f

With a document open, click File > Print.
Click Properties, Preferences, Options, or Setup.
From the Form Source list box, select the source containing the paper you have loaded.
From the Form Type list box, select the type of paper you have loaded.
From the Form Size list box, select the size of paper you have loaded.
Click OK, and then click Print.

For Macintosh users
In Mac OS X:

a Customize the settings as needed in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 From the Paper Size pop‑up menu, choose a paper size that matches the size of the loaded paper, or create
a custom size.

3 Click OK.
b Customize the settings as needed in the Print dialog:
1 With a document open, click File > Print.
2
3
4
5

If necessary, click the disclosure triangle to see more options.
From the print options or Copies & Pages pop‑up menu, choose Printer Features.
From the Feature Sets pop‑up menu, choose Paper.
From the Paper type pop‑up menu, choose a paper type.
Click Print.

In Mac OS 9:

a Customize the settings as needed in the Page Setup dialog:
1 With a document open, choose File > Page Setup.
2 From the Paper pop‑up menu, choose a paper size or create a custom size to match the loaded paper.
3 Click OK.
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b Customize the settings as needed in the Print dialog:
1 With a document open, choose File > Print.
2 Select a Paper Source option, and then choose the tray loaded with the appropriate paper.
3 Click Print.

Printing on specialty media
Tips on using letterhead
Check with the manufacturer or vendor to determine whether the chosen preprinted letterhead is acceptable for laser
printers.

Placing paper in the trays
Page orientation is important when printing on letterhead. Use the following sections to determine which direction to
load the letterhead.
Source or process

Print side

Standard 500‑sheet trays

Preprinted letterhead design is placed faceup.

Optional 500‑sheet trays
Optional 2,000‑sheet dual input trays
Optional 2,000‑sheet high capacity feeder Preprinted letterhead design is placed facedown.
Multipurpose tray (simplex printing)

Preprinted letterhead design is placed facedown.

Duplex (two‑sided) printing from trays

Preprinted letterhead design is placed facedown.
Sheet placement is faceup in the 2,000‑sheet high capacity feeder and the
multipurpose feeder.

Orienting the paper for long‑ or short‑edge printing
Paper trays
Short‑edge orientation

Long‑edge orientation

With finisher

With finisher
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Short‑edge orientation

Long‑edge orientation

Without finisher

Without finisher

High capacity feeder
Without finisher

With finisher

Simplex (one-sided) printing

Simplex (one-sided) printing

AB

C

C

AB

AB

C

Duplex (two-sided) printing

Duplex (two-sided) printing
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Multipurpose tray
Simplex (one-sided) printing

Duplex (two-sided) printing

Tips on using transparencies
Print samples on the transparencies being considered for use before buying large quantities.

• Feed transparencies from the standard tray or the multipurpose feeder.
• From the Paper menu, set the Paper Type to Transparency.
• Use transparencies designed specifically for laser printers. Transparencies must be able to withstand temperatures
of 230°C (446°F) without melting, discoloring, offsetting, or releasing hazardous emissions.

• To prevent print quality problems, avoid getting fingerprints on the transparencies.
• Before loading transparencies, fan the stack to prevent sheets from sticking together.
• We recommend Lexmark transparencies. For ordering information, see the Lexmark Web site at
www.lexmark.com.

Tips on using envelopes
Print samples on the envelopes being considered for use before buying large quantities.

• Use envelopes designed specifically for laser printers. Check with the manufacturer or vendor to ensure that the
envelopes can withstand temperatures up to 220°C (446°F) without sealing, wrinkling, curling excessively, or
releasing hazardous emissions.

• For best performance, use envelopes made from 90 g/m2 (24 lb bond) paper or 25% cotton. All‑cotton envelopes
must not exceed 70 g/m2 (20 lb bond) weight.

• Use only new envelopes from undamaged packages.
• To optimize performance and minimize jams, do not use envelopes that:
– Have excessive curl or twist
– Are stuck together or damaged in any way
– Have windows, holes, perforations, cutouts, or embossing
– Have metal clasps, string ties, or folding bars
– Have an interlocking design
– Have postage stamps attached
– Have any exposed adhesive when the flap is in the sealed or closed position
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– Have bent corners
– Have rough, cockle, or laid finishes
• Adjust the width guides to fit the width of the envelopes.
Note: A combination of high humidity (over 60%) and the high printing temperature may wrinkle or seal envelopes.

Tips on using labels
Print samples on the labels being considered for use before buying large quantities.
Note: Paper labels are supported. Other media such as vinyl may show print quality defects in some environments,
and prolonged vinyl label usage may reduce fuser life.
For detailed information on label printing, characteristics, and design, see the Card Stock & Label Guide available on
the Lexmark Web site at http://support.lexmark.com.
When printing on labels:

• Use labels designed specifically for laser/LED printers. Check with the manufacturer or vendor to verify that:
– The labels can withstand temperatures up to 190°C (374°F) without sealing, excessive curling, wrinkling, or
releasing hazardous emissions.

– Label adhesives, face sheet (printable stock), and topcoats can withstand up to 25 psi (172 kPa) pressure without
delaminating, oozing around the edges, or releasing hazardous fumes.

• Do not use labels with slick backing material.
• Use full label sheets. Partial sheets may cause labels to peel off during printing, resulting in a jam. Partial sheets
also contaminate the printer and the cartridge with adhesive, and could void the printer and cartridge warranties.

• Do not use labels with exposed adhesive.
• Do not print within 1 mm (0.04 in.) of the edge of the label, of the perforations, or between die‑cuts of the label.
• Be sure adhesive backing does not reach to the sheet edge. Zone coating of the adhesive at least 1 mm (0.04 in.)
away from edges is recommended. Adhesive material contaminates the printer and could void the warranty.

• If zone coating of the adhesive is not possible, remove a 1.6 mm (0.06 in.) strip on the leading and driver edge, and
use a non‑oozing adhesive.

• Portrait orientation works best, especially when printing bar codes.

Tips on using card stock
Card stock is heavy, single‑ply specialty media. Many of its variable characteristics, such as moisture content, thickness,
and texture, can significantly impact print quality. Print samples on the card stock being considered for use before
buying large quantities.

• From the Paper menu, set the Paper Type to Card Stock.
• Select the appropriate Paper Texture setting.
• Be aware that preprinting, perforation, and creasing may significantly affect the print quality and cause jams or
other paper handling problems.

• Check with the manufacturer or vendor to ensure the card stock can withstand temperatures up to 220°C (446°F)
without releasing hazardous emissions.

• Do not use preprinted card stock manufactured with chemicals that may contaminate the printer. Preprinting
introduces semi‑liquid and volatile components into the printer.

• Use grain short card stock when possible.
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Printing confidential and other held jobs
Holding jobs in the printer
When sending a job to the printer, you can specify that you want the printer to hold the job in memory until you start
the job from the printer control panel. All print jobs that can be initiated by the user at the printer are called held jobs.
Note: Confidential, Verify, Reserve, and Repeat print jobs may be deleted if the printer requires extra memory to
process additional held jobs.
Job type

Description

Confidential

When you send a Confidential print job to the printer, you must create a PIN from
the computer. The PIN must be four digits using the numbers 0–9. The job is held
in printer memory until you enter the PIN from the printer control panel and
choose to print or delete the job.

Verify

When you send a Verify print job, the printer prints one copy and holds the
remaining copies in printer memory. Verify lets you examine the first copy to see
if it is satisfactory before printing the remaining copies. Once all copies are printed,
the job is automatically deleted from printer memory.

Reserve

When you send a Reserve print job, the printer does not print the job immediately.
It stores the job in memory so you can print the job later. The job is held in memory
until you delete it from the Held Jobs menu.

Repeat

When you send a Repeat print job, the printer prints all requested copies of the
job and stores the job in memory so you can print additional copies later. You can
print additional copies as long as the job remains stored in memory.

Other types of held jobs include:

•
•
•
•

Profiles from various sources including Lexmark Document Solutions Suite (LDSS)
Forms from a kiosk
Bookmarks
Jobs not printed, which are called parked jobs

Printing confidential and other held jobs from Windows
Note: Confidential and Verify print jobs are automatically deleted from memory after they print. Repeat and Reserve
jobs continue to be held in the printer until you choose to delete them.

1 With a document open, click File > Print.
2 Click Properties, Preferences, Options, or Setup.
3 Click Other Options, and then click Print and Hold.
4 Select your job type (Confidential, Reserve, Repeat, or Verify), and then assign a user name. For a confidential job,
also enter a four‑digit PIN.

5 Click OK or Print, and then go to the printer to release the job.
6 On the home screen, touch Held jobs.
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7 Touch your user name.
Note: A maximum of 500 results can be displayed for held jobs. If your name does not appear, touch the down
arrow until your name appears, or touch Search Held Jobs if there are a large number of held jobs in the printer.

8 Touch Confidential Jobs.
9 Enter your PIN.
10 Touch the job you want to print.
11 Touch Print, or touch the arrows to increase or decrease the number of copies, and then touch Print.

Printing confidential and other held jobs from a Macintosh computer
Note: Confidential and Verify print jobs are automatically deleted from memory after they print. Repeat and Reserve
jobs continue to be held in the printer until you choose to delete them.

1 With a document open, choose File > Print.
If necessary, click the disclosure triangle to see more options.

2 From the print options or Copies & Pages pop‑up menu, choose Job Routing.
3 Select your job type (Confidential, Reserve, Repeat, or Verify), and then assign a user name. For a confidential job,
also enter a four‑digit PIN.

4 Click OK or Print, and then go to the printer to release the job.
5 On the home screen, touch Held jobs.
6 Touch your user name.
Note: A maximum of 500 results can be displayed for held jobs. If your name does not appear, touch the down
arrow until your name appears, or touch Search Held Jobs if there are a large number of held jobs in the printer.

7 Touch Confidential Jobs.
8 Enter your PIN.
9 Touch the job you want to print.
10 Touch Print, or touch the arrows to increase or decrease the number of copies, and then touch Print.
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Printing from a flash drive
A USB port is located on the printer control panel. Insert a flash drive to print supported file types. Supported file types
include: .pdf, .gif, .jpeg, .jpg, .bmp, .png, .tiff, .tif, .pcx, .html, .xps, and .dcx.
Lexmark has tested and approved the following USB flash memory devices:

•
•
•
•
•
•

Lexar FireFly 512 MB
Lexar FireFly 1 GB
SanDisk Cruizer Micro 512 MB
SanDisk Cruizer Micro 1 GB
Sony 512 MB
Sony 1 GB

Notes:

• Hi‑Speed flash drives must support the USB 2.0 specification, specifically supporting the High Speed mode.
• USB devices must support the FAT (File Allocation Tables) system. Devices formatted with NTFS (New
Technology File System) or any other file system are not supported.

• If selecting an encrypted .pdf file, then enter the file password from the printer control panel.
• Before printing an encrypted .pdf file, enter the file password from the printer control panel.
• You cannot print files for which you do not have printing permissions.
1 Make sure the printer is on and Ready appears.
2 Insert a flash drive into the USB port.

Notes:

• If you insert the flash drive when the printer requires attention, such as when a jam has occurred, then the
printer ignores the flash drive.

• If you insert the flash drive while the printer is printing other jobs, then Printer Busy appears. After the
other jobs are processed, you may need to view the held jobs list to print documents from the flash drive.
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3 Touch the document you want to print.
Note: Folders found on the flash drive appear as folders. File names are appended by the extension type (for
example, .jpg).

4 Touch the arrows if you want to increase the number of printed copies.
5 Touch Print.

Printing information pages
Printing a font sample list
To print samples of the fonts currently available for your printer:

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch Menus.
3 Touch Reports.
4 Touch the up or down arrow until Print Fonts appears, and then touch Print Fonts.
5 Touch PCL Fonts or PostScript Fonts.

Printing a directory list
A directory list shows the resources stored in flash memory or on the printer hard disk.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Reports.
4 Touch the down arrow until Print Directory appears.
5 Touch Print Directory.

Printing the print quality test pages
Print the print quality test pages to isolate print quality problems.

1 Turn the printer off.
2 Hold down

and

6 MNO

while turning the printer on.

3 Release the buttons when the screen with the progress bar appears.
The printer performs a power‑on sequence, and then the Configuration menu appears.

4 Touch the down arrow until Print Quality Pages appears.
5 Touch Print Quality Pages Menu.
6 Touch Print Quality Pages.
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Canceling a print job
Canceling a print job from the printer control panel
1 Touch Cancel Jobs on the touch screen, or press

on the keypad.

2 Touch the job you want to cancel.
3 Touch Delete Selected Jobs.

Canceling a print job from the computer
For Windows users
1 Open the printers folder.
In Windows 8
From the Search charm, type run, and then navigate to:
Apps list > Run > type control printers > OK
In Windows 7 or earlier

a Click
or click Start, and then click Run.
b In the Start Search or Run dialog, type control printers.
c Press Enter, or click OK.
2 Double‑click the printer icon.
3 Select the print job you want to cancel.
4 Click Delete.

For Macintosh users
1 From the Apple menu, navigate to either of the following:
• System Preferences > Print & Scan > select your printer > Open Print Queue
• System Preferences > Print & Fax > select your printer > Open Print Queue
2 From the printer window, select the print job you want to cancel, and then delete it.
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Supported finishing features
1
2
3

4

1

Standard bin

2

Finisher Bin 1

3

Finisher Bin 2

4

Finisher Bin 3

Standard bin
• The paper capacity is 300 sheets.
• Finishing options are not supported in this bin.
• Envelopes are routed here.

Finisher Bin 1
• The paper capacity is 500 sheets of A4/Letter and 300 sheets of A3/Ledger.
• Envelopes, A5, A6 and Statement are not supported in this bin.
• Finishing options are not supported in this bin.

Finisher Bin 2
• The paper capacity is 3,000 sheets when the standard finisher is installed.
• If booklet finisher is installed, capacity is reduced to 1,500 sheets.
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Finisher Bin 2 finishing features
Size

Two‑hole punch*

Three‑ or
Four‑hole punch

Offset

Single staple

Dual staple

A3
A4
Note: Supported
only if feeding
orientation is long
edge.
A5

X

X

Note: Supported
only if feeding
orientation is long
edge.
X

X

X

Executive
Folio

X

JIS B4
JIS B5
Legal

X

Letter
Note: Supported
only if feeding
orientation is long
edge.
Statement

X

X

Universal

X

X

Envelopes (any
size)

X

X

Note: Supported
only if feeding
orientation is long
edge.
X

X

X

X

Tabloid

Oficio

X

X

* For

the Universal paper size, the finishing edge must be at least 9 in. (229 mm) for a 3‑hole punch and 10 in. (254 mm) for
a 4‑hole punch.
Punch—Two‑, three‑, or four‑hole punch settings
Single staple—One staple
Dual staple—Two staples

Finisher Bin 3
Bin 3 is available only when the booklet finisher is installed. The paper capacity of Bin 3 (booklet‑maker) is 1,500 sheets
or 18 sets of 15‑page booklets.
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Bin 3 finishing features
Size

Bi fold

Booklet fold

Saddle staple

A5

X

X

X

Executive

X

X

X

X

X

X

X

X

X

Universal

X

X

X

Envelopes (any size)

X

X

X

A3
A4 (only SEF)

Folio
JIS B4
JIS B5
Legal
Letter (only SEF)
Statement
Tabloid

SEF—The paper is loaded in the short edge orientation. The short edge of the paper enters the printer first.
Bi fold—Each page is individually folded and stacked separately.
Booklet fold—A multiple-page job is folded along the center into a single booklet.
Saddle staple—A booklet‑fold print job is stapled along the center fold.

Adjusting toner darkness
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Print Settings.
4 Click Quality Menu.
5 Adjust the toner darkness setting.
6 Click Submit.
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Copying
ADF

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

Making copies
Making a quick copy
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 From the printer control panel, press

.

4 If you placed the document on the scanner glass, then touch Finish the Job to return to the home screen.

Copying using the ADF
1 Load an original document faceup, short edge first into the ADF.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 Adjust the paper guides.
3 On the home screen, touch Copy, or use the keypad to enter the number of copies.
The copy screen appears.

4 Change the copy settings as needed.
5 Touch Copy It.
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Copying using the scanner glass
1 Place an original document facedown on the scanner glass in the upper left corner.
2 On the home screen, touch Copy, or use the keypad to enter the number of copies.
The copy screen appears.

3 Change the copy settings as needed.
4 Touch Copy It.
5 If you have more pages to scan, then place the next document on the scanner glass, and then touch Scan the Next
Page.

6 Touch Finish the Job to return to the home screen.

Copying photos
1 Place a photo facedown on the scanner glass in the upper left corner.
2 On the home screen, touch Copy.
3 Touch the left or right arrow under Content to select Photo.
4 Touch Copy It.

Copying on specialty media
Making transparencies
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Copy from, and then identify the size of the original document.
5 Touch Copy to, and then touch the tray that contains transparencies, or touch Manual Feeder and then place
transparencies in the multipurpose feeder.

6 Touch the desired size of the transparencies, and then touch Continue.
7 Touch the arrows until Transparency appears.
8 Touch Transparency, and then touch Continue.
9 Touch Copy It.
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Copying to letterhead
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Copy from, and then identify the size of the original document.
5 Touch Copy to, and then touch Manual Feeder and place letterhead face down, top edge first in the multipurpose
feeder.

6 Touch the desired size of the letterhead, and then touch Continue.
7 Touch the arrows until Letterhead appears.
8 Touch Letterhead, and then touch Continue.
9 Touch Copy It.

Customizing copy settings
Copying from one size to another
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Copy from, and then identify the size of the original document.
5 Touch Copy to, and then select the size you want the copy to be.
Note: If you select a paper size that is different from the “Copy from” size, then the printer will scale the size
automatically.

6 Touch Copy It.

Making copies using paper from a selected tray
During the copy process, you can select the tray that contains the paper type of choice. For example, if specialty media
is located in the multipurpose feeder, and you want to make copies on that media:

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
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3 On the home screen, touch Copy.
4 Touch Copy from, and then identify the size of the original document.
5 Touch Copy to, and then touch Manual Feeder or the tray that contains the paper type you want.
Note: If you choose Manual Feeder, then you will need to also select the paper size and type.

6 Touch Copy It.

Copying a document that contains mixed paper sizes
Use the ADF to copy an original document that contains mixed paper sizes. Depending on the paper sizes loaded and
the “Copy to” and “Copy from” settings, each copy is either printed on mixed paper sizes (Example 1) or scaled to fit a
single paper size (Example 2).

Example 1: Copying to mixed paper sizes
The printer has two paper trays, one tray loaded with letter‑size paper and the other with legal‑size paper. A document
that contains letter‑ and legal‑size pages needs to be copied.

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Copy from, and then touch Auto Size Sense.
5 Touch Copy to, and then touch Auto Size Match.
6 Touch Copy It.
The scanner identifies the mixed paper sizes as they scan. Copies are printed on mixed paper sizes corresponding
to the paper sizes of the original document.

Example 2: Copying to a single paper size
The printer has one paper tray, loaded with letter-size paper. A document that contains letter‑ and legal‑size pages
needs to be copied.

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Copy from, and then touch Mixed Sizes.
5 Touch Copy to, and then touch Letter.
6 Touch Copy It.
The scanner identifies the mixed paper sizes as they scan and then scales the legal‑size pages to print on letter‑size
paper.
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Copying on both sides of the paper (duplexing)
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, adjust the paper guides.
3 On the home screen, touch Copy.
4 From the Sides (Duplex) area, touch the button that looks the way you want your copies duplexed.
The first number represents sides of the original documents; the second number represents sides of the copy. For
example, select 1‑sided to 2‑sided if you have 1-sided original documents and you want 2‑sided copies.

5 Touch Copy It.

Reducing or enlarging copies
Copies can be reduced to 25% of the original document size or enlarged to 400% of the original document size. The
factory default setting for Scale is Auto. If you leave Scale set to Auto, the content of your original document will be
scaled to fit the size of the paper onto which you are copying.
To reduce or enlarge a copy:

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 From the Scale area, touch the arrows to enlarge or reduce your copies.
Touching “Copy to” or “Copy from” after setting Scale manually changes the scale value back to Auto.

5 Touch Copy It.

Adjusting copy quality
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Under Content, touch the left or right arrow to select what you are copying:
• Text—Used for original documents that are mostly text or line art
• Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
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• Photograph—Used when the original document is a high-quality photograph or inkjet print
• Printed Image—Used when copying halftone photographs, graphics such as documents printed on a laser
printer, or pages from a magazine or newspaper that are composed primarily of images

5 Touch Copy It.

Collating copies
If you print multiple copies of a document, then you can choose to print each copy as a set (collated) or to print the
copies as groups of pages (not collated).
Collated

Not collated

By default, Collate is set to On. If you do not want to collate your copies, then change the setting to Off.
To turn collation off:

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Use the keypad to enter the number of copies.
5 Touch Off if you do not want your copies collated.
6 Touch Copy It.

Placing separator sheets between copies
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Options.
5 Touch Separator Sheets.
Note: Collate must be On for the separator sheets to be placed between copies. If Collate is Off, the separator
sheets are added to the end of the print job.

6 Select one of the following:
• Between Copies
• Between Jobs
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• Between Pages
7 Touch Done.
8 Touch Copy It.

Copying multiple pages onto a single sheet
In order to save paper, you can copy either two or four consecutive pages of a multiple‑page document onto a single
sheet of paper.
Notes:

• The Paper Size must be set to Letter, Legal, A4, or B5 JIS.
• The Copy Size must be set to 100%.
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Select a duplex setting.
5 Touch Options.
6 Touch Paper Saver.
7 Select the desired output.
8 Touch Print Page Borders if you want a box drawn around each page of the copies.
9 Touch Done.
10 Touch Copy It.
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Creating a custom job (job build)
The custom job or job build is used to combine one or more sets of original documents into a single copy job. Each set
may be scanned using different job parameters. When a copy job is submitted and Custom Job is enabled, the scanner
scans the first set of original documents using the supplied parameters, and then it scans the next set with the same
or different parameters.
The definition of a set depends on the scan source:

• If you scan a document on the scanner glass, a set consists of one page.
• If you scan multiple pages using the ADF, a set consists of all scanned pages until the ADF becomes empty.
• If you scan one page using the ADF, a set consists of one page.
For example:

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Options.
5 Touch Custom Job.
6 Touch On.
7 Touch Done.
8 Touch Copy It.
When the end of a set is reached, the scan screen appears.

9 Load the next document faceup, short edge first into the ADF or facedown on the scanner glass, and then touch
Scan the Automatic Document Feeder or Scan the flatbed.
Note: If required, change the job settings.

10 If you have another document to scan, load the next document faceup, short edge first into the ADF or facedown
on the scanner glass, and then touch Scan the Automatic Document Feeder or Scan the flatbed. Otherwise, touch
Finish the job.

Placing information on copies
Placing the date and time at the top of each page
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Options.
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5 Touch Header/Footer.
6 Pick an area of the page to place the date and time.
7 Touch Date/Time, and then touch Continue.
8 Touch Done.
9 Touch Copy It.

Placing an overlay message on each page
An overlay message can be placed on each page. The message choices are Urgent, Confidential, Copy, or Draft. To place
a message on the copies:

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Copy.
4 Touch Options.
5 Touch Overlay.
6 Touch the button containing the overlay you want to use.
7 Touch Done.
8 Touch Copy It.

Canceling a copy job
Canceling a copy job while the document is in the ADF
When the ADF begins processing a document, the scanning screen appears. To cancel the copy job, touch Cancel Job
on the touch screen.
A “Canceling scan job” screen appears. The ADF clears all pages in the ADF and cancels the job.

Canceling a copy job while copying pages using the scanner glass
Touch Cancel Job on the touch screen.
A “Canceling scan job” screen appears. Once the job is canceled, the copy screen appears.

Canceling a copy job while the pages are being printed
1 Touch Cancel Job on the touch screen, or press
2 Touch the job you want to cancel.

on the keypad.
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3 Touch Delete Selected Jobs.
The remaining print job is canceled. The home screen appears.

Understanding the copy screens and options
Copy from
This option opens a screen where you can enter the size of the documents you are going to copy.

• Touch a paper size button to select it as the “Copy from” setting. The copy screen appears with your new setting
displayed.

• When “Copy from” is set to Mixed Letter/Legal, you can copy an original document that contains mixed paper sizes.
• When “Copy from” is set to Auto Size Sense, the scanner automatically determines the size of the original document.

Copy to
This option opens a screen where you can enter the size and type of paper on which your copies will be printed.

• Touch a paper size button to select it as the “Copy to” setting. The copy screen appears with your new setting
displayed.

• If the size settings for “Copy from” and “Copy to” are different, then the printer automatically adjusts the Scale
setting to accommodate the difference.

• If the type or size of paper that you want to copy onto is not loaded in one of the trays, then touch Manual
Feeder, and manually send the paper through the multipurpose feeder.

• When “Copy to” is set to Auto Size Match, each copy matches the size of the original document. If a matching paper
size is not in one of the trays, then the printer scales each copy to fit loaded paper.

Scale
This option creates an image from your copy that is proportionally scaled anywhere between 25% and 400%. Scale can
also be set for you automatically.

• When you want to copy from one size of paper to another, such as from legal‑size to letter‑size paper, setting the
“Copy from” and “Copy to” paper sizes automatically changes the scale to keep all the original document information
on your copy.

• Touch the left arrow to decrease the value by 1%; touch the right arrow to increase the value by 1%.
• Hold your finger on an arrow to make a continuous increment change.
• Hold your finger on an arrow for two seconds to cause the pace of the change to accelerate.

Darkness
This option adjusts how light or dark your copies will turn out in relation to the original document.
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Content
This option tells the printer the original document type. Choose from Text, Text/Photo, Photograph, or Printed Image.

• Text—Emphasize sharp, black, high-resolution text against a clean, white background
• Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
• Photograph—Tells the scanner to pay extra attention to graphics and pictures. This setting increases the time it
takes to scan, but emphasizes a reproduction of the full dynamic range of tones in the original document.

• Printed Image—Used when copying halftone photographs, graphics such as documents printed on a laser printer,
or pages from a magazine or newspaper that are composed primarily of images

Sides (Duplex)
Use this option to select duplex settings. You can print copies on one or two sides, make two-sided copies (duplex) of
two-sided original documents, make two-sided copies from one-sided original documents, or make one-sided copies
(simplex) from two-sided original documents.

Collate
This option keeps the pages of a print job stacked in sequence when printing multiple copies of the document. The
factory default setting for Collate is on; the output pages of your copies will be ordered (1,2,3) (1,2,3) (1,2,3). If you
want all the copies of each page to remain together, turn Collate off, and your copies will be ordered (1,1,1) (2,2,2)
(3,3,3).

Options
Touching the Options button opens a screen where you can change Paper Saver, Advanced Imaging, Custom Job,
Separator Sheets, Margin Shift, Edge Erase, Header/Footer, Create Booklet, Overlay, Advanced Duplex, and Save as
Shortcut settings.

Create Booklet
This option creates a sequence of collated output that, when folded or folded and stapled, forms a booklet half the
page size of the original document and with all the pages in order.
Notes:

• Create Booklet is incompatible with Staple, Hole Punch, Margin Shift, and Paper Saver.
• If Create Booklet is on, then turning Margin Shift on will turn off Create Booklet, although the duplex value from
Create Booklet will stay on.

Paper Saver
This option lets you print two or more sheets of an original document together on the same page. Paper Saver is also
called N-up printing. The N stands for Number. For example, 2-up would print two pages of your document on a single
page, and 4-up would print four pages of your document on a single page. Touching Print Page Borders adds or removes
the outline border surrounding the original document pages on the output page.
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Advanced Imaging
This option lets you adjust Background Removal, Contrast, Shadow Detail, Scan Edge to Edge, Color Dropout, Auto
Color, Negative Image Sharpness and Mirror Image before you copy the document.

Custom Job
This option combines multiple scanning jobs into a single job.
Note: Custom Job may not be available on all models.

Separator Sheets
This option places a blank piece of paper between copies, pages, and print jobs. The separator sheets can be drawn
from a tray that contains a type or color of paper that is different from the paper your copies are printed on.

Margin Shift
This option increases the size of the margin a specified distance. This can be useful in providing space to bind or holepunch copies. Use the increase or decrease arrows to set how much of a margin you want. If the additional margin is
too large, then the copy will be cropped.

Edge Erase
This option eliminates smudges or information around the edges of your document. You can choose to eliminate an
equal area around all four sides of the paper, or pick a particular edge. Edge Erase erases whatever is within the selected
area, leaving nothing printed on that portion of the paper.

Header/Footer
This option turns on the Date/Time, Page number, Bates number, or Custom text and prints them in the specified
header or footer location.

Overlay
This option creates a watermark (or message) that overlays the content of your copy. You can choose between Urgent,
Confidential, Copy, and Draft, or you can enter a custom message in the ”Enter custom text” field. The word you pick
will appear, faintly, in large print across each page.
Note: A custom overlay can also be created by your system support person. When a custom overlay is created, a
button with an icon of that overlay will be available.

Advanced Duplex
This option controls whether the documents are one‑sided or two‑sided, what orientation your original documents
have, and how your documents are bound.

Save as Shortcut
This option allows the current settings to be saved as a shortcut.
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Improving copy quality
Question
When should I use Text
mode?

Tip

• Use text mode when text preservation is the main goal of the copy, and preserving images
copied from the original document is not a concern.

• Text mode is recommended for receipts, carbon copy forms, and documents that contain
only text or fine line art.
When should I use
Text/Photo mode?

• Use Text/Photo mode when copying an original document that contains a mixture of text
and graphics.

• Text/Photo mode is recommended for magazine articles, business graphics, and
brochures.
When should I use Printed
Image mode?

Use Printed Image mode when copying halftone photographs, graphics such as documents
printed on a laser printer, or pages from a magazine or newspaper

When should I use
Photograph mode?

Use Photograph mode when the original document is a high-quality photograph or inkjet
print.

E-mailing

98

E-mailing
ADF

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

You can use the printer to e‑mail scanned documents to one or more recipients. There are three ways to send an e‑mail
from the printer. You can type the e‑mail address, use a shortcut number, or use the address book.

Getting ready to e-mail
Setting up the e-mail function
For e-mail to operate, it must be turned on in the printer configuration and have a valid IP address or gateway address.
To set up the e-mail function:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Under Default Settings, click E-mail/FTP Settings.
4 Click E-mail Settings.
5 Click Setup E-mail Server.
6 Fill in the fields with the appropriate information.
7 Click Submit.
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Configuring the e‑mail settings
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click E-mail/FTP Settings.
4 Click E-mail Settings.
5 Fill in the fields with the appropriate information.
6 Click Submit.

Creating an e-mail shortcut
Creating an e-mail shortcut using the Embedded Web Server
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Under Other Settings, click Manage Shortcuts.
4 Click E-mail Shortcut Setup.
5 Type a unique name for the recipient, and then enter the e-mail address.
Note: If you are entering multiple addresses, then separate each address with a comma (,).

6 Select the scan settings (Format, Content, Color, and Resolution).
7 Enter a shortcut number, and then click Add.
If you enter a number that is already in use, then you are prompted to select another number.

Creating an e-mail shortcut using the touch screen
1 On the home screen, touch E-mail.
2 Type the recipient's e-mail address.
To create a group of recipients, touch Next address, and then type the next recipient’s e-mail address.

3 Touch Save as Shortcut.
4 Type a unique name for the shortcut, and then touch Enter.
5 Verify that the shortcut name and number are correct, and then touch OK.
If the name or number is incorrect, then touch Cancel, and then reenter the information.
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E-mailing a document
Sending an e-mail using the touch screen
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch E-mail.
4 Enter the e‑mail address or shortcut number.
To enter additional recipients, touch Next Address, and then enter the address or shortcut number you want to
add.

5 Touch E-mail It.

Sending an e‑mail using a shortcut number
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 Press

#

, and then enter the shortcut number using the keypad.

To enter additional recipients, press Next address, and then enter the address or shortcut number you want to
add.

4 Touch E-mail It.

Sending an e-mail using the address book
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, adjust the paper guides.
3 On the home screen, touch E-mail.
4 Touch Search Address Book.
5 Enter the name or part of the name you are searching for, and then touch Search.
6 Touch the name that you want to add to the To: box.
To enter additional recipients, press Next address, and then enter the address or shortcut number you want to
add; or search the address book.

7 Touch E-mail It.
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Customizing e-mail settings
Adding e-mail subject and message information
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, adjust the paper guides.
3 On the home screen, touch E-mail.
4 Type an e‑mail address.
5 Touch Options.
6 Touch Subject.
7 Type the e-mail subject.
8 Touch Done.
9 Touch Message.
10 Type an e-mail message.
11 Touch Done.
12 Touch E-mail It.

Changing the output file type
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch E-mail.
4 Type an e-mail address.
5 Touch Options.
6 Touch the button that represents the file type you want to send.
• PDF—Creates a single file with multiple pages, viewable with Adobe Reader. Adobe Reader is provided free by
Adobe at www.adobe.com.

• Secure PDF—Creates an encrypted PDF file that protects the file contents from unauthorized access
• TIFF—Creates multiple files or a single file. If Multi-page TIFF is turned off in the Settings menu of the Embedded
Web Server, then TIFF saves one page in each file. The file size is usually larger than an equivalent JPEG.
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• JPEG—Creates and attaches a separate file for each page of your original document, viewable by most Web
browsers and graphics programs

• XPS—Creates a single XML Paper Specification (XPS) file with multiple pages, viewable using an Internet
Explorer-hosted viewer and the .NET Framework, or by downloading a third party standalone viewer

7 Touch E-mail It.
Note: If you selected Encrypted PDF, then enter your password twice.

E-mailing color documents
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, adjust the paper guides.
3 On the home screen, touch E-mail.
4 Type an e-mail address.
5 Touch Options.
6 Touch Color.
7 Touch E-mail It.

Canceling an e-mail
• When using the ADF, touch Cancel Job while Scanning… appears.
• When using the scanner glass, touch Cancel Job while Scanning… appears or while Scan the Next Page /
Finish the Job appears.

Understanding e-mail options
Original Size
This option opens a screen where you can choose the size of the documents you are going to e-mail.

• Touch a paper size button to select that size as the Original Size setting. The e‑mail screen appears with your new
setting displayed.

• When “Original Size” is set to Mixed Letter/Legal, you can scan an original document that contains mixed paper
sizes.

• When “Original Size” is set to Auto Size Sense, the scanner automatically determines the size of the original
document.

Sides (Duplex)
This option informs the printer if the original document is simplex (printed on one side) or duplex (printed on both
sides). This lets the scanner know what needs to be scanned for inclusion in the e-mail.
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Orientation
This option tells the printer whether the original document is in portrait or landscape orientation and then changes the
Sides and Binding settings to match the original document orientation.

Binding
This option tells the printer whether the original document is bound on the long-edge or short-edge side.

E-mail Subject
This option lets you enter a subject line for your e-mail. You can enter up to 255 characters.

E-mail File Name
This option lets you customize the attachment file name.

E-mail Message
This option lets you enter a message that will be sent with your scanned attachment.

Resolution
Adjusts the output quality of your e-mail. Increasing the image resolution increases the e-mail file size and the time
needed to scan your original document. Image resolution can be decreased to reduce the e-mail file size.

Send As
This option sets the output (PDF, TIFF, JPEG or XPS) for the scanned image.

• PDF—Creates a single file with multiple pages, viewable with Adobe Reader. Adobe Reader is provided free by
Adobe at www.adobe.com.

• Secure PDF—Creates an encrypted PDF file that protects the file contents from unauthorized access
• TIFF—Creates multiple files or a single file. If Multi-page TIFF is turned off in the Settings menu of the Embedded
Web Server, then TIFF saves one page in each file. The file size is usually larger than an equivalent JPEG.

• JPEG—Creates and attaches a separate file for each page of your original document, viewable by most Web browsers
and graphics programs

• XPS—Creates a single XPS file with multiple pages, viewable using an Internet Explorer-hosted viewer and the .NET
Framework, or by downloading a third party standalone viewer

Content
This option tells the printer the original document type. Choose from Text, Text/Photo, or Photo. Color can be turned
on or off with any of the Content choices. Content affects the quality and size of your e-mail.

• Text—Emphasizes sharp, black, high-resolution text against a clean, white background
• Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
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• Photograph—Tells the scanner to pay extra attention to graphics and pictures. This setting increases the time it
takes to scan, but emphasizes a reproduction of the full dynamic range of tones in the original document. This
increases the amount of information saved.

• Color—Sets the scan type and output for the e-mail. Color documents can be scanned and sent to an e-mail address.

Advanced Options
Touching this button opens a screen where you change Advanced Imaging, Custom Job, Transmission Log, Scan Preview,
Edge Erase, and Darkness settings.

• Advanced Imaging—Adjusts Background Removal, Contrast, Scan Edge to Edge, Shadow Detail, and Mirror Image
before you copy the document

• Custom Job (Job Build)—Combines multiple scanning jobs into a single job
• Transmission Log—Prints the transmission log or transmission error log
• Scan Preview—Displays the first page of the image before it is included in the e-mail. When the first page is scanned,
the scanning is paused and a preview image appears.

• Edge Erase—Eliminates smudges or information around the edges of a document. You can choose to eliminate an
equal area around all four sides of the paper, or pick a particular edge. Edge Erase will erase whatever is within the
area selected, leaving nothing on that portion of the scan.

• Darkness—Adjusts how light or dark your scanned e-mails will turn out
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Faxing
Note: Fax capabilities may not be available on all printer models.
ADF

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

Getting printer ready to fax
Initial fax setup
Many countries and regions require outgoing faxes to contain the following information in a margin at the top or bottom
of each transmitted page, or on the first page of the transmission: station name (identification of the business, other
entity, or individual sending the message) and station number (telephone number of the sending fax machine, business,
other entity, or individual).
To enter your fax setup information, use the printer control panel, or use your browser to access the Embedded Web
Server and then enter the Settings menu.
Note: If you do not have a TCP/IP environment, then you must use the printer control panel to enter your fax setup
information.

Using the printer control panel for fax setup
When the printer is turned on for the first time or if the printer has been off for an extended time, a series of start‑up
screens appear. If the printer has fax capabilities, then the following screens appear:
Station Name
Station Number

1 When Station Name appears, enter the name to be printed on all outgoing faxes.
2 After entering the Station Name, touch Submit.
3 When Station Number appears, enter the printer fax number.
4 After entering the Station Number, touch Submit.
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Using the Embedded Web Server for fax setup
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the address
in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
4 Click Analog Fax Setup.
5 Click inside the Station Name box, and then enter the name to be printed on all outgoing faxes.
6 Click inside the Station Number box, and then enter the printer fax number.
7 Click Submit.

Choosing a fax connection
You can connect the printer with equipment such as a telephone, an answering machine, or a computer modem. To
determine the best way to set up the printer, see the following table.
Notes:

• The printer is an analog device that works best when directly connected to the wall outlet. Other devices (such
as a telephone or answering machine) can be successfully attached to pass through the printer, as described in
the setup steps.

• If you want a digital connection such as ISDN, DSL, or ADSL, a third-party device (such as a DSL filter) is required.
Contact your DSL provider for a DSL filter. The DSL filter removes the digital signal on the telephone line that can
interfere with the ability of the printer to fax properly.

• You do not need to attach the printer to a computer, but you do need to connect it to an analog telephone line
to send and receive faxes.
Equipment and service options

Fax connection setup

Connect directly to the telephone line

See “Connecting to an analog telephone line” on page 107.

Connect to a Digital Subscriber Line (DSL or ADSL) service See “Connecting to a DSL service” on page 107.
Connect to a Private Branch eXchange (PBX) or Integrated See “Connecting to a PBX or ISDN system” on page 108.
Services Digital Network (ISDN) system
Use a Distinctive Ring service

See “Connecting to a distinctive ring service” on page 108.

Connect through an adapter used in your area

See “Connecting to an adapter for your country or region” on
page 109.
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Connecting to an analog telephone line
If your telecommunications equipment uses a US‑style (RJ11) telephone line, then follow these steps to connect the
equipment:

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to an active analog telephone wall jack.

Connecting to a DSL service
If you subscribe to a DSL service, then contact the DSL provider to obtain a DSL filter and telephone cord, and then
follow these steps to connect the equipment:

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to the DSL filter.
Note: Your DSL filter may look different than the one in the illustration.

3 Connect the DSL filter cable to an active telephone wall jack.

3

1
2
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Connecting to a PBX or ISDN system
If you use a PBX or ISDN converter or terminal adapter, then follow these steps to connect the equipment:

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to the port designated for fax and telephone use.
Notes:

•
•
•
•
•

Make sure the terminal adapter is set to the correct switch type for your region.
Depending on the ISDN port assignment, you may have to connect to a specific port.
When using a PBX system, make sure the call waiting tone is off.
When using a PBX system, dial the outside line prefix before dialing the fax number.
For more information on using the fax with a PBX system, see the documentation that came with your PBX
system.

Connecting to a distinctive ring service
A distinctive ring service may be available from your telephone service provider. This service allows you to have multiple
telephone numbers on one telephone line with each telephone number having a different ring pattern. This may be
useful for distinguishing between fax and voice calls. If you subscribe to a distinctive ring service, follow these steps to
connect the equipment:

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to an active analog telephone wall jack.

3 Change the Distinctive Rings setting to match the setting you want the printer to answer:
Note: The factory default setting for distinctive rings is On. This allows the printer to answer single, double, and
triple ring patterns.

a
b
c
d
e

On the home screen, touch

.

Touch Settings.
Touch Fax Settings.
Touch Analog Fax Settings.
Touch the down arrow until Distinctive Ring Settings appears
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f Touch Distinctive Ring Settings.
g Touch the arrow for the pattern setting you want to change.
h Touch Submit.

Connecting to an adapter for your country or region
The following countries or regions may require a special adapter to connect the telephone cable to the active telephone
wall jack:
Country/region

•
•
•
•
•
•
•
•

Austria
Cyprus
Denmark
Finland
France
Germany
Ireland

•
•
•
•
•
•
•

New Zealand
Netherlands
Norway
Portugal
Sweden
Switzerland
United Kingdom

Italy

For some countries or regions, a telephone line adapter is included in the box.

1 Connect one end of the telephone cable that came with the printer to the printer LINE port .
2 Connect the other end of the telephone cable to the adapter, and then connect the adapter to the active telephone
wall jack.
Note: Your telephone adapter may look different than the one shown. It will fit the wall jack used in your
location.
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Setting the outgoing fax name and number
To have the designated fax name and fax number printed on outgoing faxes:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the address
in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
4 Click Analog Fax Setup.
5 Click General Fax Settings.
6 Click inside the Station Name box, and then enter the name to be printed on all outgoing faxes.
7 Click inside the Station Number box, and then enter the printer fax number.
8 Click Submit.

Setting the date and time
You can set the date and time so that they are printed on every fax you send. If there is a power failure, you may have
to reset the date and time.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the address
in the TCP/IP section.

2 Click Settings.
3 Click Security.
4 Click Set Date and Time.
5 Click inside the Set Date & Time box, and then enter the current date and time.
6 Click Submit.

Sending a fax
Sending a fax using the printer control panel
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
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4 Enter the fax number or a shortcut using the touch screen or keypad.
To add recipients, touch Next Number, and then enter the recipient's telephone number or shortcut number, or
search the address book.
Note: To place a dial pause within a fax number, press II . The dial pause appears as a comma in the “Fax to”
box. Use this feature if you need to dial an outside line first.

5 Touch Fax It.

Sending a fax using the computer
Faxing from a computer lets you send electronic documents without leaving your desk. This gives you the flexibility of
faxing documents directly from software programs.
Note: In order to perform this function from your computer, you must use the PostScript printer driver for your
printer.

1 From your software program, click File > Print.
2 From the Print window, select your printer, and then click Properties.
3 Choose the Other Options tab, and then click Fax.
4 Click OK, and then click OK again.
5 On the Fax screen, type the name and number of the fax recipient.
6 Click Send.

Creating shortcuts
Creating a fax destination shortcut using the Embedded Web Server
Instead of entering the entire phone number of a fax recipient on the printer control panel each time you want to send
a fax, you can create a permanent fax destination and assign a shortcut number. A shortcut can be created to a single
fax number or a group of fax numbers.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Manage Shortcuts.
Note: A password may be required. If you do not have an ID and password, get one from your system support
person.

4 Click Fax Shortcut Setup.
5 Type a unique name for the shortcut, and then enter the fax number.
To create a multiple‑number shortcut, enter the fax numbers for the group.
Note: Separate each fax number in the group with a semicolon (;).
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6 Assign a shortcut number.
If you enter a number that is already in use, then you are prompted to select another number.

7 Click Add.

Creating a fax destination shortcut using the touch screen
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
4 Enter the fax number.
To create a group of fax numbers, touch Next number, and then enter the next fax number.

5 Touch Save as Shortcut.
6 Enter a name for the shortcut.
7 Touch OK.
8 Touch Fax It to send the fax, or touch

to return to the home screen.

Changing the fax destination shortcut using the Embedded Web Server
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Manage Shortcuts.
Note: A password may be required. If you do not have an ID and password, get one from your system support
person.

4 Click Fax Shortcut Setup.
5 Select the list entry, and then update it using the text box.
6 Click Modify.
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Using shortcuts and the address book
Using fax shortcuts
Fax shortcuts are just like the speed dial numbers on a telephone or fax machine. You can assign shortcut numbers
when creating permanent fax destinations. Permanent fax destinations or speed dial numbers are created in the
Manage Shortcuts link located under Settings on the Embedded Web Server. A shortcut number (1–99999) can contain
a single recipient or multiple recipients. By creating a group fax shortcut with a shortcut number, you can quickly and
easily fax broadcast information to an entire group.

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not place postcards, photos, small items, transparencies, photo paper, or thin media (such as
magazine clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 Press

#

, and then enter the shortcut number using the keypad.

Using the address book
Note: The address book feature is enabled if it contains at least one entry.

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
4 Touch Search Address Book.
5 Using the virtual keyboard, type the name or part of the name of the person whose fax number you want to find.
Note: Do not attempt to search for multiple names at the same time.

6 Touch Search.
7 Touch the name to add it to the “Fax to” list.
8 Repeat steps 4 through 7 to enter additional addresses.
9 Touch Fax It.
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Customizing fax settings
Changing the fax resolution
Adjusting the resolution setting changes the quality of the fax. Settings range from Standard (fastest speed) to Ultra
Fine (slowest speed, best quality).

1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
4 Use the keypad to enter the fax number.
5 Touch Options.
6 From the Resolution area, touch the arrows to change to the resolution you want.
7 Touch Fax It.

Making a fax lighter or darker
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
4 Use the keypad to enter the fax number.
5 Touch Options.
6 From the Darkness area, touch the arrows to adjust the darkness of the fax.
7 Touch Fax It.

Sending a fax at a scheduled time
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch Fax.
4 Enter the fax number using the numbers on the touch screen or keypad.
5 Touch Options.
6 Touch Advanced Options.

Faxing

115

7 Touch Delayed Send.
Note: If Fax Mode is set to Fax Server, the Delayed Send button will not appear. Faxes waiting for transmission
are listed in the Fax Queue.

8 Touch the arrows to adjust the time the fax will be transmitted.
The time is increased or decreased in increments of 30 minutes. If the current time is shown, the left arrow is
unavailable.

9 Touch Done.
10 Touch Fax it.
Note: The document is scanned and then faxed at the scheduled time.

Viewing a fax log
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Reports.
3 Click Fax Job Log or Fax Call Log.

Blocking junk faxes
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
4 Click Analog Fax Setup.
5 Click the Block No Name Fax option.
This option blocks all incoming faxes that have a private caller ID or no fax station name.

6 In the Banned Fax List field, enter the phone numbers or fax station names of specific fax callers you want to block.

Canceling an outgoing fax
Canceling a fax while the original documents are still scanning
• When using the ADF, touch Cancel Job while Scanning… appears.
• When using the scanner glass, touch Cancel Job while Scanning… appears or while Scan the Next Page /
Finish the Job appears.
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Canceling a fax after the original documents have been scanned to memory
1 On the home screen, touch Cancel Jobs.
The Cancel Jobs screen appears.

2 Touch the job or jobs you want to cancel.
Only three jobs appear on the screen; touch the down arrow until the job you want appears, and then touch the
job you want to cancel.

3 Touch Delete Selected Jobs.
The Deleting Selected Jobs screen appears, the selected jobs are deleted, and then the home screen appears.

Understanding fax options
Original Size
This option opens a screen where you can choose the size of the documents you are going to fax.

• Touch a paper size button to select that size as the Original Size setting. The fax screen appears with your new
setting displayed.

• When Original Size is set to Mixed Letter/Legal, you can scan an original document that contains mixed paper sizes.
• When “Original Size” is set to Auto Size Sense, the scanner automatically determines the size of the original
document.

Content
This option tells the printer the original document type. Choose from Text, Text/Photo, or Photograph. Color can be
turned on or off with any of the Content choices. Content affects the quality and size of your scan.

• Text—Emphasizes sharp, black, high-resolution text against a clean, white background
• Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
• Photograph—Tells the scanner to pay extra attention to graphics and pictures. This setting increases the time it
takes to scan, but emphasizes a reproduction of the full dynamic range of tones in the original document. This
increases the amount of information saved.

• Color—Sets the scan type and output for the fax. Color documents can be scanned and sent to a fax destination.
Note: Color is not available when Fax is in Fax Server Mode.

Sides (Duplex)
This option informs the printer if the original document is simplex (printed on one side) or duplex (printed on both
sides). This lets the scanner know what needs to be scanned for inclusion in the fax.
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Resolution
This options increases how closely the scanner examines the document you want to fax. If you are faxing a photo, a
drawing with fine lines, or a document with very small text, increase the Resolution setting. This will increase the amount
of time required for the scan and will increase the quality of the fax output.

•
•
•
•

Standard—Suitable for most documents
Fine—Recommended for documents with small print
Super fine—Recommended for original documents with fine detail
Ultra fine—Recommended for documents with pictures or photos

Darkness
This option adjusts how light or dark your faxes will turn out in relation to the original document.

Advanced Options
Touching this button opens a screen where you can change Delayed Send, Advanced Imaging, Custom Job, Transmission
Log, Scan Preview, Edge Erase, and Advanced Duplex settings.

• Delayed Send—Lets you send a fax at a later time or date. After setting up your fax, touch Delayed Send, enter the
time and date you would like to send your fax, and then touch Done. This setting can be especially useful in sending
information to fax lines that are not readily available during certain hours, or when transmission times are cheaper.
Note: If the printer is turned off when the delayed fax is scheduled to be sent, the fax is sent the next time the
printer is turned on.

• Advanced Imaging—Adjusts Background Removal, Color Dropout, Contrast, Mirror Image, Negative Image, Shadow
Details, Scan Edge to Edge and Sharpness before you fax the document

• Custom Job—Combines multiple scanning jobs into a single job
• Transmission Log—Prints the transmission log or transmission error log
• Scan Preview—Displays the image before it is included in the fax. When the first page is scanned, the scanning is
paused, and a preview image appears.

• Edge Erase—Eliminates smudges or information around the edges of a document. You can choose to eliminate an
equal area around all four sides of the paper, or pick a particular edge. Edge Erase will erase whatever is within the
area selected, leaving nothing on that portion of the scan.

Improving fax quality
Question
When should I use Text
mode?

Tip

• Use Text mode when text preservation is the main goal of the fax, and preserving images
copied from the original document is not a concern.

• Text mode is recommended for faxing receipts, carbon copy forms, and documents that
contain only text or fine line art.
When should I use
Text/Photo mode?

• Use Text/Photo mode when faxing an original document that contains a mixture of text and
graphics.

• Text/Photo mode is recommended for magazine articles, business graphics, and brochures.
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Question

Tip

When should I use Photo
mode?

Use Photo mode when faxing photos printed on a laser printer or taken from a magazine or
newspaper.

Holding and forwarding faxes
Holding faxes
This option lets you hold received faxes from printing until they are released. Held faxes can be released manually or
at a scheduled day or time.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
4 Click Analog Fax Setup.
5 Click Holding Faxes.
6 Enter a password in the Print Faxes Password box.
Note: This may not be applicable in some cases.

7 From the Held Fax Mode menu, select one of the following:
• Off
• Always On
• Manual
• Scheduled
8 If you selected Scheduled, then continue with the following steps. Otherwise, click Submit.
a Click Fax Holding Schedule.
b From the Action menu, select Hold faxes.
c From the Time menu, select the time you want the held faxes released.
d From the Day(s) menu, select the day you want the held faxes released.
e Click Add.

Forwarding a fax
This option lets you print and forward received faxes to a fax number, e‑mail address, FTP site, or LDSS.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
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3 Click Fax Settings.
4 Click Analog Fax Setup.
5 From the Fax Forwarding menu under Fax Receive settings, select one of the following:
• Print
• Print and Forward
• Forward
6 From the “Forward to” menu, select one of the following:
• Fax
• E‑mail
• FTP
• LDSS
• eSF
7 Click inside the Forward to Shortcut box, and then enter the shortcut number where you want the fax forwarded.
Note: The shortcut number must be a valid shortcut number for the setting that was selected in the “Forward
to” menu.

8 Click Submit.
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Scanning to an FTP address
ADF

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

The scanner lets you scan documents directly to a File Transfer Protocol (FTP) server. Only one FTP address may be
sent to the server at a time.
Once an FTP destination has been configured by your system support person, the name of the destination becomes
available as a shortcut number, or it is listed as a profile under the Held Jobs icon. An FTP destination could also be
another PostScript printer; for example, a color document can be scanned, and then sent to a color printer.

Scanning to an FTP address
Scanning to an FTP address using the keypad
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 On the home screen, touch FTP.
4 Type the FTP address.
5 Touch Send It.
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Scanning to an FTP address using a shortcut number
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 Press #, and then enter the FTP shortcut number.
4 Touch Send It.

Scanning to an FTP address using the address book
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, adjust the paper guides.
3 On the home screen, touch FTP.
4 Touch Search Address Book.
5 Type the name or part of the name you are searching for, and then touch Search.
6 Touch the name that you want to add to the To: field.
7 Touch Send It.

Creating shortcuts
Instead of entering the entire FTP site address on the control panel each time you want to send a document to an FTP
server, you can create a permanent FTP destination and assign a shortcut number. There are two methods for creating
shortcut numbers: using a computer and using the printer touch screen.

Creating an FTP shortcut using the Embedded Web Server
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Under Other Settings, click Manage Shortcuts.
Note: A password may be required. If you do not have an ID and password, get one from your system support
person.

4 Click FTP Shortcut Setup.
5 Enter the appropriate information into the boxes.
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6 Enter a shortcut number.
7 Click Add.

Creating an FTP shortcut using the touch screen
1 On the home screen, touch FTP.
2 Type the address of the FTP site.
3 Touch Save as Shortcut.
4 Enter a name for the shortcut.
5 Touch Enter.
6 Verify that the shortcut name and number are correct, and then touch OK. If the name or number is incorrect, then
touch Cancel, and reenter the information.
If you enter a number that is already in use, then you are prompted to select another number.

7 Touch Send It to start the scan, or touch

to return to the home screen.

Understanding FTP options
Original Size
This option opens a screen where you can choose the size of the documents you are going to copy.

• Touch a paper size button to select that size as the Original Size setting. The FTP screen appears with your new
setting displayed.

• When “Original Size” is set to Mixed Letter/Legal, you can scan an original document that contains mixed paper
sizes.

• When “Original Size” is set to Auto Size Sense, the scanner automatically determines the size of the original
document.

Sides (Duplex)
This option informs the printer if the original document is simplex (printed on one side) or duplex (printed on both
sides). This lets the scanner know what needs to be scanned for inclusion in the document.

Orientation
This option tells the printer whether the original document is in portrait or landscape orientation and then changes the
Sides and Binding settings to match the original document orientation.

Binding
Tells the printer whether the original document is bound on the long-edge or short-edge side.
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Resolution
This option adjusts the output quality of your file. Increasing the image resolution increases the file size and the time
needed to scan your original document. Image resolution can be decreased to reduce the file size.

Send As
This option sets the output (PDF, TIFF, JPEG or XPS) for the scanned image.

• PDF—Creates a single file with multiple pages, viewable with Adobe Reader. Adobe Reader is provided free by
Adobe at www.adobe.com.

• Secure PDF—Creates an encrypted PDF file that protects the file contents from unauthorized access
• TIFF—Creates multiple files or a single file. If Multi-page TIFF is turned off in the Settings menu of the Embedded
Web Server, then TIFF saves one page in each file. The file size is usually larger than an equivalent JPEG.

• JPEG—Creates and attaches a separate file for each page of your original document, viewable by most Web browsers
and graphics programs

• XPS—Creates a single XPS file with multiple pages, viewable using an Internet Explorer-hosted viewer and the .NET
Framework, or by downloading a third party standalone viewer

Content
This option tells the printer the original document type. Choose from Text, Text/Photo, or Photo. Color can be turned
on or off with any of the Content choices. Content affects the quality and size of your FTP file.

• Text—Emphasize sharp, black, high-resolution text against a clean, white background
• Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
• Photograph—Tells the scanner to pay extra attention to graphics and pictures. This setting increases the time it
takes to scan, but emphasizes a reproduction of the full dynamic range of tones in the original document. This
increases the amount of information saved.

• Color—Sets the scan type and output for the FTP file. Color documents can be scanned and sent to an FTP site,
computer, e-mail address, or the printer.

Advanced Options
Touching this button opens a screen where you can change the following settings:

• Advanced Imaging—Adjusts Background Removal, Contrast, Shadow Detail, and Mirror Image before you scan the
document

• Custom Job (Job Build)—Combines multiple scanning jobs into a single job
• Transmission Log—Prints the transmission log or transmission error log
• Scan Preview—Displays the first page of an image before it is included in the FTP file. When the first page is scanned,
the scanning is paused and a preview image appears.

• Edge Erase—Eliminates smudges or information around the edges of a document. You can choose to eliminate an
equal area around all four sides of the paper, or pick a particular edge. Edge Erase will erase whatever is within the
area selected, leaving nothing on that portion of the scan.

• Darkness—Adjusts how light or dark your scanned documents will turn out
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Improving FTP quality
Question
When should I use Text
mode?

Tip

• Use Text mode when text preservation is the main goal of sending a document to an FTP site,
and preserving images copied from the original document is not a concern.

• Text mode is recommended for receipts, carbon copy forms, and documents that only contain
text or fine line art.
When should I use
Text/Photo mode?

• Use Text/Photo mode when sending a document to an FTP site that contains a mixture of
text and graphics.

• Text/Photo mode is recommended for magazine articles, business graphics, and brochures.
When should I use Photo Use Photo mode when the original document is composed mostly of photos printed on a laser
mode?
printer or taken from a magazine or newspaper.
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Scanning to a computer or flash drive
ADF

Scanner glass

ABC

Use the ADF for multiple‑page documents.

Use the scanner glass for single pages, small items (such as postcards or
photos), transparencies, photo paper, or thin media (such as magazine
clippings).

The scanner lets you scan documents directly to a computer or a flash drive. The computer does not have to be directly
connected to the printer for you to receive Scan to PC images. You can scan the document back to the computer over
the network by creating a scan profile on the computer, and then downloading the profile to the printer.

Scanning to a computer
1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Scan Profile.
3 Click Create Scan Profile.
Note: Your computer must have java program installed to be able to create a scan profile.

4 Select your scan settings, and then click Next.
5 Select a location on your computer where you want to save the scanned output file.
6 Enter a scan name.
The scan name is the name that appears in the Scan Profile list on the display.

7 Click Submit.
8 Review the instructions on the Scan Profile screen.
A shortcut number was automatically assigned when you clicked Submit. You can use this shortcut number when
you are ready to scan your documents.

9 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.
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10 If you are loading a document into the ADF, then adjust the paper guides.
11 Press

# , and then enter the shortcut number using the keypad, or touch Held Jobs on the home screen, and
then touch Profiles.

12 After you enter the shortcut number, the scanner scans and sends the document to the directory or program you
specified. If you touched Profiles on the home screen, then locate your shortcut on the list.

13 Touch Finish the Job.
14 Return to the computer to view the file.
The output file is saved in the location you specified or launched in the program you specified.

Scanning to a flash drive
1 Load an original document faceup, short edge first into the ADF or facedown on the scanner glass.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

2 If you are loading a document into the ADF, then adjust the paper guides.
3 Insert the flash drive into the USB port on the front of the printer.
4 Touch Scan to USB drive.
5 Select the size and file that you want to scan.
6 Touch Scan It.

Understanding scan profile options
Quick Setup
This option lets you select preset formats or customize the scan job settings. You can select one of these settings:
Custom

Photo - Color JPEG

Text - BW PDF

Photo - Color TIFF

Text - BW TIFF

Text/Photo - BW PDF
Text/Photo - Color PDF

To customize the scan job settings, from the Quick Setup menu, select Custom. Then change the scan settings as needed.

Format Type
This option sets the output (PDF, JPEG, TIFF, SECURE PDF, or XPS) for the scanned image.

• PDF—Creates a single file with multiple pages, viewable with Adobe Reader. Adobe Reader is provided free by
Adobe at www.adobe.com.

• JPEG—Creates and attaches a separate file for each page of your original document, viewable by most Web browsers
and graphics programs
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• TIFF—Creates multiple files or a single file. If Multi-page TIFF is turned off in the Settings menu of the Embedded
Web Server, then TIFF saves one page in each file. The file size is usually larger than an equivalent JPEG.

• Secure PDF—Creates an encrypted PDF file that protects the file contents from unauthorized access
• XPS—Creates a single XPS file with multiple pages, viewable using an Internet Explorer-hosted viewer and the .NET
Framework, or by downloading a third party standalone viewer

Compression
This option sets the format (Zlib, JPEG or None) used to compress the scanned output file.

Default Content
This option tells the printer the original document type. Choose from Text, Text/Photo, or Photo. Content affects the
quality and size of your scanned file.
Text—Emphasizes sharp, black, high-resolution text against a clean, white background
Text/Photo—Used when the original documents are a mixture of text and graphics or pictures
Photo—Tells the scanner to pay extra attention to graphics and pictures. This setting increases the time it takes to
scan, but emphasizes a reproduction of the full dynamic range of tones in the original document. This increases the
amount of information saved.

Color
This option tells the printer the color of the original documents. You can select Gray, BW (Black and White), or Color.

Original Size
This option sets the size of the documents you are going to scan. When Original Size is set to Mixed Sizes, you can scan
an original document that contains mixed paper sizes (letter‑ and legal‑size pages).

Orientation
This option tells the printer whether the original document is in portrait or landscape orientation and then changes the
Sides and Binding settings to match the original document orientation.

Sides (Duplex)
This option informs the printer if your original document is simplex (printed on one side) or duplex (printed on both
sides). This lets the scanner know what needs to be scanned for inclusion in the document.

Darkness
This option adjusts how light or dark your scanned documents will turn out in relation to the original document.
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Resolution
This option adjusts the output quality of your file. Increasing the image resolution increases the file size and the time
needed to scan your original document. Image resolution can be decreased to reduce the file size.

Advanced Imaging
• Background Removal—Adjusts the white portion of the output. Click the arrow buttons to increase or decrease
the white portion.

•
•
•
•

Contrast—Click the arrow buttons to increase or decrease the contrast.

•
•
•
•

Scan edge to edge—Select this box to scan edge to edge.

Shadow Detail—Click the arrow buttons to increase or decrease the visible detail in the shadows.
Sharpness—Click the arrow buttons to increase or decrease the sharpness.
Color Dropout—Color dropout is used for form Optical Character Recognition (OCR) processing. Selecting a color
eliminates the color from a form, enabling improved OCR capabilities.
Mirror Image—Select this box to create a mirror image scan.
Negative Image—Select this box to create a negative image scan.
Jpeg Quality—Select this box to choose JPEG quality.

Improving scan quality
Question
When should I use Text
mode?

Tip

• Use Text mode when text preservation is the main goal of the scan, and preserving images
copied from the original document is not a concern.

• Text mode is recommended for receipts, carbon copy forms, and documents that only
contain text or fine line art.
When should I use
Text/Photo mode?

• Use Text/Photo mode when scanning an original document that contains a mixture of text
and graphics.

• Text/Photo mode is recommended for magazine articles, business graphics, and brochures.
When should I use Photo
mode?

Use Photo mode when scanning photos printed on a laser printer or taken from a magazine or
newspaper.
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Understanding printer menus
Menus list
To access the menus, touch

on the home screen.

Paper Menu

Reports

Network/Ports

Default Source

Menu Settings Page

Active NIC

Paper Size/Type

Device Statistics

Standard Network2

Configure MP

Network Setup Page

SMTP Setup

Substitute Size

Network <x> Setup Page

Standard USB

Page1

Paper Texture

Wireless Setup

Paper Loading

Shortcut List

Custom Types

Fax Job Log

Custom Names
Custom Scan Sizes

Fax Call Log
Copy Shortcuts

Custom Bin Names

E‑mail Shortcuts

Universal Setup

Fax Shortcuts

Bin Setup

FTP Shortcuts
Profiles List
NetWare Setup Page
Print Fonts
Print Directory
Print Demo
Asset Report

1

Only appears if a wireless card is installed.

2

Depending on the printer setup, this menu item appears as Standard Network or Network <x>.

Security

Settings

Help

Edit Security Setups

General Settings

Print all guides

Miscellaneous Security Settings

Copy Settings

Copy guide

Confidential Print

Fax Settings

E‑mail guide

Disc Wiping

E‑mail Settings

Fax guide

Security Audit Log

FTP Settings

FTP guide

Set Date and Time

Flash Drive Menu

Information guide

Print Settings

Print Defects guide
Supplies Guide
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Paper menu
Default Source menu
Menu item

Description

Default Source
Tray <x>
MP Feeder
Manual Paper
Manual Env

Sets a default paper source for all print jobs
Notes:

• Tray 1 (standard tray) is the factory default setting.
• Only an installed paper source will appear as a menu setting.
• A paper source selected by a print job will override the Default Source
setting for the duration of the print job.

• If the same size and type of paper are in two trays and the Paper Size and
Paper Type settings match, then the trays are automatically linked. When
one tray is empty, the job prints using the linked tray.

• From the Paper menu, Configure MP must be set to Cassette in order for
MP Feeder to appear as a menu setting.

Paper Size/Type menu
Menu item

Description

Tray <x> Size
A4
A5
JIS B5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal
A3
Tabloid
JIS B4

Specifies the paper size loaded in each tray
Notes:

• A4 is the international factory default setting. Letter is the US factory
default setting.

• For trays with automatic size sensing, only the size detected by the
hardware appears.

• Executive, Oficio, and Statement appear as options only if Tray Size
Sensing it turned off.

• Use this menu item to configure automatic tray linking. If the same size
and type of paper are in two trays and the Paper Size and Paper Type
settings match, then the trays are automatically linked. When one tray
is empty, the job prints using the linked tray.

• Automatic size sensing is not supported for Oficio, Folio, or Statement
paper sizes.

• The 2000‑sheet tray supports A4, Letter, and Legal paper sizes.
Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

Tray <x> Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper loaded in each tray

MP Feeder Size
A4
A3
Tabloid
JIS B4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal
7 3/4 Envelope
10 Envelope
DL Envelope
Other Envelope

Specifies the paper size loaded in the multipurpose feeder

Notes:

• Plain Paper is the factory default setting for Tray 1. Custom Type <x> is
the factory default setting for all other trays.

• If available, a user‑defined name appears instead of Custom Type <x>.
• Use this menu item to configure automatic tray linking. If the same size
and type of paper are in two trays and the Paper Size and Paper Type
settings match, then the trays are automatically linked. When one tray
is empty, the job prints using the linked tray.

Notes:

• From the Paper menu, Configure MP must be set to Cassette in order
for MP Feeder Size to appear as a menu item.

• A4 is the international factory default setting. Letter is the US factory
default setting.

• The multipurpose feeder does not automatically sense paper size. The
paper size value must be set.

• JIS B5 is supported only if feeding orientation is long edge.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

MP Feeder Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Envelope
Rough Envelope
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper loaded in the multipurpose feeder

Manual Paper Size
A4
A3
Tabloid
JIS B4
A5
A6
JIS B5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal

Specifies the size of the paper being manually loaded

Notes:

• From the Paper menu, Configure MP must be set to Cassette in order
for MP Feeder Type to appear as a menu item.

• Plain Paper is the factory default setting.

Note: A4 is the international factory default setting. Letter is the US factory
default setting.

Note: Only installed trays, drawers, and feeders are listed in this menu.
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Menu item

Description

Manual Paper Type
Plain Paper
Card Stock
Transparency
Recycled
Labels
Bond
Letterhead
Preprinted
Colored Paper
Light Paper
Heavy Paper
Rough/Cotton Paper
Custom Type <x>

Specifies the type of paper being manually loaded

Manual Envelope Size
7 3/4 Envelope
10 Envelope
DL Envelope
Other Envelope

Specifies the size of the envelope being manually loaded

Manual Envelope Type
Envelope
Rough Envelope
Custom Type <x>

Note: Plain Paper is the factory default setting.

Note: DL Envelope is the international factory default setting. 10 Envelope is
the US factory default setting.

Specifies the type of envelope being manually loaded
Note: Envelope is the factory default setting.

Note: Only installed trays, drawers, and feeders are listed in this menu.

Configure MP menu
Menu item

Description

Configure MP
Cassette
Manual
First

Determines when the printer selects paper from the multipurpose feeder
Notes:

• Cassette is the factory default setting.
• The Cassette setting configures the multipurpose feeder as an automatic
paper source.

• When Manual is selected, the multipurpose feeder can be used only for
manual feed print jobs.

• If paper is loaded in the multipurpose feeder and First is selected, then
paper always feeds from the multipurpose feeder first.
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Substitute Size menu
Menu item

Description

Substitute Size
All Listed
Off
Statement/A5
Letter/A4
11 x 17/A3

Substitutes a specified paper size if the requested paper size is not available
Notes:

• All Listed is the factory default setting. All available substitutions are
allowed.

• The Off setting indicates no size substitutions are allowed.
• Setting a substitution lets the job print without a Change Paper message
appearing.

Paper Texture menu
Menu item

Description

Plain Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Card Stock Texture
Smooth
Normal
Rough

Specifies the relative texture of the card stock loaded in a specific tray

Transparency Texture
Smooth
Normal
Rough

Specifies the relative texture of the transparencies loaded in a specific tray

Recycled Texture
Smooth
Normal
Rough

Specifies the relative texture of the recycled paper loaded in a specific tray

Labels Texture
Smooth
Normal
Rough

Specifies the relative texture of the labels loaded in a specific tray

Bond Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Envelope Texture
Smooth
Normal
Rough

Specifies the relative texture of the envelopes loaded in a specific tray

Note: Normal is the factory default setting.

Notes:

• Normal is the factory default setting.
• Settings appear only if card stock is supported.
Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Rough is the factory default setting.

Note: Normal is the factory default setting.
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Menu item

Description

Rough Envelope Texture
Smooth
Normal
Rough

Specifies the relative texture of the rough envelopes loaded in a specific tray

Letterhead Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Preprinted Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Colored Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Light Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Heavy Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Rough Texture
Smooth
Normal
Rough

Specifies the relative texture of the paper loaded in a specific tray

Custom <x> Texture
Smooth
Normal
Rough

Specifies the relative texture of the custom paper loaded in a specific tray

Note: Rough is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Normal is the factory default setting.

Note: Rough is the factory default setting.

Note: Normal is the factory default setting.
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Paper Loading menu
Menu item

Description

Card Stock Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Card Stock as the paper type

Recycled Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Recycled as the paper type

Labels Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Labels as the paper type

Bond Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Bond as the paper type

Letterhead Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Letterhead as the paper type

Preprinted Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Preprinted as the paper type

Colored Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Colored as the paper type

Light Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Light as the paper type

Heavy Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Heavy as the paper type

Rough Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Rough as the paper type

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Notes:

• Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties in Windows or the Print dialog in Macintosh.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including 1‑sided jobs.
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Menu item

Description

Custom <x> Loading
Duplex
Off

Determines whether 2‑sided printing occurs for all jobs that specify
Custom <x> as the paper type
Notes:

• Off is the factory default setting.
• Custom <x> Loading is available only if the custom type is
supported.
Notes:

• Duplex sets the printer default to 2‑sided printing for every print job unless 1‑sided printing is selected from Print
Properties in Windows or the Print dialog in Macintosh.

• If Duplex is selected, then all print jobs are sent through the duplex unit, including 1‑sided jobs.

Custom Types menu
Menu item

Description

Custom Type <x>
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Bond
Envelope

Associates a paper or specialty media type with a factory default Custom
Type <x> name or a user‑defined Custom Name created from the Embedded
Web Server or MarkVision Professional

Recycled
Paper
Card Stock
Transparency
Rough/Cotton
Labels
Bond
Envelope

Specifies a paper type when the Recycled setting is selected in other menus

Notes:

• Paper is the factory default setting.
• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Notes:

• Paper is the factory default setting.
• The custom media type must be supported by the selected tray or
multipurpose feeder in order to print from that source.

Custom Names menu
Menu item

Definition

Custom Name <x>
<none>

Specify a custom name for a paper type. This name replaces a Custom Type
<x> name in the printer menus.
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Custom Scan Sizes menu
Menu item

Description

Custom Scan Size <x>
Scan Size Name
Width
3–14.17 inches (76–360 mm)
Height
3–14.17 inches (76–360 mm)
Orientation
Landscape
Portrait
2 scans per side
Off
On
ADF Pick Roller Force
User Default
30%
40%
50%
60%
70%
80%

Specifies a custom scan size name and options. This name replaces a Custom
Scan Size <x> name in the printer menus.
Notes:

• 8.5 Inches is the US factory default setting for Width. 216 millimeters is
the international factory default setting for Width.

• 14 Inches is the US factory default setting for Height. 356 millimeters is
the international factory default setting for Height.

• Landscape is the factory default setting for Orientation.
• Off is the factory default setting for 2 scans per side.
• User Default is the factory default setting for ADF Pick Roller Force.

Custom Bin Names menu
Menu Item

Description

Standard Bin

Specifies a custom name for the Standard Bin

Bin 1

Specifies a custom name for Bin 1

Universal Setup menu
These menu items are used to specify the height, width, and feed direction of the Universal Paper Size. The Universal
Paper Size is a user‑defined paper size setting. It is listed with the other paper size settings and includes similar options,
such as support for duplex printing and printing multiple pages on one sheet.
Menu item

Description

Units of Measure
Inches
Millimeters

Identifies the units of measure
Notes:

• Inches is the US factory default setting.
• Millimeters is the international factory default setting.
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Menu item

Description

Portrait Width
3–17 inches
76–432 mm

Sets the portrait width
Notes:

• If the width exceeds the maximum, the printer uses the maximum
width allowed.

• 11.69 inches is the US factory default setting. Inches can be
increased in 0.01‑inch increments.

• 297 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.
Portrait Height
3–17 inches
76–432 mm

Sets the portrait height
Notes:

• If the height exceeds the maximum, the printer uses the maximum
height allowed.

• 17 inches is the US factory default setting. Inches can be increased in
0.01‑inch increments.

• 432 mm is the international factory default setting. Millimeters can
be increased in 1‑mm increments.
Feed Direction
Short Edge
Long Edge

Specifies the feed direction if the paper can be loaded in either direction
Notes:

• Short Edge is the factory default setting.
• Long Edge appears only if the longest edge is shorter than the
maximum width supported in the tray.

Bin Setup menu
Menu Item

Description

Output Bin
Standard Bin
Bin <x>

Specifies the default output bin
Note: Standard Bin is the factory default setting.
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Menu Item

Description

Configure Bins
Mailbox
Link
Link Optional
Type Assignment

Specifies configuration options for output bins
Notes:

• Mailbox is the factory default setting.
• Bins assigned the same name are automatically
linked unless Link Optional is selected.

• The Mailbox setting treats each bin as a separate
mailbox.

• The Link setting links together all available output
bins.

• The Link Optional setting links together all available
output bins except the standard bin and appears only
when at least two optional bins are installed.

• The Type Assignment setting assigns each paper type
to an output bin or linked bin set.
Assign Type/Bin
Plain Paper Bin
Card Stock Bin
Transparency Bin
Recycled Bin
Labels Bin
Bond Bin
Envelope Bin
Rough Envelope Bin
Letterhead Bin
Preprinted Bin
Colored Bin
Light Bin
Heavy Bin
Rough/Cotton Bin
Custom <x> Bin

Selects an output bin for each supported paper type
Available selections for each type are:
Disabled
Standard Bin
Bin <x>
Note: Standard Bin is the factory default setting.

Reports menu
Note: When you select a menu item from the Reports menu, the indicated report prints.
Menu item

Description

Menu Settings Page

Prints a report containing information about paper loaded into trays, installed
memory, the total page count, alarms, timeouts, the control panel language, the
TCP/IP address, the status of supplies, the status of the network connection, and
other information

Device Statistics

Prints a report containing printer statistics such as supply information and details
about printed pages
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Menu item

Description

Network Setup Page

Prints a report containing information about the network printer settings, such
as the TCP/IP address information
Note: This menu item appears only for network printers or printers connected
to print servers.

Network <x> Setup Page

Prints a report containing information about the network printer settings, such
as the TCP/IP address information
Notes:

• This menu item is available when more than one network option is
installed.

• This menu item appears only for network printers or printers connected to
print servers.
Wireless Setup Page

Prints a report containing information about the wireless network printer
settings, such as the TCP/IP address information
Notes:

• This menu item is available when a wireless card is installed and Lexmark
Document Solutions Suite is enabled.

• This menu item appears only for network printers or printers connected to
print servers.
Shortcut List

Prints a report containing information about configured shortcuts

Fax Job Log

Prints a report containing information about the last 200 completed faxes

Fax Call Log

Prints a report containing information about the last 100 attempted, received,
and blocked calls

Copy Shortcuts

Prints a report containing information about copy shortcuts

E‑mail Shortcuts

Prints a report containing information about e‑mail shortcuts

Fax Shortcuts

Prints a report containing information about fax shortcuts

FTP Shortcuts

Prints a report containing information about FTP shortcuts

Profiles List

Prints a list of profiles stored in the printer

NetWare Setup Page

Prints a report containing NetWare‑specific information about the network
settings
Note: This menu item appears only for printers with an internal print server
installed.

Print Fonts

Prints a report of all the fonts available for the printer language currently set in
the printer

Print Directory

Prints a list of all the resources stored on an optional flash memory card or printer
hard disk
Notes:

• Job Buffer Size must be set to 100%.
• The optional flash memory or printer hard disk must be installed correctly
and working properly.
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Menu item

Description

Asset Report

Prints a report containing asset information including the printer serial number
and model name. The report contains text and UPC barcodes that can be scanned
into an asset database.

Network/Ports menu
Active NIC menu
Menu item

Description

Active NIC
Auto
<list of available network cards>

Notes:

• Auto is the factory default setting.
• This menu item appears only if an optional network card is installed.

Standard Network or Network <x> menus
Note: Only active ports appear in this menu; all inactive ports are omitted.
Menu item

Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job requires
it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PostScript emulation if PS
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PS SmartSwitch is set to Off.
PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job requires
it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PCL emulation if PCL
SmartSwitch is set to On. It uses the default printer language specified in the
Setup menu if PCL SmartSwitch is set to Off.
NPA Mode
Auto
Off

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item

Description

Network Buffer
Auto
3K to <maximum size allowed>

Sets the size of the network input buffer
Notes:

• Auto is the factory default setting.
• The value can be changed in 1‑K increments.
• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether Resource Save is set to On or
Off.

• To increase the maximum size range for the Network Buffer, disable or
reduce the size of the parallel, serial, and USB buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing. This menu appears
only if a formatted disk is installed.
Notes:

• Off is the factory default setting.
• The On value buffers jobs on the printer hard disk. This menu selection
appears only when a formatted disk is installed and is not defective.

• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
Mac Binary PS
Auto
On
Off

Sets the printer to process Macintosh binary PostScript print jobs

Std Network Setup
Network Card
TCP/IP
IPv6
AppleTalk
NetWare
LexLink

Sets printer settings on jobs sent through a network port

Net <x> Setup
Reports or Network Reports
Network Card
TCP/IP
IPv6
Wireless
AppleTalk
NetWare
LexLink

Notes:

• Auto is the factory default setting.
• The Off setting filters print jobs using the standard protocol.
• The On setting processes raw binary PostScript print jobs.
Note: The Wireless menu appears only when the printer is connected to a wireless
network.
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Standard USB menu
Menu item

Description

PCL SmartSwitch
On
Off

Sets the printer to automatically switch to PCL emulation when a print job received
through a USB port requires it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PostScript emulation if the PS
SmartSwitch setting is On. It uses the default printer language specified in the
Setup menu if the PS SmartSwitch setting is Off.
PS SmartSwitch
On
Off

Sets the printer to automatically switch to PS emulation when a print job received
through a USB port requires it, regardless of the default printer language
Notes:

• On is the factory default setting.
• When the Off setting is used, the printer does not examine incoming data.
• When the Off setting is used, the printer uses PCL emulation if the PCL
SmartSwitch setting is On. It uses the default printer language specified in the
Setup menu if the PCL SmartSwitch setting is Off.
NPA Mode
Auto
Off

Sets the printer to perform the special processing required for bidirectional
communication following the conventions defined by the NPA protocol
Notes:

• Auto is the factory default setting.
• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
USB Buffer
Auto
Disabled
3K to <maximum size allowed>

Sets the size of the USB input buffer
Notes:

• Auto is the factory default setting.
• The Disabled setting turns off job buffering. Any jobs already buffered on the
disk are printed before normal processing is resumed.

• The USB buffer size value can be changed in 1‑K increments.
• The maximum size allowed depends on the amount of memory in the printer,
the size of the other link buffers, and whether the Resource Save setting is On
or Off.

• To increase the maximum size range for the USB Buffer, disable or reduce the
size of the parallel, serial, and network buffers.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
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Menu item

Description

Job Buffering
Off
On
Auto

Temporarily stores jobs on the printer hard disk before printing
Notes:

• Off is the factory default setting.
• The On setting buffers jobs on the printer hard disk.
• The Auto setting buffers print jobs only if the printer is busy processing data
from another input port.

• Changing this setting from the printer control panel and then exiting the
menus causes the printer to restart. The menu selection is updated.
Mac Binary PS
Auto
Off
On

Sets the printer to process Macintosh binary PostScript print jobs

USB With ENA
ENA Address
ENA Netmask
ENA Gateway

Sets the network address, netmask, or gateway information for an external print
server that is attached to the printer using a USB cable.

Notes:

• Auto is the factory default setting.
• The Off setting filters print jobs using the standard protocol.
• The On setting processes raw binary PostScript print jobs.

Note: This menu item is available only if the printer is attached to an external print
server through the USB port.

Network Reports menu
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > Reports or Network
Reports
Menu item

Description

Print Setup Page

Prints a report containing information about the current network setup

Print NetWare Setup
Page

Notes:

• The Setup Page contains information about the network printer settings, such as the
TCP/IP address.

• The NetWare Setup Page menu item appears only on models that support NetWare and
shows information about NetWare settings.

Network Card menu
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > Network Card
Menu item

Description

View Card Status
Connected
Disconnected

Lets you view the connection status of the Network Card
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Menu item

Description

View Card Speed

Lets you view the speed of a currently active network card

Network Address
UAA
LAA

Lets you view the network addresses

Job Timeout

Sets the amount of time in seconds that a network print job can take before it
is canceled

0‑225 seconds

Notes:

• 90 seconds is the factory default setting.
• A setting value of 0 disables the timeout.
• If a value of 1–9 is selected, then the setting is saved as 10.
Banner Page
Off
On

Allows the printer to print a banner page
Note: Off is the factory default setting.

TCP/IP menu
Use the following menu items to view or set the TCP/IP information.
Note: This menu is available only for network models or printers attached to print servers.
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > TCP/IP
Menu item

Description

Activate
On
Off

Activates TCP/IP

View Hostname

Lets you view the current TCP/IP hostname

Note: On is the factory default setting.

Note: This can be changed only from the Embedded Web Server.
IP Address

Lets you view or change the current TCP/IP Address
Note: Manually setting the IP address sets the Enable DHCP and Enable Auto IP
settings to Off. It also sets Enable BOOTP and Enable RARP to Off on systems that
support BOOTP and RARP.

Netmask

Lets you view or change the current TCP/IP Netmask

Gateway

Lets you view or change the current TCP/IP Gateway

Enable DHCP
On
Off

Specifies the DHCP address and parameter assignment setting

Enable RARP
On
Off

Specifies the RARP address assignment setting

Note: On is the factory default setting.

Note: On is the factory default setting.
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Menu item

Description

Enable BOOTP
On
Off

Specifies the BOOTP address assignment setting

Enable AutoIP
Yes
No

Specifies the Zero Configuration Networking setting

Enable FTP/TFTP
Yes
No

Enables the built-in FTP server, which allows you to send files to the printer using the
File Transfer Protocol.

Enable HTTP Server
Yes
No

Enables the built-in Web server (Embedded Web Server). When enabled, the printer
can be monitored and managed remotely using a web browser.

DNS Server Address

Lets you view or change the current DNS Server Address

Enable DDNS/MDNS

Lets you view or change the current DDNS/MDNS Server Address

WINS Server Address

Lets you view or change the current WINS Server Address

Note: On is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

Note: Yes is the factory default setting.

IPv6 menu
Use the following menu items to view or set the Internet Protocol version 6 (IPv6) information.
Note: This menu is available only for network models or printers attached to print servers.
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > IPv6
Menu item

Description

Enable IPv6
On
Off

Enables IPv6 in the printer

Auto Configuration
On
Off

Specifies whether the network adapter accepts the automatic IPv6
address configuration entries provided by a router

View Hostname

Lets you view the current setting

View Address

Note: These settings can be changed only from the Embedded Web
Server.

Note: On is the factory default setting.

Note: On is the factory default setting.

View Router Address
Enable DHCPv6
On
Off

Enables DHCPv6 in the printer
Note: On is the factory default setting.
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Wireless menu
Use the following menu items to view or configure the wireless internal print server settings.
Note: This menu is available only for models connected to a wireless network.
This menu is available from the Network/Ports menu:
Network/Ports > Network <x> > Net <x> Setup > Wireless
Menu item

Description

Network Mode
Infrastructure
Ad hoc

Specifies the network mode
Notes:

• Infrastructure mode lets the printer access a network using an
access point.

• Ad hoc is the factory default setting. Ad hoc mode configures the
printer for wireless networking directly between it and a computer.
Compatibility
802.11n
802.11b/g
802.11b/g/n

Specifies the wireless standard for the wireless network

Choose Network
<list of available networks>

Lets you select an available network for the printer to use

View Signal Quality

Lets you view the quality of the wireless connection

View Security Mode

Lets you view the encryption method for the wireless connection.
“Disabled” indicates that the wireless network is not encrypted.

AppleTalk menu
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > AppleTalk
Menu item

Description

Activate
Yes
No

Activates AppleTalk support

View Name

Shows the assigned AppleTalk name

Note: Yes is the factory default setting.

Note: The name can be changed only from the Embedded Web Server.
View Address

Shows the assigned AppleTalk address
Note: The address can be changed only from the Embedded Web Server.

Set Zone
<list of zones available on the
network>

Provides a list of AppleTalk zones available on the network
Note: The default setting is the default zone for the network. If no default
zone exists, the zone marked with an * is the default setting.
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NetWare menu
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > NetWare
Menu item

Description

Activate
Yes
No

Activates NetWare support

View Login Name

Lets you view the assigned NetWare login name

Note: No is the factory default setting.

Note: This can be changed only from the Embedded Web Server.
Print Mode

Lets you view the assigned NetWare print mode
Note: This can be changed only from the Embedded Web Server.

Network Number

Lets you view the assigned NetWare network number
Note: This can be changed only from the Embedded Web Server.

Select SAP Frames
Ethernet 802.2
Ethernet 802.3
Ethernet Type II
Ethernet SNAP

Enables the Ethernet frame type setting

Packet Burst
Yes
No

Reduces network traffic by allowing the transfer and acknowledgement of
multiple data packets to and from the NetWare server

NSQ/GSQ Mode
Yes
No

Specifies the NSQ/GSQ Mode setting

Note: On is the factory default setting for all menu items.

Note: Yes is the factory default setting.
Note: Yes is the factory default setting.

LexLink menu
This menu is available from the Network/Ports menu:
Network/Ports > Standard Network or Network <x> > Std Network Setup or Net <x> Setup > LexLink menu
Menu item

Description

Activate
On
Off

Activates LexLink support

View Nickname

Lets you view the assigned LexLink nickname

Note: Off is the factory default setting.

Note: The LexLink nickname can be changed only from the Embedded Web
Server.

SMTP Setup menu
Use the following menu to configure the SMTP server.
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Menu item

Description

Primary SMTP Gateway

Specifies SMTP server port information

Primary SMTP Gateway Port

Note: 25 is the default SMTP gateway port.

Secondary SMTP Gateway
Secondary SMTP Gateway Port
SMTP Timeout
5–30

Specifies the amount of time in seconds before the server stops trying to
send the e‑mail
Note: 30 seconds is the factory default setting.

Reply Address

Specifies server information. This is a required item.

Use SSL
Disabled
Negotiate
Required

Notes:

SMTP Server Authentication
No authentication required
Login / Plain
CRAM‑MD5
Digest‑MD5
NTLM
Kerberos 5

Specifies the type of user authentication required for scan to e‑mail
privileges

Device‑Initiated E‑mail
None
Use Device SMTP Credentials

Specifies server information

User‑Initiated E‑mail
None
Use Device SMTP Credentials
Use Session User ID and Password
Use Session E‑mail address and Password
Prompt User
Device Userid
Device password
Kerberos 5 Realm
NTLM Domain

• The message box has a limitation of 512 characters.
• Disabled is the factory default setting for Use SSL.

Note: “No authentication required” is the factory default setting.

Notes:

• The message boxes have a limitation of 512 characters.
• None is the factory default setting for Device‑Initiated E‑mail and
User‑Initiated E‑mail.
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Security menu
Miscellaneous menu
Menu item

Description

Panel Logins
Login failures
Failure time frame
Lockout time
Panel Login Timeout
Remote Login Timeout

Limits the number and time frames of failed login attempts from the printer control
panel before all users are locked out
Notes:

• “Login failures” specifies the number of failed login attempts before users are
locked out. Settings range from 1–50. 3 attempts is the factory default setting.

• “Failure time frame” specifies the time frame during which failed login
attempts can be made before users are locked out. Settings range from 1–60
minutes. 5 minutes is the factory default setting.

• “Lockout time” specifies how long users are locked out after exceeding the
login failures limit. Settings range from 0–60 minutes. 5 minutes is the factory
default setting. 0 indicates the printer does not impose a lockout time.

• “Panel Login Timeout” specifies how long the printer remains idle on the
Home screen before automatically logging the user off. Settings range from 1–
900 seconds. 300 seconds is the factory default setting.
Remote Logins
Login failures
Failure time frame
Lockout time
Login timeout

Limits the number and time frames of failed login attempts from a computer before
all remote users are locked out
Notes:

• “Login failures” specifies the number of failed login attempts before users are
locked out. Settings range from 1–50. 3 attempts is the factory default setting.

• “Failure time frame” specifies the time frame during which failed login
attempts can be made before users are locked out. Settings range from 1–60
minutes. 5 minutes is the factory default setting.

• “Lockout time” specifies how long a user is locked out after exceeding the
login failures limit. Settings range from 0–60 minutes. 5 minutes is the factory
default setting. 0 indicates the printer does not impose a lockout time.

• “Login timeout” specifies how long the remote interface remains idle before
automatically logging the user off. Settings range from 1–900 seconds. 300
seconds is the factory default setting.

Confidential Print menu
Menu item

Description

Max Invalid PIN
Off
2–10

Limits the number of times an invalid PIN can be entered
Notes:

• Off is the default setting.
• This menu item appears only if a printer hard disk is installed.
• Once a limit is reached, the jobs for that user name and that PIN are deleted.
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Menu item

Description

Job Expiration
Off
1 hour
4 hours
24 hours
1 week

Limits the amount of time a confidential job stays in the printer before it is deleted
Notes:

• Off is the default setting.
• If the Job Expiration setting is changed while confidential jobs reside on the
printer RAM or printer hard disk, the expiration time for those print jobs does
not change to the new default value.

• If the printer is turned off, all confidential jobs held in printer RAM are
deleted.

Disk Wiping menu
Menu item

Description

Wiping Mode

Sets the wiping mode to Auto, Manual or Off

Automatic Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.
Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the default setting.
• Highly confidential information should be wiped using the Multiple pass
method only.
Manual Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.
Both manual and scheduled wiping allow the file system to reuse marked disk space
without first having to wipe it.
Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the default setting.
• Highly confidential information should be wiped using the Multiple Pass
method only.

Understanding printer menus

153

Menu item

Description

Scheduled Method
Single pass
Multiple pass

Disk Wiping erases only print job data that is not currently in use by the file system
from the printer hard disk. All permanent data on the printer hard disk is preserved,
such as downloaded fonts, macros, and held jobs.
Both manual and scheduled wiping allow the file system to reuse marked disk space
without first having to wipe it.
Notes:

• This menu item appears only if a formatted, non-defective printer hard disk is
installed.

• Single pass is the default setting.
• Highly confidential information should be wiped using the Multiple Pass
method only.

• Scheduled wipes are initiated without displaying a user warning or
confirmation message.

Security Audit Log menu
Menu item

Description

Export Log

Enables an authorized user to export the security log
Notes:

• To export the log from the printer control panel, a flash drive must be
attached to the printer.

• From the Embedded Web Server, the log can be downloaded to a computer.
Delete Log
Yes
No

Specifies whether audit logs are deleted

Configure Log
Enable Audit
Enable Remote Syslog
Remote Syslog Server
Remote Syslog Port
Remote Syslog Method
Remote Syslog Facility

Specifies whether and how the audit logs are created

Note: Delete Now is the factory default setting.

Set Date and Time menu
Menu item

Description

Current Date and Time

Lets you view the current date and time settings for the printer

Manually Set Date & Time
<input date/time>

Note: Date/Time is set in YYYY-MM-DD HH:MM format.

Time Zone
<list of time zones>

Note: GMT is the factory default setting.
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Menu item

Description

Automatically Observe DST
On
Off

Note: On is the factory default setting and uses the applicable Daylight Saving Time
associated with the Time Zone setting.

Custom Time Zone Setup

Set up your time zone.

Enable NTP
On
Off

Enables Network Time Protocol, which synchronizes the clocks of devices on a
network
Note: On is the factory default setting.

Settings menu
General Settings menu
Menu item

Description

Display Language
English
Francais
Deutsch
Italiano
Espanol
Dansk
Norsk
Nederlands
Svenska
Portuguese
Suomi
Russian
Polski
Magyar
Turkce
Cesky
Simplified Chinese
Traditional Chinese
Korean
Japanese

Sets the language of the text appearing on the display
Note: All languages may not be available for all printers.

Understanding printer menus

155

Menu item

Description

Eco-Mode
Off
Energy
Energy/Paper
Paper

Minimizes the use of energy, paper, or specialty media
Notes:

• Off is the factory default setting. Off resets the printer to its
factory default settings.

• The Energy setting minimizes the power used by the printer.
Performance may be affected, but print quality is not.

• The Paper setting minimizes the amount of paper and
specialty media needed for a print job. Performance may be
affected, but print quality is not.

• Energy/Paper minimizes the use of power and of paper and
specialty media.
Run Initial setup
Yes
No

Instructs the printer to run the setup wizard
Notes:

• Yes is the factory default setting.
• After completing the setup wizard by selecting Done at the
Country select screen, the default becomes No.

Paper Sizes
US
Metric

Notes:

• The initial setting is determined by your Country selection in
the initial setup wizard.

• Changing this setting also changes the Units of Measurement
setting in the Universal Setup menu and the default for each
input source in the Paper Size/Paper Type menu.
Output Lighting
Normal/Standby Mode

• Bright
• Dim
• Off
Power Saver

• Bright
• Dim
• Off

Sets the amount of light from an optional output bin
Notes:

• In Normal/Standby Mode, the factory default setting is
Bright.

• In Power Saver Mode, the factory default setting is Dim.
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Menu item

Description

Alarms
Alarm Control
Cartridge Alarm
Staple Alarm
Hole Punch Alarm

Sets an alarm to sound when the printer requires operator
intervention
Available selections for each alarm type are:
Off
Single
Continuous
Notes:

• Single is the factory default setting for Alarm Control. Single
sounds three quick beeps.

• Off is the factory default setting for Cartridge Alarm and
Staple Alarm. Off means no alarm will sound.

• Continuous repeats three beeps every 10 seconds.
• The Staple Alarm is available only when the finisher is
installed.

• The Hole Punch Alarm is only displayed when a finisher with
hole punch is installed.
Timeouts
Standby Mode

Sets the amount of time the printer is in standby mode

Timeouts
Power Saver
1–240 min

Sets the amount of time the printer waits after a job is printed
before it goes into a reduced power state
Notes:

• 30 minutes is the factory default setting.
• Lower settings conserve more energy, but may require
longer warm‑up times.

• Select the lowest setting if the printer shares an electrical
circuit with room lighting or you notice lights flickering in the
room.

• Select a high setting if the printer is in constant use. Under
most circumstances, this keeps the printer ready to print
with minimum warm‑up time.
Timeouts
Screen Timeout
15–300 sec

Sets the amount of time in seconds the printer waits before
returning the printer display to a Ready state

Timeouts
Print Timeout
Disabled
1–255 sec

Sets the amount of time in seconds the printer waits to receive an
end‑of‑job message before canceling the remainder of the print job

Note: 30 seconds is the factory default setting.

Notes:

• 90 seconds is the factory default setting.
• When the timer expires, any partially printed page still in the
printer is printed, and then the printer checks to see if any
new print jobs are waiting.

• Print Timeout is available only when using PCL emulation.
This setting has no effect on PostScript emulation print jobs.
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Menu item

Description

Timeouts
Wait Timeout
Disabled
15–65535 sec

Sets the amount of time in seconds the printer waits for additional
data before canceling a print job
Notes:

• 40 seconds is the factory default setting.
• Wait Timeout is available only when the printer is using
PostScript emulation. This setting has no effect on PCL or
PPDS emulation print jobs.

Timeouts
Job Hold Timeout
5–255 sec

Sets the amount of time the printer waits for user intervention
before it holds jobs that require unavailable resources and
continues to print other jobs in the print queue
Notes:

• 30 seconds is the factory default setting.
• This menu item appears only when a printer hard disk is
installed.
Print Recovery
Auto Continue
Disabled
5–255 sec

Lets the printer automatically continue printing from certain offline
situations when they are not resolved within the specified time
period

Print Recovery
Jam Recovery
Auto
On
Off

Specifies whether the printer reprints jammed pages

Note: Disabled is the factory default setting.

Notes:

• Auto is the factory default setting. The printer reprints
jammed pages unless the memory required to hold the
pages is needed for other printer tasks.

• On sets the printer to always reprint jammed pages.
• Off sets the printer to never reprint jammed pages.
Print Recovery
Page Protect
Off
On

Lets the printer successfully print a page that may not have printed
otherwise
Notes:

• Off is the factory default setting. Off prints a partial page
when there is not enough memory to print the whole page.

• On sets the printer to process the whole page so that the
entire page prints.
Factory Defaults
Do Not Restore
Restore Now

Returns the printer settings to the factory default settings
Notes:

• Do Not Restore is the factory default setting. Do Not Restore
keeps the user‑defined settings.

• Restore Now returns all printer settings to the factory
default settings except Network/Ports menu settings. All
downloads stored in RAM are deleted. Downloads stored in
flash memory or on a printer hard disk are not affected.
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Copy Settings menu
Menu item

Description

Content
Text/Photo
Photograph
Printed Image
Text

Specifies the type of content contained in the copy job
Notes:

• Text/Photo is the factory default setting. Text/Photo is used when the original
documents are a mixture of text and graphics or pictures.

• Photograph tells the scanner to pay extra attention to graphics and pictures.
This setting increases the time it takes to scan, but emphasizes a reproduction
of the full dynamic range of tones in the original document. This increases the
amount of information saved.

• Printed Image is used when jobs are composed primarily of images. Printed
Image converts the images to halftone. Halftoning makes a grayscale or color
image printable by transforming it to a pattern of small spots with a limited
number of colors.

• Text emphasizes sharp, black, high-resolution text against a clean, white
background.
Sides (Duplex)
1 sided to 1 sided
1 sided to 2 sided
2 sided to 1 sided
2 sided to 2 sided

Specifies whether an original document is duplex (two‑sided) or simplex (one-sided),
and then specifies whether the copy should be duplex or simplex
Notes:

• 1 sided to 1 sided—The original page has printing on one side. The copied
page will have printing on one side.

• 1 sided to 2 sided—The original page has printing on one side. The copied
page will have printing on both sides. For example, if the original is six sheets,
the copy is three sheets with printing on both sides.

• 2 sided to 1 sided—The original page has printing on both sides. The copied
page will have printing on only one side. For example, if the original draft is
three sheets of paper with an image on each side of each sheet, then the copy
is six sheets with only one image on one side of each sheet.

• 2 sided to 2 sided—The original page has printing on both sides. The copy
mimics the original exactly.
Paper Saver
Off
2 on 1 Portrait
2 on 1 Landscape
4 on 1 Portrait
4 on 1 Landscape

Sets two or four sheets of an original document together on the same page

Collate
On
Off

Keeps the pages of a print job stacked in sequence when making multiple copies of
the job

Staple

Enables stapling

Note: Off is the factory default setting.

Note: On is the factory default setting.
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Menu item

Description

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the original document

Copy To Source
Tray <x>
Single Sheet Feeder
Multi Sheet Feeder
Auto Size Match

Specifies the paper source for copy jobs

Transparency Separators
On
Off

Places a sheet of paper between transparencies

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Places a sheet of paper between pages, copies, or jobs based on the value selected

Separator Source
Tray <x>
Manual Feeder
Envelope Feeder

Specifies a paper source

Darkness
1–9

Specifies the level of darkness for the copy job

Output Bin
Standard Bin
Bin <x>

Specifies which output bin receives the copy after it is printed

Number of Copies

Specifies the number of copies for the copy job

Note: Tray 1 is the factory default setting.

Note: On is the factory default setting.

Note: None is the factory default setting.

Understanding printer menus

160

Menu item

Description

Header/Footer
Top left
Top left
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the top left of the page

Header/Footer
Top middle
Top middle
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the middle of the page

Header/Footer
Top right
Top right
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the top right of the page

Notes:

• Off is the factory default setting for Top left.
• “All pages” is the factory default setting for Print on.

Notes:

• Off is the factory default setting for Top middle.
• “All pages” is the factory default setting for Print on.

Notes:

• Off is the factory default setting for Top right.
• “All pages” is the factory default setting for Print on.
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Menu item

Description

Header/Footer
Bottom left
Bottom left
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the bottom left of the page

Header/Footer
Bottom middle
Bottom middle
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the bottom middle of the page

Header/Footer
Bottom right
Bottom right
Off
Date/Time
Page number
Bates number
Custom text
Print on
All pages
First page only
All but first page
Enter custom text

Specifies header/footer information for the bottom right of the page

Notes:

• Off is the factory default setting for Bottom left.
• “All pages” is the factory default setting for Print on.

Notes:

• Off is the factory default setting for Bottom middle.
• “All pages” is the factory default setting for Print on.

Notes:

• Off is the factory default setting for Bottom right.
• “All pages” is the factory default setting for Print on.
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Menu item

Description

Overlay
Off
Confidential
Copy
Draft
Urgent
Custom

Specifies overlay text that is printed on each page of the copy job

Custom Overlay

Specifies custom overlay text

Allow priority copies
On
Off

Allows interruption of a print job to copy a page or document

Custom Job scanning
On
Off

Lets you copy in a single copy job a document that contains mixed paper sizes

Allow Save as Shortcut
On
Off

Lets you save custom copy settings as shortcuts

Background Removal
‑4 to +4

Adjusts the amount of background visible on a copy

Note: Off is the factory default setting.

Note: On is the factory default setting.

Note: On is the factory default setting.

Fax Settings menu
Fax Mode (Analog Fax Setup) menu
Analog Fax Setup mode sends the fax job by way of a telephone line.
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General Fax Settings
Menu item

Description

Fax Cover Page
Fax Cover Page
Off by default
On by default
Never Use
Always Use
Include To field
On
Off
Include From field
On
Off
From
Include Message field
On
Off
Message
Include Logo
On
Off
Include Footer <x>
Footer <x>

Configures the fax cover page

Station Name

Specifies the name of the fax within the printer

Station Number

Specifies a number associated with the fax

Station ID
Station Name
Station Number

Specifies how the fax is identified

Enable Manual Fax
On
Off

Sets the printer to fax manually only, which requires a line splitter and a telephone
hand set

Note: Off is the factory default setting for all Fax Cover Page options.

Notes:

• Use a regular telephone to answer an incoming fax job and to dial a fax
number.

• Touch # 0 on the numeric keypad to go directly to the Manual Fax function.
Memory Use
All receive
Mostly receive
Equal
Mostly sent
All send

Defines the allocation of non-volatile memory between sending and receiving fax jobs
Notes:

• “All receive” specifies that all the memory is set to receive fax jobs.
• “Mostly receive” specifies that most of the memory is set to receive fax jobs.
• Equal is the factory default setting. Equal splits the memory for sending and
receiving fax jobs into equal amounts.

• “Mostly sent” specifies that most of the memory is set to send fax jobs.
• “All send” specifies that all the memory is set to send fax jobs.
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Menu item

Description

Cancel Faxes
Allow
Don't Allow

Specifies whether the printer may cancel fax jobs

Caller ID
FSK
DTMF

Specifies type of caller ID being used

Fax number masking
Off
From left
From right

Specifies the direction from which digits are masked in an outgoing fax number

Digits to mask
0–58

Specifies the number of digits to mask in an outgoing fax number

Note: If Cancel Faxes is not enabled, it will not appear as an option.

Note: FSK is the factory default setting.

Note: The number of characters masked is determined by the “Digits to mask”
setting.

Fax Send Settings
Menu item

Description

Resolution
Standard
Fine
Super Fine
Ultra Fine

Specifies quality in dots per inch (dpi). A higher resolution gives greater print quality,
but it increases the fax transmission time for outgoing faxes.

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the document that is being scanned

Note: Standard is the factory default setting.

Note: Letter is the US factory default setting. A4 is the international factory default
setting.
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Menu item

Description

Sides (Duplex)
Off
Long edge
Short edge

Specifies how the text and graphics are oriented on the page
Notes:

• Off is the factory default setting.
• Long edge assumes binding along the long edge of the page (left edge for
portrait orientation and top edge for landscape orientation).

• Short edge assumes binding along the short edge of the page (top edge for
portrait orientation and left edge for landscape orientation).
Content
Text
Text/Photo
Photograph

Specifies the type of content that will be scanned to fax
Notes:

• Text is used when the document is mostly text.
• Text/Photo is the factory default setting. Text/Photo is used when the
documents are mostly text or line art.

• Photograph is used when the document is a high-quality photograph or inkjet
print.
Darkness
1–9

Lightens or darkens the output

Dial Prefix

A numeric entry field is provided to enter numbers

Dialing Prefix Rules
Prefix Rule <x>

Establishes a dialing prefix rule

Automatic Redial
0–9

Specifies the number of times the printer tries to send the fax to a specified number

Redial Frequency
1–200

Specifies the number of minutes between redials

Behind a PABX
Off
On

Enables switchboard blind dialing without a dial tone

Enable ECM
On
Off

Enables Error Correction Mode for fax jobs

Enable Fax Scans
On
Off

Lets you send faxes by scanning at the printer

Driver to fax
On
Off

Allows driver to fax jobs to be sent by the printer

Allow Save as Shortcut
On
Off

Lets you save fax numbers as shortcuts in the printer

Note: 5 is the factory default setting.

Note: 5 is the factory default setting.
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Menu item

Description

Dial Mode
Tone
Pulse

Specifies the dialing sound, either as a tone or a pulse.

Max Speed
2400
4800
9600
14400
33600

Specifies the maximum speed in baud at which faxes are sent

Custom Job scanning
On
Off

Lets you scan a document that contains mixed paper sizes into a single file

Scan Preview
On
Off

Specifies whether a preview will appear on the display for scan jobs

Background Removal
‑4 to +4

Adjusts the amount of background visible on a copy

Auto Center
On
Off

Lets you automatically center the fax on the page

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specifies which color to drop during faxing, and how much to increase or decrease
the dropout

Contrast
Best for content
0–5

Specifies the contrast of the output

Mirror Image
On
Off

Creates a mirror image of the original document

Negative Image
On
Off

Creates a negative image of the original document

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: “Best for content” is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.
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Menu item

Description

Shadow Detail
0–4

Adjusts the amount of shadow detail visible on a fax

Scan edge to edge
On
Off

Specifies if the original document is scanned edge-to‑edge prior to faxing

Sharpness
0–5

Adjusts the amount of sharpness on a fax

Enable Color Fax Scans
On by default
Never use
Always use
Off by default

Enables color faxing

Auto Convert Color Faxes to Mono
Faxes
On
Off

Converts all outgoing faxes to black and white

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.
Note: “Off by default” is the factory default setting.

Note: On is the factory default setting.

Fax Receive Settings
Menu item

Description

Enable Fax Receive
On
Off

Allows fax jobs to be received by the printer

Rings to Answer
1–25

Specifies the number of rings before answering an incoming fax job

Auto Reduction
On
Off

Scales an incoming fax job so it fits the size of the paper loaded in the designated fax
source

Paper Source
Auto
Tray <x>
Multi‑Purpose Feeder

Specifies the paper source selected to supply paper for the printer to print an incoming
fax

Output Bin
Standard Bin
Bin 1<x>

Specifies an output bin for received faxes

Sides (Duplex)
On
Off

Enables duplex printing (two-sided printing) for incoming fax jobs

Fax Footer
On
Off

Prints the transmission information at the bottom of each page from a received fax

Note: On is the factory default setting.

Note: 1 is the factory default setting.

Note: On is the factory default setting.

Note: Bin 1 is available only when the finisher is installed.

Note: On is the factory default setting.
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Menu item

Description

Max Speed
2400
4800
9600
14400
33600

Specifies the maximum speed in baud at which faxes are received

Fax Forwarding
Forward
Print
Print and Forward

Enables forwarding of received faxes to another recipient

Forward to
Fax
E‑mail
FTP
LDSS
eSF

Specifies the type of recipient to which faxes will be forwarded

Forward to Shortcut

Lets you enter the shortcut number which matches the recipient type (Fax, E-mail,
FPT, LDSS, or eSF)

Block No Name Fax
On
Off

Enables blocking of incoming faxes sent from devices with no station ID specified

Banned Fax List

Enables the list of banned fax numbers stored in the printer

Holding Faxes
Held Fax Mode
Off
Always On
Manual
Scheduled
Fax Holding Schedule

Enables fax holding all of the time or according to a set schedule

Staple
On
Off

Specifies the default staple setting for the attached finisher

Note: This item is available only from the printer Embedded Web Server.

Note: Off is the factory default setting.

Note: Only the settings associated with the installed finisher appear.

Fax Log Settings
Menu item

Description

Transmission Log
Print log
Do not print log
Print only for error

Enables printing of a transmission log after each fax job

Receive Error Log
Print Never
Print on Error

Enables printing of a receive error log following a receive error
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Menu item

Description

Auto Print Logs
On
Off

Enables automatic printing of fax logs

Log Paper Source
Tray <x>
Manual Feeder

Selects the source of the paper used for printing logs

Logs Display
Remote Station Name
Dialed Number

Specifies whether printed logs display the dialed number or the station name returned

Enable Job Log
On
Off

Enables access to the Fax Job log

Enable Call Log
On
Off

Enables access to the Fax Call log

Log Output Bin
Standard Bin
Bin <x>

Specifies the output bin where fax logs are printed

Note: Logs print after every 200 jobs.

Speaker Settings
Menu item

Description

Speaker Mode
Always Off
On until Connected
Always On

Notes:

• Always Off turns the speaker off.
• On until Connected is the factory default setting. The speaker is on and issues a
noise until the fax connection is made.

• Always On turns the speaker on.
Speaker Volume
High
Low

Controls the volume setting

Ringer Volume
On
Off

Controls the fax speaker ringer volume

Note: High is the factory default setting.

Note: On is the factory default setting.

Distinctive Rings
Menu item

Description

Single Ring
On
Off

Answers calls with a one‑ring pattern
Note: On is the factory default setting.
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Menu item

Description

Double Ring
On
Off

Answers calls with a double‑ring pattern

Triple Ring
On
Off

Note: On is the factory default setting.
Answers calls with a triple‑ring pattern
Note: On is the factory default setting.

Fax Mode (Fax Server Setup) menu
Fax Server mode sends the fax job to a fax server for transmission.

Fax Server Setup
Menu item

Description

To Format

Lets you enter the information using the virtual keyboard on the printer touch screen

Reply Address
Subject
Message
Primary SMTP Gateway

Specifies SMTP server port information
Note: 25 is the default SMTP gateway port.

Secondary SMTP Gateway

Specifies SMTP server port information
Note: 25 is the default SMTP gateway port.

Image Format
PDF (.pdf)
XPS (.xps)
TIFF (.tif)

Specifies the image type for scan to fax

Content
Text
Text/Photo
Photograph

Specifies the type of content that will be scanned to fax
Notes:

• Text is used when the document is mostly text.
• Text/Photo is the factory default setting. Text/Photo is used when the
documents are mostly text or line art.

• Photograph is used when the document is a high-quality photograph or inkjet
print.
Fax Resolution
Standard
Fine
Super Fine
Ultra Fine

Specifies the resolution level for scan to fax

Darkness
1–9

Lightens or darkens the output
Note: 5 factory default setting.
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Menu item

Description

Orientation
Portrait
Landscape

Specifies the orientation of the scanned image

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the document that is being scanned

Use Multi‑Page TIFF
On
Off

Provides a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan to fax job, either one TIFF file is created containing all the pages,
or multiple TIFF files are created with one file for each page of the job.

Note: Letter is the US factory default setting. A4 is the international factory default
setting.

Notes:

• On is the factory default setting.
• This menu item applies to all scan functions.
Enable Analog Receive
On
Off

Enables analog fax receive
Note: Off is the factory default setting.

E‑mail Settings menu
Menu item

Description

E‑mail Server Setup
Subject
Message

Specifies e‑mail server information
Note: The message box has a limitation of 512 characters.
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Menu item

Description

E‑mail Server Setup
Send me a copy
Never appears
On by default
Off by default
Always On

Sends a copy of the e-mail back to the creator of the e-mail

E‑mail Server Setup
Max e‑mail size
0–65535 KB

Specifies the maximum e-mail size in kilobytes

E‑mail Server Setup
Size Error Message

Sends a message when an e-mail is greater than the configured size limit

E‑mail Server Setup
Limit destinations

Sends an e-mail only when the address contains the domain name, such as a company
domain name

Note: E-mail above the specified size is not sent.

Notes:

• E-mail can only be sent to the specified domain.
• The limit is one domain.
E‑mail Server Setup
Web Link Setup
Server
Login
Password
Path
Base file name
Web Link

Defines the path name

Format
PDF (.pdf)
Secure PDF
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)

Specifies the format of the file

PDF Version
1.2–1.6

Sets the version of the PDF file that will be scanned to e‑mail

Content
Text/Photo
Photograph
Text

Specifies the type of content that will be scanned to e‑mail

Note: Defines the path. For example: /directory/path
The following characters or symbols are invalid entries for a path name: * : ? <
> |.

Note: 1.5 is the factory default setting.

Notes:

• Text/Photo is the factory default setting. Text/Photo is used when the
documents are mostly text or line art.

• Photograph is used when the document is a high-quality photograph or inkjet
print.

• Text is used when the document is mostly text.
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Menu item

Description

Color
Gray
Color

Specifies whether a job prints in grayscale or color

Resolution
75
150
200
300
400
600

Specifies how many dots per inch are scanned

Darkness
1–9

Lightens or darkens the output

Orientation
Portrait
Landscape

Specifies the orientation of the scanned image

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the document that is being scanned

Sides (Duplex)
Off
Long edge
Short edge

Specifies how the text and graphics are oriented on the page

Note: Gray is the factory default setting.

Note: 150 dpi is the factory default setting.

Note: 5 is the factory default setting.
Note: Portrait is the factory default setting.

Note: Letter is the US factory default setting. A4 is the international factory default
setting.

Notes:

• Off is the factory default setting.
• Long edge assumes binding along the long edge of the page (left edge for
portrait orientation and top edge for landscape orientation).

• Short edge assumes binding along the short edge of the page (top edge for
portrait orientation and left edge for landscape orientation).
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Menu item

Description

JPEG Quality
Best for content
5–90

Sets the quality of a JPEG photo image in relation to file size and the quality of the
image
Notes:

•
•
•
•

“Best for content” is the factory default setting.
5 reduces the file size, but the quality of the image is lessened.
90 provides the best image quality, but the file size is very large.
This menu item applies to all scan functions.

E‑mail images sent as
Attachment
Web Link

Specifies how the images will be sent

Use Multi‑Page TIFF
On
Off

Provides a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan to e-mail job, either one TIFF file is created containing all the
pages, or multiple TIFF files are created with one file for each page of the job.

Note: Attachment is the factory default setting.

Notes:

• On is the factory default setting.
• This menu item applies to all scan functions.
Transmission Log
Print log
Do not print log
Print only for error

Specifies whether the transmission log prints

Log Paper Source
Tray <x>
Manual Feeder
Manual Env
MP Feeder

Specifies a paper source for printing e-mail logs

Log Output Bin
Standard Bin
Bin <x>

Specifies an output bin for the printed e‑mail log

E‑mail Bit Depth
8 bit
1 bit

Enables the Text/Photo mode to have smaller file sizes by using 1‑bit images when
Color is set to Off.

Custom Job scanning
On
Off

Lets you copy a document that contains mixed paper sizes into a single job

Scan Preview
On
Off

Specifies whether a preview will appear on the display for scan jobs

Note: “Print log” is the factory default setting.

Note: Tray 1 is the factory default setting.

Note: 8 bit is the factory default setting.

Note: Off is the factory default setting.
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Menu item

Description

Allow Save as Shortcut
On
Off

Lets you save e-mail addresses as shortcuts
Notes:

• Off is the factory default setting.
• When set to Off, the Save as Shortcut button does not appear on the E-mail
Destination screen.

Background Removal
‑4 to +4

Adjusts the amount of background visible on a scanned image

Auto Center
On
Off

Lets you automatically center the copy on the page

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specifies which color to drop during scanning, and how much to increase or decrease
the dropout

Contrast
0–5
Best for content

Specifies the contrast of the output

Mirror Image
On
Off

Creates a mirror image of the original document

Negative Image
On
Off

Creates a negative image of the original document

Shadow Detail
0–4

Adjusts the amount of shadow detail visible on a scanned image

Scan edge to edge
On
Off

Specifies whether the original document is scanned edge-to-edge

Sharpness
0–5

Adjusts the amount of sharpness on a scanned image

Use cc:/bcc:
On
Off

Enables the use of the cc: and bcc: fields

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: “Best for content” is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.
Note: Off is the factory default setting.
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FTP Settings menu
Menu item

Description

Format
PDF (.pdf)
Secure PDF
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)

Specifies the format of the FTP file

PDF Version
1.2–1.6

Sets the version level of the PDF file for FTP

Content
Text/Photo
Photograph
Text

Specifies the type of content that will be scanned to FTP

Note: PDF (.pdf) is the factory default setting.

Note: 1.5 is the factory default setting.

Notes:

• Text/Photo is the factory default setting. Text/Photo is used when the
documents are mostly text or line art.

• Photograph is used when the document is a high-quality photograph or inkjet
print

• Text is used when the document is mostly text.
Color
Gray
Color

Specifies whether a job prints in grayscale or color

Resolution
75
150
200
300
400
600

Specifies how many dots per inch are scanned

Darkness
1–9

Lightens or darkens the output

Orientation
Portrait
Landscape

Specifies the orientation of the scanned image

Note: Gray is the factory default setting.

Note: 150 dpi is the factory default setting.

Note: 5 is the factory default setting.
Note: Portrait is the factory default setting.
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Menu item

Description

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the document that is being scanned

Sides (Duplex)
Off
Long edge
Short edge

Specifies how the text and graphics are oriented on the page

Note: Letter is the US factory default setting. A4 is the international factory default
setting.

Notes:

• Off is the factory default setting.
• Long edge assumes binding along the long edge of the page (left edge for
portrait orientation and top edge for landscape orientation).

• Short edge assumes binding along the short edge of the page (top edge for
portrait orientation and left edge for landscape orientation).
JPEG Quality
Best for content
5–90

Sets the quality of a JPEG photo image in relation to file size and the quality of the
image
Notes:

•
•
•
•
Use Multi‑Page TIFF
On
Off

“Best for content” is the factory default setting.
5 reduces the file size, but the quality of the image is lessened.
90 provides the best image quality, but the file size is very large.
This menu item applies to all scan functions.

Provides a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan to FTP job, either one TIFF file is created containing all the pages,
or multiple TIFF files are created with one file for each page of the job.
Notes:

• On is the factory default setting.
• This menu item applies to all scan functions.
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Menu item

Description

Transmission Log
Print log
Do not print log
Print only for error

Specifies whether the transmission log prints

Log Paper Source
Tray <x>
Manual Feeder
Manual Env
MP Feeder

Specifies a paper source for FTP logs

Log Output Bin
Standard Bin
Bin <x>

Specifies an output bin for the FTP log

FTP bit Depth
8 bit
1 bit

Enables the Text/Photo mode to have smaller file sizes by using 1‑bit images when
Color is set to Off

Base File Name

Lets you enter a base file name

Custom Job Scanning
On
Off

Lets you copy a document that contains mixed paper sizes into a single job

Scan Preview
On
Off

Specifies whether a preview will appear on the display for scan jobs

Allow Save as Shortcut
On
Off

Enables shortcut creation for FTP addresses

Background Removal
‑4 to +4

Adjusts the amount of background visible on a copy

Auto Center
On
Off

Lets you automatically center the copy on the page

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specifies which color to drop during scanning, and how much to increase or decrease
the dropout

Note: “Print log” is the factory default setting.

Note: Tray 1 is the factory default setting.

Note: 8 bit is the factory default setting.

Note: Off is the factory default setting.

Note: On is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.
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Menu item

Description

Contrast
0–5
Best for content

Specifies the contrast of the output

Mirror Image
On
Off

Creates a mirror image of the original document

Negative Image
On
Off

Creates a negative image of the original document

Shadow Detail
0–4

Adjusts the amount of shadow detail visible on a scanned image

Scan edge to edge
On
Off

Specifies whether the original document is scanned edge-to-edge

Sharpness
0–5

Adjusts the amount of sharpness on a scanned image

Note: “Best for content” is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.

Flash Drive menu
Scan Settings
Menu item

Description

Format
PDF (.pdf)
Secure PDF
TIFF (.tif)
JPEG (.jpg)
XPS (.xps)

Specifies the format of the file

PDF Version
1.2–1.6

Sets the version of the PDF file that will be scanned to USB

Content
Text/Photo
Photograph
Text

Specifies the type of content that will be scanned to USB

Note: 1.5 is the factory default setting.

Notes:

• Text/Photo is the factory default setting. Text/Photo is used when the
documents are mostly text or line art.

• Photograph is used when the document is a high-quality photograph or inkjet
print

• Text is used when the document is mostly text.
Color
Gray
Color

Specifies whether job prints in grayscale or color
Note: Gray is the factory default setting.
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Menu item

Description

Resolution
75
150
200
300
400
600

Specifies how many dots per inch are scanned

Darkness
1–9

Lightens or darkens the output

Orientation
Portrait
Landscape

Specifies the orientation of the scanned image

Original Size
Letter
Legal
Executive
Folio
Statement
Universal
4 x 6 in.
3 x 5 in.
Business Card
Custom Scan Size <x>
A4
A5
Oficio (Mexico)
A6
JIS B5
Book Original
Auto Size Sense
Mixed Letter/Legal

Specifies the paper size of the document that is being scanned

Sides (Duplex)
Off
Long edge
Short edge

Specifies how the text and graphics are oriented on the page

Note: 150 dpi is the factory default setting.

Note: 5 is the factory default setting.
Note: Portrait is the factory default setting.

Note: Letter is the US factory default setting. A4 is the international factory default
setting.

Notes:

• Off is the factory default setting.
• Long edge assumes binding along the long edge of the page (left edge for
portrait orientation and top edge for landscape orientation).

• Short edge assumes binding along the short edge of the page (top edge for
portrait orientation and left edge for landscape orientation).
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Menu item

Description

Photo JPEG Quality
5–90

Sets the quality of a JPEG photo image in relation to file size and the quality of the
image
Notes:

•
•
•
•
JPEG Quality
Best for content
5–90

5 reduces the file size, but the quality of the image is lessened.
90 provides the best image quality, but the file size is very large.
This menu item applies to all scan functions.

Sets the quality of a JPEG text or text/photo image in relation to file size and the
quality of the image.
Notes:

•
•
•
•
Use Multi‑Page TIFF
On
Off

50 is the factory default setting.

“Best for content” is the factory default setting.
5 reduces the file size, but the quality of the image is lessened.
90 provides the best image quality, but the file size is very large.
This menu item applies to Text, Text/Photo, and all scan functions.

Provides a choice between single-page TIFF files and multiple‑page TIFF files. For a
multiple-page scan to USB job, either one TIFF file is created containing all the pages,
or multiple TIFF files are created with one file for each page of the job.
Notes:

• On is the factory default setting.
• This menu item applies to all scan functions.
Scan bit Depth
8 bit
1 bit

Enables the Text/Photo mode to have smaller file sizes by using 1‑bit images when
Color is set to Off

Base File Name

Lets you enter a base file name

Custom Job scanning
Off
On

Lets you copy a document that contains mixed paper sizes into a single job

Scan Preview
On
Off

Specifies whether a preview will appear on the display for scan jobs

Background Removal
‑4 to +4

Adjusts the amount of background visible on a copy

Auto Center
On
Off

Lets you automatically center the copy on the page

Note: 8 bit is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.
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Menu item

Description

Color Dropout
Color Dropout
None
Red
Green
Blue
Default Red Threshold
0–255
Default Green Threshold
0–255
Default Blue Threshold
0–255

Specifies which color to drop during scanning, and how much to increase or decrease
the dropout

Contrast
0–5
Best for content

Specifies the contrast of the output

Mirror Image
On
Off

Creates a mirror image of the original document

Negative Image
On
Off

Creates a negative image of the original document

Shadow Detail
0–4

Adjusts the amount of shadow detail visible on a scanned image

Scan edge to edge
On
Off

Specifies whether the original document is scanned edge-to-edge

Sharpness
0–5

Adjusts the amount of sharpness on a scanned image

Notes:

• None is the factory default setting for Color Dropout.
• 128 is the factory default setting for each color threshold.

Note: “Best for content” is the factory default setting.

Note: Off is the factory default setting.

Note: Off is the factory default setting.

Note: 0 is the factory default setting.
Note: Off is the factory default setting.

Note: 3 is the factory default setting.

Print Settings
Menu item

Description

Copies

Specifies the number of copies to print

Paper Source
Tray <x>
MP Feeder
Manual Paper
Manual Envelope

Specifies the paper source selected to supply paper for the printer to print from the
flash drive

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies
Notes:

• Off is the factory default setting. No pages will be collated.
• The On setting stacks the print job sequentially.
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Menu item

Description

Sides (Duplex)
On
Off

Enables duplex printing (two-sided printing)

Staple
On
Off

Enables stapling

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of the
page is oriented in relation to the printing on the front of the page

Note: Off is the factory default setting.

Notes:

• Long Edge is the factory default setting.
• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.
Orientation
Auto
Portrait
Landscape

Specifies the orientation of the print job

N‑up (pages/side)
Off
2 Up
3 Up
4 Up
6 Up
9 Up
12 Up
16 Up

Specifies that multiple‑page images be printed on one side of a sheet of paper.

N‑up Border
None
Solid

Prints a border around each page image when using N‑up

Note: Auto is the factory default setting.

This is also referred to as Paper Saver.
Notes:

• Off is the factory default setting.
• The number selected is the number of page images that will print per side.

Note: None is the factory default setting.

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Places a sheet of paper between pages, copies, or jobs based on the value selected

Notes:

• Horizontal is the factory default setting.
• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.
Note: None is the factory default setting.
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Menu item

Description

Separator Source
Tray <x>
Manual Feeder
Envelope Feeder

Specifies a paper source

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job
Note: Do Not Print is the factory default setting.

Print Settings
Setup menu
Menu item

Description

Printer Language
PCL Emulation
PS Emulation

Sets the default printer language
Notes:

• PCL emulation uses a PCL interpreter for processing print
jobs. PostScript emulation uses a PS interpreter for
processing print jobs.

• PCL is the factory default printer language.
• Setting a printer language as the default does not prevent a
software program from sending print jobs that use another
printer language.
Job Waiting
On
Off

Specifies that print jobs be removed from the print queue if they
require unavailable printer options or custom settings. They are
stored in a separate print queue, so other jobs print normally. When
the missing information and/or options are obtained, the stored
jobs print.
Notes:

• Off is the factory default setting.
• This menu appears only if a non-Read Only printer hard disk
is installed. This requirement ensures that stored jobs are
not deleted if the printer loses power.
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Menu item

Description

Print Area
Normal
Whole Page

Sets the logical and physical printable area
Notes:

• This menu does not appear if Edge to Edge is enabled in the
printer Setup menu.

• Normal is the factory default setting. When attempting to
print data in the non‑printable area defined by the Normal
setting, the printer clips the image at the boundary.

• The Whole Page setting allows the image to be moved into
the non‑printable area defined by the Normal setting, but
the printer will clip the image at the Normal setting
boundary.

• The Whole Page setting only affects pages printed using a
PCL 5e interpreter. This setting has no effect on pages
printed using the PCL XL or PostScript interpreter.
Download Target
RAM
Flash
Disk

Sets the storage location for downloads
Notes:

• RAM is the factory default setting.
• Storing downloads in flash memory or on a printer hard disk
places them in permanent storage. Downloads remain in
flash memory or on the printer hard disk even when the
printer is turned off.

• Storing downloads in RAM is temporary.
• This menu appears only if a flash and/or disk option is
installed.
Job Accounting
On
Off

Specifies whether the printer stores statistical information about
the most recent print jobs on the hard disk
Notes:

• Off is the factory default setting. Off means the printer does
not store job statistics.

• The statistics include a record of print errors, the print time,
the job size in bytes, the requested paper size and type, the
total number of printed pages, and the total number of
copies requested.

• Job Accounting is available only when a printer hard disk is
installed and working properly. It should not be Read/Write
or Write protected. Job Buffer Size should not be set to
100%.

• Changing this setting from the printer control panel and then
exiting the menus causes the printer to reset. The menu
selection is updated.
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Menu item

Description

Resource Save
On
Off

Specifies how the printer handles temporary downloads, such as
fonts and macros stored in RAM, when the printer receives a job
that requires more memory than is available
Notes:

• Off is the factory default setting. Off sets the printer to retain
the downloads only until memory is needed. Downloads are
deleted in order to process print jobs.

• The On setting retains the downloads during language
changes and printer resets. If the printer runs out of
memory, 38 Memory Full appears, and downloads are
not deleted.
Print All Order
Alphabetically
Newest First
Oldest First

Specifies the order in which held and confidential jobs are printed
when Print All is selected
Notes:

• Alphabetically is the factory default setting.
• Print jobs always appear in alphabetical order on the printer
control panel.

Finishing menu
Menu item

Description

Sides (Duplex)
2 sided
1 sided

Specifies whether duplex (2‑sided) printing is set as the default for all print jobs
Notes:

• 1 sided is the factory default setting.
• To set 2‑sided printing from the software program: for Windows users, click
File > Print, and then click Properties, Preferences, Options, or Setup; for
Macintosh users, choose File > Print, and then adjust the settings from the
Print dialog and pop‑up menus.

Duplex Binding
Long Edge
Short Edge

Defines the way duplexed pages are bound and how the printing on the back of the
page is oriented in relation to the printing on the front of the page
Notes:

• Long Edge is the factory default setting.
• Long Edge specifies that binding be placed on the left edge of portrait pages
and the top edge of landscape pages.

• Short Edge specifies that binding be placed on the top edge of portrait pages
and the left edge of landscape pages.
Copies
1–999

Specifies a default number of copies for each print job

Blank Pages
Do Not Print
Print

Specifies whether blank pages are inserted in a print job

Note: 1 is the factory default setting.
Note: Do Not Print is the factory default setting.
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Menu item

Description

Collate
Off (1,1,1,2,2,2)
On (1,2,1,2,1,2)

Stacks the pages of a print job in sequence when printing multiple copies
Notes:

• Off is the factory default setting. No pages will be collated.
• The On setting stacks the print job sequentially.
• Both settings print the entire job the number of times specified by the Copies
menu setting.

Separator Sheets
None
Between Copies
Between Jobs
Between Pages

Specifies whether blank separator sheets are inserted
Notes:

• None is the factory default setting.
• Between Copies inserts a blank sheet between each copy of a print job if
Collation is set to On. If Collation is set to Off, a blank page is inserted between
each set of printed pages, such as after all page 1's and after all page 2's.

• Between Jobs inserts a blank sheet between print jobs.
• Between Pages inserts a blank sheet between each page of the print job. This
setting is useful when printing transparencies or inserting blank pages in a
document for notes.
Separator Source
Tray <x>
Multi‑Purpose Feeder
Envelope Feeder

Specifies the paper source for separator sheets
Notes:

• Tray 1 (standard tray) is the factory default setting.
• From the Paper menu, Configure MP must be set to Cassette in order for
Multi‑Purpose Feeder to appear as a menu setting.

N‑up (pages‑side)
Off
2‑Up
3‑Up
4‑Up
6‑Up
9‑Up
12‑Up
16‑Up

Specifies that multiple‑page images be printed on one side of a sheet of paper

N‑up Ordering
Horizontal
Reverse Horizontal
Reverse Vertical
Vertical

Specifies the positioning of multiple‑page images when using N‑up (pages‑sides)

Orientation
Auto
Landscape
Portrait

Specifies the orientation of a multiple‑page sheet

Notes:

• Off is the factory default setting.
• The number selected is the number of page images that will print per side.

Notes:

• Horizontal is the factory default setting.
• Positioning depends on the number of images and whether the images are in
portrait or landscape orientation.
Note: Auto is the factory default setting. The printer chooses between portrait and
landscape.
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Menu item

Description

N‑up Border
None
Solid

Prints a border around each page image when using N‑up (pages‑sides)

Staple Job
Off
On

Specifies whether print jobs are stapled

Offset Pages
Off
Between Jobs
Between Copies

Stacks copies or print jobs into staggered sets in an output bin

Note: None is the factory default setting.

Notes:

• This menu item is available only when the StapleSmart Finisher is installed.
• Off is the factory default setting. Print jobs are not stapled.
• Envelopes are not stapled.
Notes:

•
•
•
•

This menu item appears only when the StapleSmart Finisher is installed.
Off is the factory default setting. No pages are offset during the print job.
Between Jobs offsets each print job.
Between Copies offsets each copy of a print job.

Quality menu
Menu item

Description

Print Resolution
300 dpi
600 dpi
1200 dpi
1200 Image Q
2400 Image Q

Specifies the printed output resolution

Pixel Boost
Off
Fonts
Horizontally
Vertically
Both Directions

Enhances the printed quality of small fonts and graphics

Toner Darkness
1–10

Note: 600 dpi is the factory default setting. The printer driver default is 1200 IQ.

Notes:

•
•
•
•
•

Off is the factory default setting.
Fonts applies this setting only to text.
Horizontally darkens horizontal lines of text and images.
Vertically darkens vertical lines of text and images.
Both Directions darkens horizontal and vertical lines on text and images.

Lightens or darkens the printed output
Notes:

• 8 is the factory default setting.
• Selecting a smaller number can help conserve toner.
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Menu item

Description

Enhance Fine Lines
On
Off

Enables a print mode preferable for files such as architectural drawings, maps, electrical
circuit diagrams, and flow charts
Notes:

• Off is the factory default setting.
• To set Enhance Fine Lines using the Embedded Web Server, type the network
printer IP address in a browser window.
Gray Correction
Auto
Off

Adjusts the gray value of printed output

Brightness
‑6 to +6

Adjusts or darkens printed output and conserves toner

Note: Auto is the factory default setting.

Notes:

• 0 is the factory default setting.
• A negative value will darken text, images, and graphics. A positive value will
lighten them and conserve toner.
Contrast
0–5

Adjusts the degree of difference between levels of gray in printed output
Notes:

• 0 is the factory default setting.
• Higher settings show more difference between levels of gray.

Utilities menu
Menu item

Description

Remove Held Jobs
Confidential
Held
Not Restored
All

Removes confidential and held jobs from the printer hard disk
Notes:

• Selecting a setting affects only print jobs that are resident in the printer.
Bookmarks, jobs on flash drives, and other types of held jobs are not affected.

• Selecting Not Restored removes all Print and Hold jobs that were not restored
from the disk.

Format Flash
Yes
No

Formats the flash memory. Flash memory refers to the memory added by installing
a flash memory option card in the printer.
Warning—Potential Damage: Do not turn off the printer while the flash memory is
formatting.
Notes:

• A flash memory option card must be installed in the printer and operating
properly for this menu item to be available. The flash memory option card
must not be Read/Write or Write protected.

• Selecting Yes deletes all data stored in flash memory.
• No cancels the format request.

Understanding printer menus

190

Menu item

Description

Delete Downloads on Disk
Delete Now
Do Not Delete

Removes downloads from the printer hard disk, including all held Jobs, buffered jobs,
and parked jobs. Job accounting information is not affected.

Job Acct Stat
Print
Clear

Prints a list of all stored job statistics or deletes the information from the printer hard
disk

Note: Delete Now is the default setting.

Notes:

• A printer hard disk must be installed in the printer and operating properly for
this menu item to be available.

• Selecting Print prints a list of statistics.
• Clear deletes all job statistics stored on the printer hard disk.
• The Clear selection will not appear if Job Accounting is set to MarkTrackTM
using NPA.
Hex Trace
Activate

Assists in isolating the source of a print job problem
Notes:

• When Activate is selected, all data sent to the printer is printed in hexadecimal
and character representation and control codes are not executed.

• To exit or deactivate Hex Trace, turn the printer off or reset the printer.
Coverage Estimator
Off
On

Provides an estimate of the percentage coverage of black on a page. The estimate is
printed on a separate page at the end of each print job.

LCD Contrast
1–10

Adjusts the contrast lighting of the display

Note: Off is the factory default setting.

Notes:

• 5 is the factory default setting.
• A higher setting makes the display appear lighter.
• A lower setting makes the display appear darker.
LCD Brightness
1–10

Adjusts the brightness of the backlight on the display
Notes:

• 5 is the factory default setting.
• A higher setting makes the display appear lighter.
• A lower setting makes the display appear darker.

PDF menu
Menu item

Description

Scale to Fit
Yes
No

Scales page content to fit the selected paper size
Note: No is the factory default setting.
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Menu item

Description

Annotations
Do Not Print
Print

Prints annotations in a PDF
Note: Do Not Print is the factory default setting.

PostScript menu
Menu item

Description

Print PS Error
On
Off

Prints a page containing the PostScript error

Font Priority
Resident
Flash/Disk

Establishes the font search order

Note: Off is the factory default setting.

Notes:

• Resident is the factory default setting.
• A formatted flash memory option card or printer hard disk must be
installed in the printer and operating properly for this menu item to be
available.

• The flash memory option or printer hard disk cannot be Read/Write,
Write, or password protected.

• Job Buffer Size must not be set to 100%.

PCL Emul menu
Menu item

Description

Font Source
Resident
Disk
Download
Flash
All

Specifies the set of fonts used by the Font Name menu item
Notes:

• Resident is the factory default setting. It shows the factory default set of
fonts downloaded into printer RAM.

• Flash and Disk settings appear only if applicable and show all fonts
resident in that option.

• Flash and Disk options must be properly formatted and cannot be
Read/Write, Write, or password protected.

• Download appears only if applicable and shows all the fonts downloaded
into printer RAM.

• All shows all fonts available to any option.
Font Name
<list of available fonts>

Identifies a specific font and the option where it is stored
Notes:

• Courier 10 is the factory default setting.
• The font source abbreviation is R for Resident, F for Flash, K for Disk, and
D for download.
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Menu item

Description

Symbol Set
10U PC‑8
12U PC‑850

Specifies the symbol set for each font name
Notes:

• 10U PC‑8 is the US factory default setting.
• 12U PC‑850 is the international factory default setting.
• A symbol set is a set of alphabetic and numeric characters, punctuation,
and special symbols. Symbol sets support the different languages or
specific programs such as math symbols for scientific text. Only the
supported symbol sets are shown.

PCL Emulation Settings
Pitch
0.08–100

Specifies the font pitch for scalable monospaced fonts
Notes:

•
•
•
•

10 is the factory default setting.
Pitch refers to the number of fixed‑space characters per inch (cpi).
Pitch can be increased or decreased in 0.01‑cpi increments.
For nonscalable monospaced fonts, the pitch appears on the display but
cannot be changed.

PCL Emulation Settings
Orientation
Portrait
Landscape

Specifies the orientation of text and graphics on the page

PCL Emulation Settings
Lines per Page
1–255

Specifies the number of lines that print on each page

Notes:

• Portrait is the factory default setting.
• Portrait prints text and graphics parallel to the short edge of the page.
• Landscape prints text and graphics parallel to the long edge of the page.
Notes:

• 60 is the US factory default setting. 64 is the international default setting.
• The printer sets the amount of space between each line based on the
Lines per Page, Paper Size, and Orientation settings. Select the desired
Paper Size and Orientation before setting Lines per Page.

PCL Emulation Settings
A4 Width
198 mm
203 mm

Sets the printer to print on A4‑size paper
Notes:

• 198 mm is the factory default setting.
• The 203‑mm setting sets the width of the page to allow the printing of
eighty 10‑pitch characters.

PCL Emulation Settings
Auto CR after LF
On
Off

Specifies whether the printer automatically performs a carriage return after a
line feed control command

PCL Emulation Settings
Auto LF after CR
On
Off

Specifies whether the printer automatically performs a line feed after a carriage
return control command

Note: Off is the factory default setting.

Note: Off is the factory default setting.
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Menu item

Description

Tray Renumber
Assign MP Feeder
Off
None
0–199
Assign Tray <x>
Off
None
0–199
Assign Manual Paper
Off
None
0–199
Assign Man Env
Off
None
0–199

Configures the printer to work with printer software or programs that use
different source assignments for trays, drawers, and feeders

Tray Renumber
View Factory Def
MPF Default = 8
T1 Default = 1
T2 Default = 4
T3 Default = 5
T4 Default = 20
T5 Default = 21
Env Default = 6
MPaper Default = 2
MEnv Default = 3

Lets you view the factory default setting assigned to each tray, drawer, or feeder,
even if it has not been installed

Tray Renumber
Restore Defaults
Yes
No

Returns all tray, drawer, and feeder assignments to the factory default settings

Notes:

• Off is the factory default setting.
• None is not an available selection. It appears only when it is selected by
the PCL 5 interpreter.

• None ignores the Select Paper Feed command.
• 0–199 allows a custom setting to be assigned.
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HTML menu
Menu item
Font Name
Albertus MT
Antique Olive
Apple Chancery
Arial MT
Avant Garde
Bodoni
Bookman
Chicago
Clarendon
Cooper Black
Copperplate
Coronet
Courier
Eurostile
Garamond
Geneva
Gill Sans
Goudy
Helvetica
Hoefler Text

Description
Intl CG Times
Sets the default font for HTML documents
Intl Courier
Notes:
Intl Univers
• The Times font will be used in HTML documents that do not specify a
Joanna MT
font.
Letter Gothic
• The following fonts appear only if the appropriate DBCS font card is
Lubalin Gothic
installed: HG-GothicB, MSung-Light, MD_DotumChe, and MingMTMarigold
Light.
MonaLisa Recut
Monaco
New CenturySbk
New York
Optima
Oxford
Palatino
StempelGaramond
Taffy
Times
TimesNewRoman
Univers
Zapf Chancery

Menu item

Description

Font Size
1–255 pt

Sets the default font size for HTML documents
Notes:

• 12 pt is the factory default setting.
• Font size can be increased in 1‑point increments.
Scale
1–400%

Scales the default font for HTML documents
Notes:

• 100% is the factory default setting.
• Scaling can be increased in 1% increments.
Orientation
Portrait
Landscape

Sets the page orientation for HTML documents

Margin Size
8–255 mm

Sets the page margin for HTML documents

Note: Portrait is the factory default setting.

Notes:

• 19 mm is the factory default setting.
• Margin size can be increased in 1‑mm increments.
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Menu item

Description

Backgrounds
Do Not Print
Print

Specifies whether to print backgrounds on HTML documents
Note: Print is the factory default setting.

Image menu
Menu item

Description

Auto Fit
On
Off

Selects the optimal paper size, scaling, and orientation

Invert
On
Off

Inverts bi‑tonal monochrome images

Scaling
Anchor Top Left
Best Fit
Anchor Center
Fit Height/Width
Fit Height
Fit Width

Scales the image to fit the selected paper size

Orientation
Portrait
Landscape
Rev Portrait
Rev Landscape

Sets the image orientation

Notes:

• On is the factory default setting.
• The On setting overrides scaling and orientation settings for some images.
Notes:

• Off is the factory default setting.
• The font size can be increased in 1‑point increments.
• This setting does not apply to GIF or JPEG images.
Notes:

• Best Fit is the factory default setting.
• When Auto Fit is set to On, Scaling is automatically set to Best Fit.

Note: Portrait is the factory default setting.

XPS menu
Menu item

Description

Print Error Pages
Off
On

Prints a page containing information on errors, including XML markup errors
Note: Off is the factory default setting.

Booklet Adjustments menu
The Booklet Adjustments menu is available if a booklet finisher is installed. You can select various adjustments from
this menu when printing booklets.
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To access the Booklet Adjustments menu:

1 Turn the printer off.
2 Hold down

and

6 MNO

while turning the printer on.

3 Release the buttons when the screen with the progress bar appears.
The printer performs a power-on sequence, and then the Configuration Menu appears.

4 Touch the down arrow until Booklet Adjustments appears.
5 Touch Booklet Adjustments.
Menu item

Description

Size of paper
A4
A5
Letter
Legal
Executive
Oficio
Folio
Statement
Universal
A3
Tabloid
JIS B4

Specifies the paper size

Total number of sheets
1‑2 sheets
3 sheets
4 sheets
5-7 sheets
8-15 sheets

Specifies the total number of sheets in a booklet

Adjust for folding overlap
Top overlap
Bottom overlap

Select top or bottom overlap based on printed output

Adjust for skew during booklet making
Clockwise skew
Counter‑clockwise skew

Select skew direction based on printed output

Note: This setting defaults to the Tray 1 Size value.

Note: The factory default setting is 1‑2 sheets.

Help menu
The Help menu consists of Help pages that are stored in the printer as PDFs. They contain reference information about
using the printer and performing tasks. You may select to print each one individually, or select Print all
guides to print all of them at one time.
English, French, German, and Spanish translations are stored in the printer. Other translations are available on the
Software and Documentation CD.
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Menu item

Description

Print all guides

Prints all the guides

Copy guide

Provides information about making copies and changing settings

E‑mail guide

Provides information about sending e‑mails using addresses, shortcut numbers,
or the address book, and changing settings

Fax guide

Provides information about sending faxes using fax numbers, shortcut numbers,
or the address book, and changing settings

FTP guide

Provides information about scanning documents directly to an FTP server using an
FTP address, shortcut numbers, or the address book, and changing settings

Information guide

Provides help in locating additional information

Print defects guide

Provides help in resolving repeating defects in copies or prints

Supplies guide

Provides part numbers for ordering supplies

Maintaining the printer
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Maintaining the printer
Cleaning the exterior of the printer
1 Make sure that the printer is turned off and unplugged from the wall outlet.
CAUTION—SHOCK HAZARD: To avoid the risk of electric shock when cleaning the exterior of the printer,
unplug the power cord from the wall outlet and disconnect all cables to the printer before proceeding.

2 Remove paper from the standard exit bin.
3 Dampen a clean, lint‑free cloth with water.
Warning—Potential Damage: Do not use household cleaners or detergents, as they may damage the finish of
the printer.

4 Wipe only the outside of the printer, making sure to include the standard exit bin.
Warning—Potential Damage: Using a damp cloth to clean the interior may cause damage to your printer.

5 Make sure the standard exit bin is dry before beginning a new print job.
Note: A cleaning kit consisting of wipes for the touch screen and scanner glass is available:
Part name

Part number

Cleaning kit (wet and dry wipes)

40X0392
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Cleaning the scanner glass
Clean the scanner glass if you encounter print quality problems, such as streaks on copied or scanned images.

1 Slightly dampen a soft, lint-free cloth or paper towel with water.
2 Open the scanner cover.
1

2

4
3

1

White underside of the ADF cover

2

White underside of the scanner cover

3

Scanner glass

4

ADF glass

3 Wipe the areas shown and let them dry.
4 Close the scanner cover.

Adjusting scanner registration
Scanner Registration is a process to align the scan area with the paper location. To manually adjust the scanner
registration:

1 Turn the printer off.
2 Clean the scanner glass and backing material.
3 Hold down

and

6 MNO

until the progress bar appears.

4 Release the buttons.
The printer performs a power‑on sequence, and then the Diagnostic menu appears.

5 Touch the up or down arrow until Scanner Test appears.
6 Touch Scanner Test.
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7 Touch the up or down arrow until Scanner Manual Registration appears.
8 Touch Scanner Manual Registration.
9 Touch the left and right arrows to change the settings.
10 Touch Submit.

Storing supplies
Choose a cool, clean storage area for the printer supplies. Store supplies right side up in their original packing until you
are ready to use them.
Do not expose supplies to:

•
•
•
•
•
•

Direct sunlight
Temperatures above 35°C (95°F)
High humidity above 80%
Salty air
Corrosive gases
Heavy dust

Conserving supplies
There are some settings you can change from the printer control panel that will help you conserve toner and paper.
If you need to print several copies, you can conserve supplies by printing the first copy and checking it for accuracy
before printing the remaining copies.

Checking the status of supplies
A message appears on the display when a replacement supply item is needed or when maintenance is required.

Checking the status of supplies from the printer control panel
1 Make sure the printer is on and Ready appears.
2 On the home screen, touch Status/Supplies.
Note: If Status/Supplies is not on the home screen, then print a menu settings page to review the status of the
supplies.

Checking the status of supplies from a network computer
Note: The computer must be connected to the same network as the printer.
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1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, print a network setup page and locate the IP address in
the TCP/IP section.

2 Click Device Status. The Device Status page appears, displaying a summary of supply levels.

Ordering supplies
To order parts and supplies in the U.S., contact Lexmark at 1-800-539-6275 for information about Lexmark authorized
supplies dealers in your area. In other countries or regions, visit the Lexmark Web site at www.lexmark.com or contact
the place where you purchased the printer.
Note: All life estimates for printer supplies assume printing on letter‑ or A4‑size plain paper.

Ordering toner cartridges
Recommended toner cartridge and part number
Part name

Part number

For printer(s)

High Yield Toner Cartridge

X860H21G

X860, X862, X864

Ordering a photoconductor kit
When Replace Photoconductor message appears, order a new photoconductor kit.
Part name

Part number

For printer(s)

Photoconductor Kit

X860H22G

X860, X862, X864

Ordering a maintenance kit
When 80 Routine maintenance needed appears, order a maintenance kit. The maintenance kit contains all
the items necessary to replace the pick rollers, the charge roll, the transfer roller, and the fuser.
Note: Using certain types of paper may require more frequent replacement of the maintenance kit. The pick rollers,
charge roll, transfer roller, and fuser can also be individually ordered and replaced as necessary.
Part name

Part number

For printer(s)

Maintenance kit (low
voltage)

40X2375

X860, X862, X864

Maintenance kit (high
voltage)

40X2376

X860, X862, X864

Maintenance kit (100 volt)

40X2377

X860, X862, X864

Maintenance kit (for the
ADF)

40X2734.

X860, X862, X864
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Ordering staple cartridges
When Staples Low or Staples Empty appears, order the specified staple cartridge.
For more information, see the illustrations inside the stapler door.
Part name

Part number

Staple Cartridges–3 pack

25A0013

Ordering a cleaning kit
Use the wet and dry wipes from the cleaning kit to clean the scanner glass and touch screen.
Part name

Part number

Cleaning kit (wet and dry wipes)

40X0392

Replacing supplies
Replacing the toner cartridge
When 88 Cartridge low, 88.yy Replace cartridge, or 88 Replace cartridge to continue
appears, or when print becomes faded:

1 Turn the printer off.
2 Open the front door.

Maintaining the printer

3 Grasp the handle and pull out the cartridge.

4 Unpack a new cartridge.

Warning—Potential Damage: When replacing a toner cartridge, do not leave the new cartridge exposed to
direct light for an extended period of time. Extended light exposure can cause print quality problems.

5 Firmly shake the cartridge side-to-side several times to redistribute the toner.
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6 Insert the new cartridge into the printer. Push the toner cartridge in as far as it will go. The cartridge clicks into
place when correctly installed.

7 Close the front door.

Replacing the photoconductor
You can determine approximately how full the photoconductor is by printing the printer settings configuration sheet.
This helps you decide when you might need to order replacement supplies.
To ensure print quality and to avoid damage to the printer, the printer stops operating after the photoconductor has
reached a maximum of 60,000 pages. The printer automatically notifies you before the photoconductor reaches this
point.
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When 84 Replace photoconductor or 84 Photoconductor low appears, order a new photoconductor
immediately. While the printer may continue to function properly after the photoconductor has reached its official
end‑of‑life, print quality significantly decreases.

To replace the photoconductor:

1 Turn the printer off.
2 Open the front door.

Note: The photoconductor cannot be pulled out if Side Door A is closed.

Maintaining the printer

3 Lower Side Door A.

4 Pull the photoconductor out of the printer.

Place the photoconductor on a flat, clean surface.

5 Unpack the new photoconductor.
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6 Align and insert the end of the photoconductor.

7 Remove the tape from the top of the photoconductor.
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8 Push the photoconductor as far as it will go.

The photoconductor clicks into place when correctly installed.

9 Close Side Door A.

208

Maintaining the printer

209

10 Close the front door.

Note: After you insert the photoconductor and close all the doors, the printer performs a motor cycle and clears the
Replace Photoconductor warnings.
The printer returns to the Ready state.

Moving the printer
Before moving the printer
CAUTION—POTENTIAL INJURY: The printer weighs more than 55 kg (121 lb), and requires at least four persons
or a properly rated mechanical handling system to lift it safely.
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Follow these guidelines to avoid personal injury or printer damage:

•
•
•
•

Use at least four people or a properly rated mechanical handling system to lift the printer.
Turn off the printer using the power switch, and then unplug the power cord from the wall outlet.
Disconnect all cords and cables from the printer before moving it.
Remove all printer options before moving the printer.

Warning—Potential Damage: Damage to the printer caused by improper moving is not covered by the printer
warranty.

Removing the optional trays
1 Remove the printer tray.
2 Remove the two thumbscrews and save them.
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3 Place the tray into the printer.

4 Remove the cable cover.
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5 Disconnect the optional drawer connector.

6 Attach the cable cover.

7 Lift the printer off the trays.
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Moving the printer to another location
The printer and options can be safely moved to another location by following these precautions:

• Any cart used to move the printer must have a surface able to support the full footprint of the printer. Any cart
used to move the options must have a surface able to support the dimensions of the options.

• Keep the printer in an upright position.
• Avoid severe jarring movements.

Shipping the printer
When shipping the printer, use the original packaging or call the place of purchase for a relocation kit.
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Administrative support
Finding advanced networking and administrator information
This chapter covers basic administrative support tasks. For more advanced system support tasks, see the Networking
Guide on the Software and Documentation CD and the Embedded Web Server Administrator's Guide on the Lexmark
Web site at www.lexmark.com.

Using the Embedded Web Server
If the printer is installed on a network, the Embedded Web Server is available for a range of functions including:

•
•
•
•
•

Viewing a virtual display of the printer control panel
Checking the status of the printer supplies
Configuring printer settings
Configuring network settings
Viewing reports

To access the Embedded Web Server, type the printer IP address into the address field of your Web browser.
Notes:

• If you do not know the IP address of the printer, then print a network setup page and locate the IP address in
the TCP/IP section.

• For more information, see the Networking Guide on the Software and Documentation CD and the Embedded
Web Server Administrator's Guide on the Lexmark Web site at www.lexmark.com.

Checking the virtual display
When the Embedded Web Server is open, a virtual display appears in the top left corner of the screen. It works as an
actual display would work on a printer control panel, showing printer messages.
To access the Embedded Web Server, type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP address in
the TCP/IP section.
The virtual display appears in the top left corner of the screen.
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Checking the device status
Using the Embedded Web Server, you can view paper tray settings, the level of toner in the print cartridge, the
percentage of life remaining in the maintenance kit, and capacity measurements of certain printer parts. To view the
device status:

1 Type the printer IP address in the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Device Status.

Setting up e‑mail alerts
You can have the printer send you an e‑mail when the supplies are getting low or when the paper needs to be changed,
added, or unjammed.
To set up e‑mail alerts:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Under Other Settings, click E‑mail Alert Setup.
4 Select the items for notification, and type in the e‑mail addresses.
5 Click Submit.
Note: See your system support person to set up the e‑mail server.

Viewing reports
You can view some reports from the Embedded Web Server. These reports are useful for assessing the status of the
printer, the network, and supplies.
To view reports from a network printer:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Reports, and then click the type of report you want to view.

Adjusting the brightness of the display
If you are having trouble reading your display, the LCD brightness can be adjusted through the Settings menu.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.
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3 Touch Settings.
4 Touch General Settings.
5 Touch the down arrow until Screen Brightness appears.
6 Touch the arrows to increase or decrease the brightness.
Brightness settings can be adjusted from 20–100 (100 is the factory default setting).

7 Touch Submit.
8 Touch

.

Restoring the factory default settings
If you want to retain a list of the current menu settings for reference, then print a menu settings page before you restore
the factory default settings. For more information, see “Printing a menu settings page” on page 37.
Warning—Potential Damage: Restoring factory defaults returns most printer settings to the original factory default
setting. Exceptions include the display language, custom sizes and messages, and Network/Port menu settings. All
downloads stored in RAM are deleted. Downloads stored in flash memory or on a printer hard disk are not affected.

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Settings.
4 Touch General Settings.
5 Touch the down arrow until Factory Defaults appears.
6 Touch the left or right arrow until Restore Now appears.
7 Touch Submit.
8 Touch

.
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Troubleshooting
Solving basic problems
Solving basic printer problems
If there are basic printer problems, or the printer is unresponsive, make sure:

•
•
•
•
•
•

The power cord is plugged into the printer and a properly grounded electrical outlet.
The electrical outlet is not turned off by any switch or breaker.
The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.
Other electronic equipment plugged into the outlet is working.
The printer is turned on. Check the printer power switch.
The printer cable is securely attached to the printer and the host computer, print server, option, or other network
device.

• All options are properly installed.
• The printer driver settings are correct.
Once you have checked each of these possibilities, turn the printer off, wait for about 10 seconds, and then turn the
printer back on. This often fixes the problem.

Printer control panel display is blank or displays only diamonds
The printer self test failed. Turn the printer off, wait about 10 seconds, and then turn the printer back on.
If the clock graphic and Ready do not appear, then turn the printer off and contact Customer Support.

Embedded Web Server does not open
These are possible solutions. Try one or more of the following:

CHECK THE NETWORK CONNECTIONS
Make sure the printer and computer are turned on and connected to the same network.

CHECK THE NETWORK SETTINGS
Depending on the network settings, you may need to type https:// instead of http:// before the printer IP
address to access the Embedded Web Server. For more information, see your system administrator.
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Understanding printer messages
An error has occured with the Flash Drive. Please remove and re-insert the drive.
Try one or more of the following:

• Remove and reinsert the flash drive.
• If the error message remains, the flash memory may be defective and require replacing.

Change <input src> to <Custom Type Name>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Change <input src> to <Custom Type Name> load <orientation>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Change <input src> to <Custom String>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.
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Change <input src> to <Custom String> load <orientation>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Change <input src> to <size>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Change <input src> to <size> load <orientation>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Change <input src> to <type> <size>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.
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Change <input src> to <type> <size> load <orientation>
You can change the current paper source for the remainder of the print job. The formatted page will print on the paper
loaded in the selected tray. This may cause clipping of text or images. Try one or more of the following:

• Select the paper tray with the correct paper size or type.
• Touch Use current [src] to ignore the message and print from the tray selected for the print job.
• Touch Continue to continue the job if the correct size and type are loaded in the tray, and this size and type are
specified in the printer control panel Paper menu.
Note: If you touch Continue when there is no paper in the tray, the job is not continued.

• Touch Cancel job to cancel the current job.

Check <input src> guides
The <input src> refers to the multipurpose feeder. The printer cannot determine the size of the paper.
Try one or more of the following:

• Readjust the paper guides.
• Check the tray configuration.

Check <input src> orientation or guides
The printer does not know the actual paper size that is loaded in a tray due to an incorrect paper orientation setting,
or because tray guides are not in the proper location.
Try one or more of the following:

• Move the guides in the tray to the correct positions for the paper size loaded.
• Make sure the paper size setting matches the paper loaded in the tray:
1 From the printer control panel Paper menu, check the Paper Size setting.
2 Before sending the job to print, specify the correct size setting:
– For Windows users, specify the size from Print Properties.
– For Macintosh users, specify the size from the Page Setup dialog.

Close door <x>
Close the specified door.

Close cover <x>
Close the specified cover to clear the message.

Close surface H
Close the specified cover to clear the message.
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Disk corrupted
The printer attempted a hard disk recovery on a corrupted hard disk, and the hard disk cannot be repaired. The hard
disk must be reformatted.
Touch Reformat disk to reformat the hard disk and clear the message.
Note: Reformatting the disk deletes all the files currently stored on the disk.

Empty the hole punch box
Empty the hole punch box, and then reinsert it into the finisher. Wait for the message to clear.

Weblink server not set up. Contact system administrator.
An error occurred on the Weblink server, or the server is not configured properly. Touch Continue to clear the message.
If the message appears again, contact your system support person.

Disk Full ‑ Scan Job Canceled
The scan job canceled or stopped due to insufficient printer hard disk space.
Touch Continue to clear the message.

Fax memory full
There is not enough memory to send the fax job.
Touch Continue to clear the message.

Fax server 'To Format' not set up. Contact system administrator.
The printer is in Fax Server mode, but the Fax Server setup has not been completed.
Try one or more of the following:

• Touch Continue to clear the message.
• Complete the Fax Server setup. If the message appears again, contact your system support person.

Fax Station Name not set up
The Fax Station Name has not been entered. Sending and receiving faxes is disabled until fax is configured properly.
Try one or more of the following:

• Touch Continue to clear the message.
• Complete the Analog Fax Setup. If the message appears again, contact your system support person.

Fax Station Number not set up
The Fax Station Number has not been entered. Sending and receiving faxes is disabled until fax is configured properly.
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Try one or more of the following:

• Touch Continue to clear the message.
• Complete the Analog Fax Setup. If the message appears again, contact your system support person.

Insert Tray <x>
Insert the specified tray into the printer.

Load <src> with <x>
<src> is a tray or feeder, and <x> is a paper type or size.
Try one or more of the following:

• Load the specified paper in the tray.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, it feeds from that tray. If the printer cannot find
a tray with the correct paper type and size, it prints from the default source.

• Cancel the current job.

Load <input src> with <Custom Type Name>
Try one or more of the following:

• Load the specified paper in the tray.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, it feeds from that tray. If the printer cannot find
a tray with the correct paper type and size, it prints from the default source.

• Cancel the current job.

Load <input src> with <Custom String>
Try one or more of the following:

• Load the specified paper in the tray.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, it feeds from that tray. If the printer cannot find
a tray with the correct paper type and size, it prints from the default source.

• Cancel the current job.

Load <input src> with <type> <size>
Try one or more of the following:

• Load the specified paper in the tray.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, it feeds from that tray. If the printer cannot find
a tray with the correct paper type and size, it prints from the default source.
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• Cancel the current job.

Load <input src> with <size>
Try one or more of the following:

• Load the specified paper in the tray.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, it feeds from that tray. If the printer cannot find
a tray with the correct paper type and size, it prints from the default source.

• Cancel the current job.

Load manual feeder with <x>
<x> is a paper type or size.
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.

Load Manual Feeder with <Custom Type Name>
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.

Load Manual Feeder with <Custom String>
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.
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Load Manual Feeder with <size>
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.

Load Manual Feeder with <type> <size>
Try one or more of the following:

• Load the specified paper in the multipurpose feeder.
• Touch Continue to clear the message and continue printing.
If the printer finds a tray that has the correct paper type and size, then it feeds from that tray. If the printer cannot
find a tray with the correct paper type and size, then it prints from the default source.

• Cancel the current job.

Load Staples [G5, G11, G12]
Try one or more of the following:

• Replace the specified staple cartridge in the finisher.
• Touch Continue to clear the message and continue printing.
• Touch Cancel job to cancel the print job.

Memory full, cannot print faxes
There is not enough memory to print the fax job.
Touch Continue to clear the message without printing. Held faxes will attempt to print after the printer has been
restarted.

Remove paper from <linked bin set name>
Remove the paper from the specified bin. The printer automatically senses paper removal and resumes printing.
If removing the paper does not clear the message, then touch Continue.

Remove paper from all bins
Remove the paper from all of the bins. The printer automatically senses paper removal and resumes printing.
If removing the paper does not clear the message, then touch Continue.

Remove paper from bin <x>
Remove the paper from the specified bin. The printer automatically senses paper removal and resumes printing.
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If removing the paper does not clear the message, then touch Continue.

Remove paper from standard output bin
Remove the stack of paper from the standard exit bin.

Replace all originals if restarting job.
One or more messages which interrupted a scan job are now cleared. Replace the original documents in the scanner
to restart the scan job.
Try one or more of the following:

• Touch Cancel Job if a scan job is processing when the message appears. This cancels the job and clears the message.
• Touch Scan from Automatic Document Feeder if the page jam recovery is active. Scanning resumes from the ADF
immediately after the last successfully scanned page.

• Touch Scan from flatbed if page jam recovery is active. Scanning resumes from the scanner glass immediately after
the last successfully scanned page.

• Touch Finish job without further scanning if page jam recovery is active. The job ends at the last successfully scanned
page, but the job is not canceled. Successfully scanned pages go to their destination: copy, fax, e-mail, or FTP.

• Touch Restart job if job recovery is active. The message clears. A new scan job containing the same parameters as
the previous job starts.

Replace last scanned page and jammed originals if restarting job.
One or more messages which interrupted a scan job are now cleared. Replace the original documents in the scanner
to restart the scan job.
Try one or more of the following:

• Touch Cancel Job if a scan job is processing when the message appears. This cancels the job and clears the message.
• Touch Scan from Automatic Document Feeder if the page jam recovery is active. Scanning resumes from the ADF
immediately after the last successfully scanned page.

• Touch Scan from flatbed if page jam recovery is active. Scanning resumes from the scanner glass immediately after
the last successfully scanned page.

• Touch Finish job without further scanning if page jam recovery is active. The job ends at the last successfully scanned
page, but the job is not canceled. Successfully scanned pages go to their destination: copy, fax, e-mail, or FTP.

• Touch Restart job if job recovery is active. The message clears. A new scan job containing the same parameters as
the previous job starts.

Restore Held Jobs?
Try one or more of the following:

• Touch Continue to restore all held jobs stored on the printer hard disk.
• Touch Do not restore if you do not want any print jobs to be restored.
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Replace jammed originals if restarting job.
One or more messages which interrupted a scan job are now cleared. Replace the original documents in the scanner
to restart the scan job.
Try one or more of the following:

• Touch Cancel Job if a scan job is processing when the message appears. This cancels the job and clears the message.
• Touch Scan from Automatic Document Feeder if the page jam recovery is active. Scanning resumes from the ADF
immediately after the last successfully scanned page.

• Touch Scan from flatbed if page jam recovery is active. Scanning resumes from the scanner glass immediately after
the last successfully scanned page.

• Touch Finish job without further scanning if page jam recovery is active. The job ends at the last successfully scanned
page, but the job is not canceled. Successfully scanned pages go to their destination: copy, fax, e-mail, or FTP.

• Touch Restart job if job recovery is active. The message clears. A new scan job containing the same parameters as
the previous job starts.

Scan Document Too Long
The scan job exceeds the maximum number of pages. Touch Cancel Job to clear the message.

Scanner ADF Cover Open
The ADF cover is open. The message clears when the cover is closed.

Scanner jam, remove all originals from the scanner
Clear all original documents from the scanner.

Scanner Jam Access Cover Open
Close the bottom ADF door to clear the message.

Serial <x>
The printer is using a serial cable connection. The serial port is the active communication link.

Some held jobs were not restored
Touch Continue to delete the specified job.
Note: Some held jobs are not restored. They stay on the hard disk and are inaccessible.

30 Invalid refill, change cartridge
Remove the print cartridge, and then install a supported one.
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31.yy Replace defective or missing cartridge
The toner cartridge is either missing or not functioning properly.
Try one or more of the following:

• Remove the toner cartridge, and then reinstall it.
• Remove the toner cartridge, and then install a new one.

32 Cartridge part number unsupported by device
Remove the print cartridge, and then install a supported one.

34 Short paper
Try one or more of the following:

•
•
•
•

Load the appropriate paper or other specialty media in the proper tray.
Touch Continue to clear the message and print the job using a different paper tray.
Check tray length and width guides and make sure the paper is properly loaded in the tray.
Check the Print Properties or Print dialog settings to make sure the print job is requesting the correct paper size
and type.

• Check that the paper size is correctly set. For example, if the MP Feeder Size is set to Universal, make sure the paper
is large enough for the data being printed.

• Cancel the current print job.

34 Incorrect media, check <input src> guides
Try one or more of the following:

• Load the appropriate paper or other specialty media in the tray.
• Press the up or down arrow button until

Continue appears, and then press

to clear the message and

print the job using a different tray.

35 Insufficient memory to support Resource Save feature
Try one or more of the following:

• Touch Continue to disable Resource Save and continue printing.
• To enable Resource Save after receiving this message, make sure the link buffers are set to Auto, and then exit the
menus to activate the link buffer changes. When Ready appears, enable Resource Save.

• Install additional memory.

37 Insufficient memory to collate job
Try one or more of the following:

• Touch Continue to print the portion of the job already stored and begin collating the rest of the print job.
• Cancel the current print job.
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37 Insufficient memory for Flash Memory Defragment operation
Try one or more of the following:

• Touch Continue to stop the defragment operation and continue printing.
• Delete fonts, macros, and other data in printer memory.
• Install additional printer memory.

37 Insufficient memory, some Held Jobs were deleted
The printer deleted some held jobs in order to process current jobs.
Touch Continue to clear the message.

37 Insufficient memory, some held jobs will not be restored
The printer was unable to restore some or all of the confidential or held jobs on the printer hard disk.
Press the up or down arrow button until

Continue appears, and then press

to clear the message.

38 Memory full
Try one or more of the following:

• Touch Continue to clear the message.
• Cancel the current print job.
• Install additional printer memory.

39 Complex page, some data may not have printed
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
• Cancel the current print job.
• Install additional printer memory.

50 PPDS font error
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
• The printer cannot find a requested font. From the PPDS menu, select Best Fit, and then select On. The printer will
find a similar font and reformat the affected text.

• Cancel the current print job.
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51 Defective flash detected
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
• Cancel the current print job.

52 Not enough free space in flash memory for resources
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
Downloaded fonts and macros not previously stored in flash memory are deleted.

• Delete fonts, macros, and other data stored in flash memory.
• Upgrade to a larger capacity flash memory card.

53 Unformatted flash detected
Try one or more of the following:

• Touch Continue to stop the defragment operation and continue printing.
• Format the flash memory. If the error message remains, the flash memory may be defective and require replacing.

54 Network <x> software error
<x> is the number of the network connection.
Try one or more of the following:

• Touch Continue to continue printing.
• Turn the printer off and then back on to reset the printer.
• Upgrade (flash) the network firmware in the printer or print server.

54 Serial option <x> error
<x> is the number of the serial option.
Try one or more of the following:

• Check that the serial cable is connected correctly and is the proper one for the serial port.
• Check that the serial interface parameters (protocol, baud, parity, and data bits) are set correctly on the printer
and host computer.

• Touch Continue to continue printing.
• Turn the printer power off and then back on to reset the printer.

54 Standard network software error
Try one or more of the following:

• Touch Continue to continue printing.
• Turn the printer off and then back on to reset the printer.
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• Upgrade (flash) the network firmware in the printer or print server.

55 Unsupported option in slot <x>
<x> is a slot on the printer system board.
Try one or more of the following:

1 Turn the printer power off.
2 Unplug the power cord from the wall outlet.
3 Remove the unsupported option card from the printer system board.
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer power back on.

56 Parallel port <x> disabled
<x> is the number of the parallel port.
Try one or more of the following:

• Touch Continue to clear the message.
The printer discards any data received through the parallel port.

• Make sure the Parallel Buffer menu item is not set to Disabled.

56 Serial port <x> disabled
<x> is the number of the serial port.
Try one or more of the following:

• Touch Continue to clear the message.
The printer discards any data received through the serial port.

• Make sure the Serial Buffer menu item is not set to Disabled.

56 Standard parallel port disabled
Try one or more of the following:

• Touch Continue to clear the message.
The printer discards any data received through the parallel port.

• Make sure the Parallel Buffer menu item is not set to Disabled.

56 Standard USB port disabled
Try one or more of the following:

• Touch Continue to clear the message.
The printer discards any data received through the USB port.

• Make sure the USB Buffer menu item is not set to Disabled.

230
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56 USB port <x> disabled
<x> is the number of the USB port.
Try one or more of the following:

• Touch Continue to clear the message.
The printer discards any data received through the USB port.

• Make sure the USB Buffer menu item is not set to Disabled.

57 Configuration change, held jobs were not restored
Since the time the jobs were stored on the printer hard disk something has changed in the printer to invalidate the
held jobs. Possible changes include:

•
•
•
•

The printer firmware has been updated.
Paper input, output, or duplex options needed for the print job were removed.
The print job was created using data from a device in the USB port and the device is no longer in the port.
The printer hard disk contains jobs that were stored while installed in a different printer model.

Touch Continue to clear the message.

58 Too many bins attached
1 Turn the printer power off.
2 Unplug the power cord from the wall outlet.
3 Remove the additional bins.
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer power back on.

58 Too many disks installed
1 Turn the printer off.
2 Unplug the power cord from the wall outlet.
3 Remove the extra disks.
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer back on.

58 Too many flash options installed
1 Turn the printer off.
2 Unplug the power cord from the wall outlet.
3 Remove the excess flash memory.
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4 Connect the power cord to a properly grounded outlet.
5 Turn the printer back on.

58 Too many trays attached
1 Turn the printer off.
2 Unplug the power cord from the wall outlet.
3 Remove the additional trays.
4 Connect the power cord to a properly grounded outlet.
5 Turn the printer back on.

61 Remove defective disk
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
• Install a different printer hard disk before performing any operations that require a printer hard disk.

62 Disk full
Try one or more of the following:

• Touch Continue to clear the message and continue processing.
• Delete fonts, macros, and other data stored on the printer hard disk.
• Install a larger printer hard disk.

63 Unformatted disk
Try one or more of the following:

• Touch Continue to clear the message and continue printing.
• Format the printer hard disk.
If the error message remains, the hard disk may be defective and require replacing.

80 Routine maintenance needed
The printer needs to have routine maintenance done. Order a maintenance kit, which contains all the items necessary
to replace the pick rollers, the charge roll, the transfer roller, and the fuser.

84 Insert photoconductor
Install the specified photoconductor to clear the message.
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84 Photoconductor low
1 Press the up or down arrow button until

Continue appears, and then press

.

2 Order a replacement photoconductor immediately. When print quality is reduced, install the new photoconductor.

84 Replace photoconductor
The printer will not print any more pages until the photoconductor is replaced.
Replace the specified photoconductor.

84 Photoconductor abnormal
An unacceptable photoconductor has been installed in the device. Replace the photoconductor.

88 Cartridge low
The toner is low. Replace the print cartridge, and then touch Continue to clear the message and continue printing.

88 Replace cartridge to continue
Replace the toner cartridge.

298.01 Scanner Missing - Cable Unplugged
The scanner was not detected. Make sure the scanner is properly connected.

1565 Emulation error, load emulation option
The printer automatically clears the message in 30 seconds and then disables the download emulator on the firmware
card.
To fix this, download the correct download emulator version from the Lexmark Web site at www.lexmark.com.

Clearing jams
Jam error messages appear on the control panel display and include the area of the printer where the jam occurred.
When there is more than one jam, the number of jammed pages is displayed.

Avoiding jams
The following hints can help you avoid jams:

Paper tray recommendations
• Make sure the paper lies flat in the tray.
• Do not remove a tray while the printer is printing.
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• Do not load a tray while the printer is printing. Load it prior to printing, or wait for a prompt to load it.
• Do not load too much paper. Make sure the stack height does not exceed the indicated maximum height.
• Make sure the guides in the tray or the multipurpose feeder are properly positioned and are not pressing too tightly
against the paper or envelopes.

• Push the tray in firmly after loading paper.
Paper recommendations
• Use only recommended paper or specialty media.
• Do not load wrinkled, creased, damp, bent, or curled paper.
• Flex, fan, and straighten paper before loading it.

•
•
•
•

Do not use paper that has been cut or trimmed by hand.
Do not mix paper sizes, weights, or types in the same stack.
Make sure all sizes and types are set correctly in the printer control panel menus.
Store paper per the manufacturer's recommendations.

Understanding jam numbers and locations
When a jam occurs, a message indicating the jam location appears on the display. Open doors and covers and remove
trays to access jam locations. To resolve any paper jam message, you must clear all jammed paper from the paper path.
E
A

D

B
C
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H

G

K

F
J

Jam numbers What to do
200–202

Open Door A, and then remove the jam.

203

Open Doors A and E, and then remove any jams.

230

Lower the duplex unit (Door D), and then remove the jam. Open Doors A and E, and then remove any jams.

231

Lower the duplex unit (Door D), and then remove the jam. Open Door A, and then remove the jam.

24x

Open each tray, and then remove any jams.
250

280–281

1
2
3
4

Remove all media from the multipurpose feeder.
Flex and stack the media.
Reload the multipurpose feeder.
Adjust the paper guide.

Open Door A, and then remove the jam. Lift Door F, and then remove the jam.

282

Lift Door F, and then remove the jam.

283

Open Door H, and then remove the jam.

284

Lower the duplex unit (Door D), and then remove the jam. Open Doors A and E, and then remove any jams.

285–286

Open Door H, and then remove the jam.

287–288

Open Doors F and G, and then remove the jam.

289

Open Door G, and then remove the jam.

290–294 jams Open the ADF cover and the scanner cover, and then remove any jams.
293

•
•
•
•

On the touch screen, select the location of your original document.
Finish your job without further scanning.
Restart scanning.
Cancel the job and clear the message.
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200–201 paper jams
1 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Pull the jam up and toward you.

Note: If the jam does not move immediately, stop pulling. Push down and pull the green lever to make it easier
to remove the jam. Make sure all paper fragments are removed.

3 Close Door A.
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202 paper jam
1 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Pull the jam up and toward you.

Note: If the jam does not move immediately, stop pulling. Push down and pull the green lever to make it easier
to remove the jam. Make sure all paper fragments are removed.

3 Close Door A.
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203, 230–231 paper jams
203 paper jam
1 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Open Door E by pushing the release latch and lowering the door.
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3 Pull the jam up.

4 Close Door E.
5 Close Door A.
230 paper jam
1 Open Door D.
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2 Remove the jam.

D

3 Close Door D.
4 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

Troubleshooting

5 Open Door E by pushing the release latch and lowering the door.

6 Pull the jam up.

7 Close Door E.
8 Close Door A.
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231 paper jam
1 Open Door D.

2 Remove the jam.

D

3 Close Door D.
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4 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

5 Pull the jam up and toward you.

Note: If the jam does not move immediately, stop pulling. Push down and pull the green lever to make it easier
to remove the jam. Make sure all paper fragments are removed.

6 Close Door A.
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24x paper jam
Jam in Tray 1
1 Remove Tray 1 from the printer.

2 Remove the jam.

3 Insert Tray 1.
If all jams are cleared, then the printer resumes printing.
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Clearing Area A
1 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.

2 Pull the jam up and toward you.

Note: If the jam does not move immediately, stop pulling. Push down and pull the green lever to make it easier
to remove the jam. Make sure all paper fragments are removed.

3 Close Door A.
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Clearing Area B
1 Open Door B.

B

C

2 Pull the jam up and toward you.

B

C

3 Close Door B.
4 Touch Continue.
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Clearing Area C
1 Open Door C.

B

C

2 Pull the jam up and toward you.

B

C

3 Close Door C.
4 Touch Continue.
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250 paper jam
1 Remove the paper from the multipurpose feeder.

2 Flex the sheets of paper back and forth to loosen them, and then fan them. Do not fold or crease the paper. Straighten
the edges on a level surface.

3 Load the paper into the multipurpose feeder.
4 Adjust the paper guide to rest lightly against the edge of the paper.

280–282 paper jams
280‑281 paper jams
1 Open Door A by pushing the release latch up and lowering the door.

CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
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2 Pull the jam up and toward you.

Note: If the jam does not move immediately, stop pulling. Push down and pull the green lever to make it easier
to remove the jam. Make sure all paper fragments are removed.

3 Close Door A.
4 Open Door F.

5 Remove the jam.

6 Close Door F.
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282 paper jam
1 Open Door F.

2 Remove the jam.

3 Close Door F.
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283, 289 staple jams
283 paper jam
1 Lift Door H.

2 Remove the jam.

3 Close Door H.
289 staple error
1 Open Door G.
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2 Hold the lever on the staple cartridge holder, and move the holder to the right.

3 Firmly pull the colored tab to remove the staple cartridge.

4 Use the metal tab to lift the staple guard, and then pull out the sheet of staples.
Discard the entire sheet.

5 Look through the clear covering on the bottom of the cartridge holder to make sure no staples are jammed at the
entrance.

Troubleshooting

6 Press down on the staple guard until it snaps securely into place.

7 Push the cartridge holder firmly into the stapler until the holder clicks into place.

8 Close Door G.
Priming Stapler appears. Priming ensures the stapler is functioning properly.
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28x paper jam
284 paper jam
1 Open Door F.

2 Remove the jam.

3 Close Door F.
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4 Open Door G.

5 Remove the jam.
6 Close Door G.
7 Lift Door H.

8 Remove the jam.

9 Close Door H.
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285–286 paper jams
1 Lift Door H.

2 Remove the jam.

3 Close Door H.
287–288 paper jams
1 Open Door F.
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2 Remove the jam.

3 Close Door F.
4 Open Door G.

5 Remove the jam.
6 Close Door G.

290–294 paper jams
1 Remove all original documents from the ADF.
2 Lift the ADF cover latch.
3 Open the ADF cover, and then remove any jammed paper.
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4 Raise the sheet guard.
5 Turn the paper advance wheel to the left to remove any jammed pages.

6 Close the ADF cover.
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7 Open the scanner cover, and remove any jammed pages.

8 Close the scanner cover.
9 Touch Continue.

293 paper jam
The printer was sent a scan job, but found no original document in the ADF. Try one or more of the following:

• Touch Continue if no scan job is active when the message appears. This clears the message.
• Touch Cancel Job if a scan job is processing when the message appears. This cancels the job and clears the message.
• Touch Scan from Automatic Document Feeder if the page jam recovery is active. Scanning resumes from the ADF
immediately after the last successfully scanned page.

• Touch Scan from flatbed if page jam recovery is active. Scanning resumes from the scanner glass immediately after
the last successfully scanned page.

• Touch Finish job without further scanning if page jam recovery is active. The job ends at the last successfully scanned
page, but the job is not canceled. Successfully scanned pages go to their destination: copy, fax, e-mail, or FTP.

• Touch Restart job if job recovery is active and the job is restartable. The message clears. A new scan job containing
the same parameters as the previous job starts.
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Solving printing problems
Multiple‑language PDFs do not print
The documents contain unavailable fonts.

1 Open the document you want to print in Adobe Acrobat.
2 Click the printer icon.
The Print dialog appears.

3 Select Print as image.
4 Click OK.

Error message about reading USB drive appears
Make sure the USB drive is supported. For information regarding tested and approved USB flash memory devices, see
“Printing from a flash drive” on page 79.

Jobs do not print
These are possible solutions. Try one or more of the following:

MAKE SURE THE PRINTER IS READY TO PRINT
Make sure Ready or Power Saver appears on the display before sending a job to print.

CHECK TO SEE IF THE STANDARD EXIT BIN IS FULL
Remove the stack of paper from the standard exit bin.

CHECK TO SEE IF THE PAPER TRAY IS EMPTY
Load paper in the tray.

MAKE SURE THE CORRECT PRINTER SOFTWARE IS INSTALLED
• Verify that you are using the correct printer software.
• If you are using a USB port, make sure you are running a supported operating system and using compatible printer
software.

MAKE SURE THE INTERNAL PRINT SERVER IS INSTALLED PROPERLY AND WORKING
• Make sure the internal print server is properly installed and that the printer is connected to the network.
• Print a network setup page and check that the status shows Connected. If the status is Not Connected, check the
network cables, and then try printing the network setup page again. Contact your system support person to make
sure the network is functioning correctly.
Copies of the printer software are also available on the Lexmark Web site at www.lexmark.com.
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MAKE SURE YOU ARE USING A RECOMMENDED USB, SERIAL, OR ETHERNET CABLE
For more information, visit the Lexmark Web site at www.lexmark.com.

MAKE SURE PRINTER CABLES ARE SECURELY CONNECTED
Check the cable connections to the printer and print server to make sure they are secure.
For more information, see the setup documentation that came with the printer.

Confidential and other held jobs do not print
These are possible solutions. Try one or more of the following:

PARTIAL JOB, NO JOB, OR BLANK PAGES PRINT
The print job may contain a formatting error or invalid data.

• Delete the print job, and then print it again.
• For PDF documents, recreate the PDF and then print it again.

MAKE SURE THE PRINTER HAS SUFFICIENT MEMORY
Free up additional printer memory by scrolling through the list of held jobs and deleting some of them.

Job takes longer than expected to print
These are possible solutions. Try one or more of the following:

REDUCE THE COMPLEXITY OF THE PRINT JOB
Eliminate the number and size of fonts, the number and complexity of images, and the number of pages in the job.

CHANGE THE PAGE PROTECT SETTING TO OFF
1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Settings.
4 Touch General Settings.
5 Touch the down arrow until Print Recovery appears.
6 Touch Print Recovery.
7 Touch the right arrow next to Page Protect until Off appears.
8 Touch Submit.
9 Touch

.
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Job prints from the wrong tray or on the wrong paper
CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Type setting from the Paper menu.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

Incorrect characters print
MAKE SURE THE PRINTER IS NOT IN HEX TRACE MODE
If Ready Hex appears on the display, then you must exit Hex Trace mode before you can print your job. Turn the
printer off and back on to exit Hex Trace mode.

Tray linking does not work
These are possible solutions. Try one or more of the following:

LOAD THE SAME SIZE AND TYPE OF PAPER
• Load the same size and type of paper in each tray to be linked.
• Move the paper guides to the correct positions for the paper size loaded in each tray.

USE THE SAME PAPER SIZE AND PAPER TYPE SETTINGS
• Print a menu settings page and compare the settings for each tray.
• If necessary, adjust the settings from the Paper Size/Type menu.
Note: The multipurpose feeder does not automatically sense the paper size. You must set the size from the Paper
Size/Type menu.

Large jobs do not collate
These are possible solutions. Try one or more of the following:

MAKE SURE COLLATE IS SET TO ON
From the Finishing menu or Print Properties, set Collate to On.
Note: Setting Collate to Off in the software overrides the setting in the Finishing menu.

REDUCE THE COMPLEXITY OF THE PRINT JOB
Reduce the complexity of the print job by eliminating the number and size of fonts, the number and complexity of
images, and the number of pages in the job.
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MAKE SURE THE PRINTER HAS ENOUGH MEMORY
Add printer memory or an optional hard disk.

Unexpected page breaks occur
INCREASE THE PRINT TIMEOUT VALUE
1 Make sure the printer is on and Ready appears.
2 On the home screen, touch

.

3 Touch Settings.
4 Touch General Settings.
5 Touch the down arrow until Timeouts appears.
6 Touch Timeouts.
7 Touch the left or right arrow next to Print Timeout until the desired value appears.
8 Touch Submit.
9 Touch

.

Solving copy problems
Copier does not respond
These are possible solutions. Try one or more of the following:

CHECK THE DISPLAY FOR ERROR MESSAGES
Clear any error messages.

CHECK THE POWER
Make sure the printer is plugged in, the power is on, and Ready appears.

Scanner unit does not close
Make sure there are no obstructions:

1 Lift the scanner unit.
2 Remove any obstruction keeping the scanner unit open.
3 Lower the scanner unit.
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Poor copy quality
These are some examples of poor copy quality:

•
•
•
•
•
•
•
•
•
•
•

Blank pages
Checkerboard pattern
Distorted graphics or pictures
Missing characters
Faded print
Dark print
Skewed lines
Smudges
Streaks
Unexpected characters
White lines in print

These are possible solutions. Try one or more of the following:

CHECK THE DISPLAY FOR ERROR MESSAGES
Clear any error messages.

THE TONER MAY BE LOW
When 88 Cartridge low appears or when the print becomes faded, replace the print cartridge.

THE SCANNER GLASS MAY BE DIRTY
Clean the scanner glass with a clean, lint‑free cloth dampened with water. For more information, see “Cleaning the
scanner glass” on page 199.

THE COPY IS TOO LIGHT OR TOO DARK
Adjust the density of the copy.

CHECK THE QUALITY OF THE ORIGINAL DOCUMENT
Make sure the quality of the original document is satisfactory.

CHECK THE DOCUMENT PLACEMENT
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

UNWANTED TONER IS IN THE BACKGROUND
• Increase the background removal setting.
• Adjust the darkness to a lighter setting.
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PATTERNS (MOIRÉ) APPEAR IN THE OUTPUT
• On the Copy screen, select the Text/Photo or Printed Image icon.
• Rotate the original document on the scanner glass.
• On the Copy screen, adjust the scale setting.

TEXT IS LIGHT OR DISAPPEARING
•
•
•
•

On the Copy screen, touch the Text icon.
Decrease the background removal setting.
Increase the contrast setting.
Decrease the shadow detail setting.

THE OUTPUT APPEARS WASHED OUT OR OVEREXPOSED
• On the Copy screen, select the Printed Image icon.
• Decrease the background removal setting.

Partial document or photo copies
These are possible solutions. Try one or more of the following:

CHECK THE DOCUMENT PLACEMENT
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Size setting from the Paper menu.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.

Solving scanner problems
Checking an unresponsive scanner
If your scanner is not responding, then make sure:

• The printer is turned on.
• The printer cable is securely attached to the printer and the host computer, print server, option, or other network
device.

• The power cord is plugged into the printer and a properly grounded electrical outlet.
• The electrical outlet is not turned off by any switch or breaker.
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• The printer is not plugged into any surge protectors, uninterrupted power supplies, or extension cords.
• Other electrical equipment plugged into the outlet is working.
Once you have checked each of these possibilities, turn the printer off and then back on. This often fixes the problem
with the scanner.

Scan was not successful
These are possible solutions. Try one or more of the following:

CHECK THE CABLE CONNECTIONS
Make sure the network or USB cable is securely connected to the computer and the printer.

AN ERROR MAY HAVE OCCURRED IN THE PROGRAM
Turn off and then restart the computer.

Scanning takes too long or freezes the computer
These are possible solutions. Try one or more of the following:

OTHER SOFTWARE PROGRAMS MAY BE INTERFERING WITH SCANNING
Close all programs not being used.

THE SCAN RESOLUTION MAY BE SET TOO HIGH
Select a lower scan resolution.

Poor scanned image quality
These are possible solutions. Try one or more of the following:

CHECK THE DISPLAY FOR ERROR MESSAGES
Clear any error messages.

THE SCANNER GLASS MAY BE DIRTY
Clean the scanner glass with a clean, lint‑free cloth dampened with water. For more information, see “Cleaning the
scanner glass” on page 199.

ADJUST THE SCAN RESOLUTION
Increase the resolution of the scan for a higher quality output.

CHECK THE QUALITY OF THE ORIGINAL DOCUMENT
Make sure the quality of the original document is satisfactory.
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CHECK THE DOCUMENT PLACEMENT
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

Partial document or photo scans
These are possible solutions. Try one or more of the following:

CHECK THE DOCUMENT PLACEMENT
Make sure the document or photo is loaded facedown on the scanner glass in the upper left corner.

CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel, check the Paper Size setting from the Paper menu.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.

Cannot scan from a computer
These are possible solutions. Try one or more of the following:

CHECK THE DISPLAY FOR ERROR MESSAGES
Clear any error messages.

CHECK THE POWER
Make sure the printer is plugged in, the power is on, and Ready appears.

CHECK THE CABLE CONNECTIONS
Make sure the network or USB cable is securely connected to the computer and the printer.

Solving fax problems
Caller ID is not shown
Contact your telecommunications company to verify that your telephone line is subscribed to the caller ID service.
If your region supports multiple caller ID patterns, you may have to change the default setting. There are two settings
available: FSK (pattern 1) and DTMF (pattern 2). The availability of these settings by way of the Fax menu depends on
whether your country or region supports multiple caller ID patterns. Contact your telecommunications company to
determine which pattern or switch setting to use.
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Cannot send or receive a fax
These are possible solutions. Try one or more of the following:

CHECK THE DISPLAY FOR ERROR MESSAGES
Clear any error messages.

CHECK THE POWER
Make sure the printer is plugged in, the power is on, and Ready appears.

CHECK THE PRINTER CONNECTIONS
Make sure the cable connections for the following hardware are secure, if applicable:

• Telephone
• Handset
• Answering machine

CHECK THE TELEPHONE WALL JACK
1 Plug a telephone into the wall jack.
2 Listen for a dial tone.
3 If you do not hear a dial tone, then plug a different telephone into the wall jack.
4 If you still do not hear a dial tone, then plug a telephone into a different wall jack.
5 If you hear a dial tone, then connect the printer to that wall jack.

REVIEW THIS DIGITAL PHONE SERVICE CHECKLIST
The fax modem is an analog device. Certain devices can be connected to the printer so that digital telephone services
can be used.

• If you are using an ISDN telephone service, then connect the printer to an analog telephone port (an R-interface
port) on an ISDN terminal adapter. For more information and to request an R-interface port, contact your ISDN
provider.

• If you are using DSL, then connect to a DSL filter or router that will support analog use. For more information,
contact your DSL provider.

• If you are using a PBX telephone service, then make sure you are connecting to an analog connection on the PBX.
If none exists, consider installing an analog telephone line for the fax machine.

CHECK FOR A DIAL TONE
• Place a test call to the telephone number to which you want to send a fax to make sure that it is working correctly.
• If the telephone line is being used by another device, then wait until the other device is finished before sending
a fax.

• If you are using the On Hook Dial feature, then turn up the volume to verify a dial tone.
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TEMPORARILY DISCONNECT OTHER EQUIPMENT
To ensure the printer is working correctly, connect it directly to the telephone line. Disconnect any answering
machines, computers with modems, or telephone line splitters.

CHECK FOR JAMS
Clear any jams, and then make sure that Ready appears.

TEMPORARILY DISABLE CALL WAITING
Call Waiting can disrupt fax transmissions. Disable this feature before sending or receiving a fax. Call your telephone
company to obtain the keypad sequence for temporarily disabling Call Waiting.

VOICE MAIL SERVICE MAY BE INTERFERING WITH THE FAX TRANSMISSION
Voice Mail offered through your local telephone company may disrupt fax transmissions. To enable both Voice Mail
and the printer to answer calls, you may want to consider adding a second telephone line for the printer.

THE PRINTER MEMORY MAY BE FULL
1 Dial the fax number.
2 Scan the original document one page at a time.

Can send but not receive faxes
These are possible solutions. Try one or more of the following:

CHECK TO SEE IF THE PAPER TRAY IS EMPTY
Load paper in the tray.

CHECK THE RING COUNT DELAY SETTINGS
The ring count delay sets the number of times the phone line rings before the printer answers. If you have extension
phones on the same line as the printer, or subscribe to the telephone company's Distinctive Ring service, then keep
the Ring Delay setting at 4.

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
4 Click Analog Fax Setup.
5 In the Rings to Answer box, enter the number of times you want the phone to ring before answering.
6 Click Submit.
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THE TONER MAY BE LOW
88 Cartridge low appears when the toner is low.

Can receive but not send faxes
These are possible solutions. Try one or more of the following:

THE PRINTER IS NOT IN FAX MODE
On the home screen, touch Fax to put the printer in Fax mode.

THE DOCUMENT IS NOT LOADED PROPERLY
Load the original document faceup, short edge first into the ADF or facedown on the scanner glass in the upper left
corner.
Note: Do not load postcards, photos, small items, transparencies, photo paper, or thin media (such as magazine
clippings) into the ADF. Place these items on the scanner glass.

MAKE SURE THE SHORTCUT NUMBER IS SET UP PROPERLY
• Check to make sure the shortcut number has been programmed for the number that you want to dial.
• As an alternative, dial the telephone number manually.

Received fax has poor print quality
These are possible solutions. Try one or more of the following:

RE‑SEND THE DOCUMENT
Ask the person who sent you the fax to:

• Check that the quality of the original document is satisfactory.
• Resend the fax. There may have been a problem with the quality of the telephone line connection.
• Increase the fax scan resolution, if possible.

THE TONER MAY BE LOW
When 88 Cartridge low appears or when you experience faded print, replace the cartridge.

MAKE SURE THE FAX TRANSMISSION SPEED IS NOT SET TOO HIGH
Decrease the incoming fax transmission speed:

1 Type the printer IP address into the address field of your Web browser.
Note: If you do not know the IP address of the printer, then print a network setup page and locate the IP
address in the TCP/IP section.

2 Click Settings.
3 Click Fax Settings.
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4 Click Analog Fax Setup.
5 In the Max Speed box, click on one of the following:
2400
4800
9600
14400
33600

6 Click Submit.

Solving option problems
Option does not operate correctly or quits after it is installed
These are possible solutions. Try one or more of the following:

RESET THE PRINTER
Turn the printer off, wait for about 10 seconds, and then turn the printer on.

CHECK TO SEE IF THE OPTION IS CONNECTED TO THE PRINTER
1 Turn the printer off.
2 Unplug the printer from the wall outlet.
3 Check the connection between the option and the printer.

MAKE SURE THE OPTION IS INSTALLED
Print a menu settings page and check to see if the option is listed in the Installed Options list. If the option is not
listed, then reinstall it.

MAKE SURE THE OPTION IS AVAILABLE IN THE PRINTER DRIVER
It may be necessary to manually add the option in the printer driver to make it available for print jobs. For more
information, see “Updating available options in the printer driver” on page 39.

MAKE SURE THE OPTION IS SELECTED
From the program you are using, select the option. Mac OS 9 users should make sure the printer is set up in the
Chooser.
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Paper tray problems
Try one or more of the following:

MAKE SURE THE PAPER IS LOADED CORRECTLY
1 Open the paper tray.
2 Check for paper jams or misfeeds.
3 Make sure the paper guides are aligned against the edges of the paper.
4 Make sure the paper tray closes properly.

RESET THE PRINTER
Turn the printer off, wait about 10 seconds, and then turn the printer on.

MAKE SURE THE PAPER TRAY IS INSTALLED CORRECTLY
If the paper tray is listed on the menu settings page, but paper jams when it enters or exits the tray, then it may not
be properly installed. Reinstall the paper tray. For more information, see the hardware setup documentation that
came with the paper tray, or go to http://support.lexmark.com to view the paper tray instruction sheet.

Solving 2,000-sheet drawer problems
Try one or more of the following:

THE ELEVATOR TRAY IS NOT WORKING PROPERLY
•
•
•
•
•

Make sure the printer is properly connected to the 2,000‑sheet drawer.
Make sure the printer is turned on.
Make sure that the power cord is plugged firmly into the back of the 2,000‑sheet drawer.
If the tray is empty, then load paper in the tray.
Clear any jams.

THE PAPER FEED ROLLERS DO NOT TURN TO ADVANCE PAPER
• Make sure the printer is properly connected to the 2,000‑sheet drawer.
• Make sure the printer is turned on.

THE PAPER CONSISTENTLY JAMS IN THE DRAWER
•
•
•
•
•

Flex the paper.
Make sure the drawer is properly installed.
Make sure paper is loaded correctly.
Make sure the paper or specialty media meets specifications and is not damaged.
Make sure the guides are positioned correctly for the paper size loaded.
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Memory card
Make sure the memory card is securely connected to the printer system board.

Flash memory card
Make sure the flash memory card is securely connected to the printer system board.

Hard disk with adapter
Make sure the hard disk is securely connected to the printer system board.

Internal Solutions Port
If the Lexmark Internal Solutions Port (ISP) does not operate correctly, then these are possible solutions. Try one or
more of the following:

CHECK THE ISP CONNECTIONS
• Make sure the ISP is securely attached to the printer system board.
• Make sure the cable is securely connected to the correct connector.

CHECK THE CABLE
Make sure you are using the correct cable and that it is securely connected.

MAKE SURE THE NETWORK SOFTWARE IS CONFIGURED CORRECTLY
For information about installing software for network printing, see the Networking Guide on the Software and
Documentation CD

Internal print server
If the internal print server does not operate correctly, these are possible solutions. Try one or more of the following:

CHECK THE PRINT SERVER CONNECTIONS
• Make sure the internal print server is attached securely to the printer system board.
• Make sure you are using the correct (optional) cable and that it is securely connected.

MAKE SURE THE NETWORK SOFTWARE IS CONFIGURED CORRECTLY
For information about installing software for network printing, click Additional on the Software and
Documentation CD, and then select the Networking Guide link under Publications on this CD.
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USB/parallel interface card
Check the USB/parallel interface card connections:

• Make sure the USB/parallel interface card is securely connected to the printer system board.
• Make sure you are using the correct cable and that it is securely connected.

Solving paper feed problems
Paper frequently jams
These are possible solutions. Try one or more of the following:

CHECK THE PAPER
Use recommended paper and specialty media. For more information, see the chapter about paper and specialty
media guidelines.

MAKE SURE THERE IS NOT TOO MUCH PAPER IN THE PAPER TRAY
Make sure the stack of paper you load does not exceed the maximum stack height indicated in the tray or on the
multipurpose feeder.

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

Paper jam message remains after jam is cleared
CHECK THE PAPER PATH
The paper path is not clear. Clear jammed paper from the entire paper path, and then touch Continue.

Page that jammed does not reprint after you clear the jam
TURN ON JAM RECOVERY
In the Setup menu, Jam Recovery is set to Off. Set Jam Recovery to Auto or On:

1 Make sure the printer is on and Ready appears.
2 On the home screen, touch
3 Touch Settings.

.
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4 Touch General Settings.
5 Touch the down arrow until Print Recovery appears.
6 Touch Print Recovery.
7 Touch the right arrow next to Jam Recovery until On or Auto appears.
8 Touch Submit.
9 Touch

.

Solving print quality problems
Isolating print quality problems
To help isolate print quality problems, print the print quality test pages:

1 Turn the printer off.
2 Load Letter‑ or A4‑size paper in the tray.
3 Hold down

and

6 MNO

while turning the printer on.

4 Release the buttons when the screen with the progress bar appears.
The printer performs a power‑on sequence, and then the Configuration menu appears.

5 Touch the down arrow until Print Quality Pages appears.
6 Touch Print Quality Pages.
The print quality test pages print.

7 Touch Back.
8 Touch Exit Configuration.

Blank pages

These are possible solutions. Try one or more of the following:

PACKING MATERIAL MAY BE ON THE TONER CARTRIDGE
Remove the toner cartridge and make sure the packing material is properly removed. Reinstall the toner cartridge.
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THE TONER MAY BE LOW
When 88 Cartridge Low appears, order a new toner cartridge.
If the problem continues, the printer may need to be serviced. For more information, contact Customer Support.

Clipped images
Try one or more of the following:

CHECK THE GUIDES
Move the width and length guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Size setting.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.

Ghost images

ABCDE
ABCDE
ABCDE
CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.
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Gray background

ABCDE
ABCDE
ABCDE
CHECK THE TONER DARKNESS SETTING
Select a lighter Toner Darkness setting:

• From the printer control panel, change the setting from the Quality menu.
• For Windows users, change the setting from Print Properties.
• For Macintosh users, change the setting from the Print dialog.

Incorrect margins

ABCD
ABCD
ABCD
These are possible solutions. Try one or more of the following:

CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER SIZE SETTING
Make sure the paper size setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Size setting.
2 Before sending the job to print, specify the correct size setting:
• For Windows users, specify the size from Print Properties.
• For Macintosh users, specify the size from the Page Setup dialog.
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Paper curl
These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

Print irregularities

These are possible solutions. Try one or more of the following:

THE PAPER MAY HAVE ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER
Avoid textured paper with rough finishes.
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THE TONER MAY BE LOW
When 88 Cartridge Low appears or when the print becomes faded, replace the toner cartridge.

THE FUSER MAY BE WORN OR DEFECTIVE
Replace the fuser.

Print is too dark

These are possible solutions. Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS
The Toner Darkness setting is too dark, the Brightness setting is too dark, or the Contrast setting is too high.

• Change these settings from the printer control panel Quality menu.
• For Windows users, change these settings from Print Properties.
• For Macintosh users, change these settings from the Print dialog and pop‑up menus.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER
Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.
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Print is too light

These are possible solutions. Try one or more of the following:

CHECK THE DARKNESS, BRIGHTNESS, AND CONTRAST SETTINGS
The Toner Darkness setting is too light, the Brightness setting is too light, or the Contrast setting is too low.

• Change these settings from the printer control panel Quality menu.
• For Windows users, change these settings from Print Properties.
• For Macintosh users, change these settings from the Print dialog and pop‑up menus.

THE PAPER HAS ABSORBED MOISTURE DUE TO HIGH HUMIDITY
• Load paper from a fresh package.
• Store paper in its original wrapper until you use it.

CHECK THE PAPER
Avoid textured paper with rough finishes.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

THE TONER IS LOW
When 88 Cartridge Low appears, order a new toner cartridge.

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.
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Repeating defects

These are possible solutions. Try one or more of the following:
Replace the transfer roller if the defects occur every:
58.7 mm (2.31 in.)
Replace the photoconductor if the defects occur every:
44 mm (1.73 in.)
Replace the fuser if the defects occur every:

• 78.5 mm (3.09 in.)
• 94.2 mm (3.71 in.)

Skewed print
CHECK THE PAPER GUIDES
Move the guides in the tray to the correct positions for the paper size loaded.

CHECK THE PAPER
Make sure you are using paper that meets the printer specifications.

Solid black or white streaks appear on transparencies or paper

These are possible solutions. Try one or more of the following:

ENSURE THAT THE FILL PATTERN IS CORRECT
If the fill pattern is incorrect, choose a different fill pattern from your software program.
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CHECK THE PAPER TYPE
•
•
•
•

Try a different type of paper.
Use only the recommended transparencies.
Ensure that the Paper Type setting matches what is loaded in the tray or feeder.
Ensure that the Paper Texture setting is correct for the type of paper or specialty media loaded in the tray or
feeder.

ENSURE THAT THE TONER IS DISTRIBUTED EVENLY WITHIN THE TONER CARTRIDGE
Remove the toner cartridge and shake it from side to side to redistribute the toner, and then reinstall it.

THE TONER CARTRIDGE MAY BE DEFECTIVE OR LOW ON TONER
Replace the used toner cartridge with a new one.

Streaked horizontal lines

ABCDE
ABCDE
ABCDE
These are possible solutions. Try one or more of the following:

THE TONER IS SMEARED
Select another tray or feeder to feed the paper for the job:

• From the printer control panel Paper Menu, select the Default Source.
• For Windows users, select the paper source from Print Properties.
• For Macintosh users, select the paper source from the Print dialog and pop‑up menus.

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

THE PAPER PATH MAY NOT BE CLEAR
Check the paper path around the toner cartridge.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
Clear any paper you see.
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THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Streaked vertical lines

ABCDE
ABCDE
ABCDE
These are possible solutions. Try one or more of the following:

THE TONER IS SMEARED
Select another tray or feeder to feed paper for the job:

• From the printer control panel Paper Menu, select the Default Source.
• For Windows users, select the paper source from Print Properties.
• For Macintosh users, select the paper source from the Print dialog and pop‑up menus.

THE TONER CARTRIDGE IS DEFECTIVE
Replace the toner cartridge.

THE PAPER PATH MAY NOT BE CLEAR
Check the paper path around the toner cartridge.
CAUTION—HOT SURFACE: The inside of the printer might be hot. To reduce the risk of injury from a hot
component, allow the surface to cool before touching.
Clear any paper you see.

THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Toner fog or background shading appears on the page
These are possible solutions. Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.
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THE CHARGE ROLLS MAY BE DEFECTIVE
Replace the charge rolls.

THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Toner rubs off

These are possible solutions. Try one or more of the following:

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

CHECK THE PAPER TEXTURE SETTING
From the printer control panel Paper menu, make sure the Paper Texture setting matches the paper loaded in the
tray.
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Toner specks

These are possible solutions. Try one or more of the following:

THE TONER CARTRIDGE MAY BE DEFECTIVE
Replace the toner cartridge.

THERE IS TONER IN THE PAPER PATH
Contact Customer Support.

Transparency print quality is poor
Try one or more of the following:

CHECK THE TRANSPARENCIES
Use only transparencies recommended by the printer manufacturer.

CHECK THE PAPER TYPE SETTING
Make sure the paper type setting matches the paper loaded in the tray:

1 From the printer control panel Paper menu, check the Paper Type setting.
2 Before sending the job to print, specify the correct type setting:
• For Windows users, specify the type from Print Properties.
• For Macintosh users, specify the type from the Print dialog.

Contacting customer support
When you contact customer support, describe the problem you are experiencing, the printer control panel light
sequence, and the troubleshooting steps you have already taken to find a solution.
You need to know your printer model type and serial number. For more information, see the label on the inside top
front cover of the printer. The serial number is also listed on the menu settings page.
Lexmark has various ways to help you solve your printing problem. Visit the Lexmark Web site at
http://support.lexmark.com, and then select one of the following:
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Tech Library You can browse our library of manuals, support documentation, drivers, and other downloads to help you
solve common problems.
E-mail

You can send an e-mail to the Lexmark team, describing your problem. A service representative will respond
and provide you with information to solve your problem.

Live chat

You can chat directly with a service representative. They can work with you to solve your printer problem or
provide assistance through Assisted Service where the service representative can remotely connect to your
computer through the Internet to troubleshoot problems, install updates, or complete other tasks to help
you successfully use your Lexmark product.

Telephone support is also available. In the U.S. or Canada, call 1-800-539-6275. For other countries or regions, visit the
Lexmark Web site at http://support.lexmark.com.
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Notices
Product information
Product name:
Lexmark X86x Series
Machine type:
7500
Model(s):
432, 632, 832

Edition notice
December 2012
The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.
This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.
References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.
For Lexmark technical support, visit support.lexmark.com.
For information on supplies and downloads, visit www.lexmark.com.
If you don't have access to the Internet, you can contact Lexmark by mail:
Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA
© 2012 Lexmark International, Inc.
All rights reserved.
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GOVERNMENT END USERS
The Software Program and any related documentation are "Commercial Items," as that term is defined in 48 C.F.R.
2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R.
12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1 through 227.7207-4,
as applicable, the Commercial Computer Software and Commercial Software Documentation are licensed to the U.S.
Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users
pursuant to the terms and conditions herein.

Trademarks
Lexmark, Lexmark with diamond design, MarkNet, and MarkVision are trademarks of Lexmark International, Inc.,
registered in the United States and/or other countries.
MarkTrack and PrintCryption are trademarks of Lexmark International, Inc.
PCL® is a registered trademark of the Hewlett-Packard Company. PCL is Hewlett-Packard Company’s designation of a
set of printer commands (language) and functions included in its printer products. This printer is intended to be
compatible with the PCL language. This means the printer recognizes PCL commands used in various application
programs, and that the printer emulates the functions corresponding to the commands.
Mac and the Mac logo are trademarks of Apple Inc., registered in the U.S. and other countries.
The following terms are trademarks or registered trademarks of these companies:
Albertus

The Monotype Corporation plc

Antique Olive

Monsieur Marcel OLIVE

Apple-Chancery

Apple Computer, Inc.

Arial

The Monotype Corporation plc

CG Times

Based on Times New Roman under license from The Monotype Corporation plc, is a product of
Agfa Corporation

Chicago

Apple Computer, Inc.

Clarendon

Linotype-Hell AG and/or its subsidiaries

Eurostile

Nebiolo

Geneva

Apple Computer, Inc.

GillSans

The Monotype Corporation plc

Helvetica

Linotype-Hell AG and/or its subsidiaries

Hoefler

Jonathan Hoefler Type Foundry

ITC Avant Garde Gothic International Typeface Corporation
ITC Bookman

International Typeface Corporation

ITC Mona Lisa

International Typeface Corporation

ITC Zapf Chancery

International Typeface Corporation

Joanna

The Monotype Corporation plc

Marigold

Arthur Baker
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Monaco

Apple Computer, Inc.

New York

Apple Computer, Inc.

Oxford

Arthur Baker

Palatino

Linotype-Hell AG and/or its subsidiaries

Stempel Garamond

Linotype-Hell AG and/or its subsidiaries

Taffy

Agfa Corporation

Times New Roman

The Monotype Corporation plc

Univers

Linotype-Hell AG and/or its subsidiaries

All other trademarks are the property of their respective owners.
AirPrint and the AirPrint logo are trademarks of Apple, Inc.

Federal Communications Commission (FCC) compliance information statement
This product has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference,
and (2) this device must accept any interference received, including interference that may cause undesired operation.
The FCC Class A limits are designed to provide reasonable protection against harmful interference when the equipment
is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio
communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case
the user will be required to correct the interference at his own expense.
The manufacturer is not responsible for any radio or television interference caused by using other than recommended
cables or by unauthorized changes or modifications to this equipment. Unauthorized changes or modifications could
void the user's authority to operate this equipment.
Note: To assure compliance with FCC regulations on electromagnetic interference for a Class A computing device,
use a properly shielded and grounded cable such as Lexmark part number 1021231 for parallel attach or 1021294 for
USB attach. Use of a substitute cable not properly shielded and grounded may result in a violation of FCC
regulations.

Modular component notice
This product contains the following modular component(s):
FCC ID: E46HFD1; Industry Canada IC: 4423B-HFD1

Noise emission levels
The following measurements were made in accordance with ISO 7779 and reported in conformance with ISO 9296.
Note: Some modes may not apply to your product.
1-meter average sound pressure, dBA
Printing

53 dBA
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1-meter average sound pressure, dBA
Ready

32 dBA

Values are subject to change. See www.lexmark.com for current values.

Temperature information
Ambient temperature

15–32° C (60–90° F)

Shipping temperature

‑40–60° C (‑40–140° F)

Storage temperature

1–60° C (34–140° F)

Waste from Electrical and Electronic Equipment (WEEE) directive

The WEEE logo signifies specific recycling programs and procedures for electronic products in countries of the European
Union. We encourage the recycling of our products. If you have further questions about recycling options, visit the
Lexmark Web site at www.lexmark.com for your local sales office phone number.

Product disposal
Do not dispose of the printer or supplies in the same manner as normal household waste. Consult your local authorities
for disposal and recycling options.

ENERGY STAR
Any Lexmark product bearing the ENERGY STAR emblem on the product or on a start-up screen is certified to comply
with Environmental Protection Agency (EPA) ENERGY STAR requirements as configured when shipped by Lexmark.
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Laser notice
The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, Chapter I, Subchapter J for Class I
(1) laser products, and elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1.
Class I laser products are not considered to be hazardous. The printer contains internally a Class IIIb (3b) laser that is
nominally a 7 milliwatt gallium arsenide laser operating in the wavelength of 655-675 nanometers. The laser system
and printer are designed so there is never any human access to laser radiation above a Class I level during normal
operation, user maintenance, or prescribed service condition.

Laser advisory label
A laser notice label may be affixed to this printer as shown:
DANGER - Invisible laser radiation when cartridges are removed and interlock defeated. Avoid exposure to laser beam.
PERIGO - Radiação a laser invisível será liberada se os cartuchos forem removidos e o lacre rompido. Evite a exposição aos feixes de laser.
Opasnost - Nevidljivo lasersko zračenje kada su kasete uklonjene i poništena sigurnosna veza. Izbjegavati izlaganje zracima.
NEBEZPEČÍ - Když jsou vyjmuty kazety a je odblokována pojistka, ze zařízení je vysíláno neviditelné laserové záření. Nevystavujte se působení laserového paprsku.
FARE - Usynlig laserstråling, når patroner fjernes, og spærreanordningen er slået fra. Undgå at blive udsat for laserstrålen.
GEVAAR - Onzichtbare laserstraling wanneer cartridges worden verwijderd en een vergrendeling wordt genegeerd. Voorkom blootstelling aan de laser.
DANGER - Rayonnements laser invisibles lors du retrait des cartouches et du déverrouillage des loquets. Eviter toute exposition au rayon laser.
VAARA - Näkymätöntä lasersäteilyä on varottava, kun värikasetit on poistettu ja lukitus on auki. Vältä lasersäteelle altistumista.
GEFAHR - Unsichtbare Laserstrahlung beim Herausnehmen von Druckkassetten und offener Sicherheitssperre. Laserstrahl meiden.
ΚΙΝΔΥΝΟΣ - Έκλυση αόρατης ακτινοβολίας laser κατά την αφαίρεση των κασετών και την απασφάλιση της μανδάλωσης. Αποφεύγετε την έκθεση στην ακτινοβολία laser.
VESZÉLY – Nem látható lézersugárzás fordulhat elő a patronok eltávolításakor és a zárószerkezet felbontásakor. Kerülje a lézersugárnak való kitettséget.
PERICOLO - Emissione di radiazioni laser invisibili durante la rimozione delle cartucce e del blocco. Evitare l´esposizione al raggio laser.
FARE – Usynlig laserstråling når kassettene tas ut og sperren er satt ut av spill. Unngå eksponering for laserstrålen.
NIEBEZPIECZEŃSTWO - niewidzialne promieniowanie laserowe podczas usuwania kaset i blokady. Należy unikać naświetlenia promieniem lasera.
ОПАСНО! Невидимое лазерное излучение при извлеченных картриджах и снятии блокировки. Избегайте воздействия лазерных лучей.
Pozor – Nebezpečenstvo neviditeľného laserového žiarenia pri odobratých kazetách a odblokovanej poistke. Nevystavujte sa lúčom.
PELIGRO: Se producen radiaciones láser invisibles al extraer los cartuchos con el interbloqueo desactivado. Evite la exposición al haz de láser.
FARA – Osynlig laserstrålning när patroner tas ur och spärrmekanismen är upphävd. Undvik exponering för laserstrålen.
危险 - 当移除碳粉盒及互锁失效时会产生看不见的激光辐射，请避免暴露在激光光束下。
危險 - 移除碳粉匣與安全連續開關失效時會產生看不見的雷射輻射。請避免曝露在雷射光束下。
危険 - カートリッジが取り外され、内部ロックが無効になると、見えないレーザー光が放射されます。 このレーザー光に当たらないようにしてください。

Power consumption
Product power consumption
The following table documents the power consumption characteristics of the product.
Note: Some modes may not apply to your product.
Mode

Description

Power consumption (Watts)

Printing

The product is generating hard‑copy output from electronic inputs.

730 W (X860), 800 W (X862), 830 W
(X864)

Copying

The product is generating hard‑copy output from hard‑copy original 800 W (X860), 840 W (X862/X864)
documents.

Scanning

The product is scanning hard‑copy documents.

200 W
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Mode

Description

Power consumption (Watts)

Ready

The product is waiting for a print job.

160 W

Standby

The product is in a high energy‑saving mode.

90 W

Power Saver The product is in a low energy‑saving mode.

22 W

Off

0.5 W

The product is plugged into a wall outlet, but the power switch is
turned off.

The power consumption levels listed in the previous table represent time-averaged measurements. Instantaneous
power draws may be substantially higher than the average.
Values are subject to change. See www.lexmark.com for current values.

Power Saver
This product is designed with an energy-saving mode called Power Saver. The Power Saver Mode is equivalent to the
EPA Sleep Mode. The Power Saver Mode saves energy by lowering power consumption during extended periods of
inactivity. The Power Saver Mode is automatically engaged after this product is not used for a specified period of time,
called the Power Saver Timeout.
Factory default Power Saver Timeout for this product (in minutes):

1 (X860), 5 (X862), 60 (X864)

Off mode
If this product has an off mode which still consumes a small amount of power, then to completely stop product power
consumption, disconnect the power supply cord from the wall outlet.

Total energy usage
It is sometimes helpful to calculate the total product energy usage. Since power consumption claims are provided in
power units of Watts, the power consumption should be multiplied by the time the product spends in each mode in
order to calculate energy usage. The total product energy usage is the sum of each mode's energy usage.

European Community (EC) directives conformity
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC and 2006/95/EC
on the approximation and harmonization of the laws of the Member States relating to electromagnetic compatibility
and safety of electrical equipment designed for use within certain voltage limits.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product satisfies the Class A limits of EN 55022 and safety requirements of EN 60950.

Industry Canada compliance statement
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Standard
ICES-003.
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Avis de conformité aux normes de l’industrie du Canada
Cet appareil numérique de classe A est conforme aux exigences de la norme canadienne relative aux équipements
pouvant causer des interférences NMB-003.

Radio interference notice
Warning
This is a product that complies with the emission requirements of EN55022 Class A limits and immunity requirements
of EN55024. This product is not intended to be used in residential/domestic environments.
This is a Class A product. In a domestic environment, this product may cause radio interference, in which case the user
may be required to take adequate measures.

CCC EMC notice

BSMI EMC notice
This is a CNS-13438 EMC Class A product. Please be aware of the notice below:
Warning to user:
This is a Class A ITE. In a residential area, this product may cause radio interference, in which case the user may be required
to take adequate measures.

Regulatory notices for telecommunication terminal equipment
This section contains regulatory information pertaining to products that contain telecommunication terminal
equipment such as facsimile.

Notice to users of the US telephone network: FCC requirements
This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council
for Terminal Attachments (ACTA). On the back of this equipment is a label that contains, among other information, a
product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to your telephone
company.
This equipment uses the RJ-11C Universal Service Order Code (USOC) jack.
A plug and jack used to connect this equipment to the premises’ wiring and telephone network must comply with the
applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular plug is
provided with this product. It is designed to be connected to a compatible modular jack that is also compliant. See your
setup documentation for more information.
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The Ringer Equivalence Number (REN) is used to determine the number of devices that may be connected to a telephone
line. Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming call. In most
but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact your local telephone company. For products approved
after July 23, 2001, the REN for this product is part of the product identifier that has the format US:AAAEQ##TXXXX.
The digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products,
the REN is shown separately on the label.
If this equipment causes harm to the telephone network, the telephone company will notify you in advance that
temporary discontinuance of service may be required. If advance notice is not practical, the telephone company will
notify the customer as soon as possible. You will also be advised of your right to file a complaint with the FCC.
The telephone company may make changes in its facilities, equipment, operations or procedures that could affect the
operation of this equipment. If this happens, the telephone company will provide advance notice in order for you to
make necessary modifications to maintain uninterrupted service.
If you experience trouble with this equipment, for repair or warranty information, contact Lexmark International, Inc.
at www.lexmark.com or your Lexmark representative. If the equipment is causing harm to the telephone network, the
telephone company may request that you disconnect the equipment until the problem is resolved.
This equipment contains no user serviceable parts. For repair and warranty information, contact Lexmark International,
Inc. See the previous paragraph for contact information.
Connection to party line service is subject to state tariffs. Contact the state public utility commission, public service
commission, or corporation commission for information.
If your home has specially wired alarm equipment connected to the telephone line, ensure the installation of this
equipment does not disable your alarm equipment. If you have questions about what will disable alarm equipment,
consult your telephone company or a qualified installer.
Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter's
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic
device, including fax machines, to send any message unless said message clearly contains in a margin at the top or
bottom of each transmitted page or on the first page of the transmission, the date and time it is sent and an identification
of the business or other entity, or other individual sending the message, and the telephone number of the sending
machine or such business, other entity, or individual. (The telephone number provided may not be a 900 number or
any other number for which charges exceed local or long-distance transmission charges.)
See your user documentation in order to program this information into your fax machine.

South Africa telecommunications notice
This modem must be used in conjunction with an approved surge protection device when connected to the PSTN.

Notice to users of the Canadian telephone network
This product meets the applicable Industry Canada technical specifications. The Ringer Equivalence Number (REN) is
an indication of the maximum number of terminals allowed to be connected to a telephone interface. The terminus of
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an interface may consist of any combination of devices, subject only to the requirement that the sum of the RENs of
all the devices does not exceed five. The modem REN is located on the rear of the equipment on the product labeling.
Telephone companies report that electrical surges, typically lightning transients, are very destructive to customer
terminal equipment connected to AC power sources. This has been identified as a major nationwide problem. It is
recommended that the customer install an appropriate AC surge arrestor in the AC outlet to which this device is
connected. An appropriate AC surge arrestor is defined as one that is suitably rated, and certified by UL (Underwriter’s
Laboratories), another NRTL (Nationally Recognized Testing Laboratory), or a recognized safety certification body in
the country/region of use. This is to avoid damage to the equipment caused by local lightning strikes and other electrical
surges.
This equipment uses CA11A telephone jacks.

Avis réservé aux utilisateurs du réseau téléphonique du Canada
Ce produit est conforme aux spécifications techniques d’Industrie Canada. Le numéro REN (ringer equivalence number :
numéro d’équivalence de sonnerie) fournit une indication du nombre maximum de terminaux pouvant être connectés
à l’interface téléphonique. En bout de ligne, le nombre d’appareils qui peuvent être connectés n’est pas directement
limité, mais la somme des REN de ces appareils ne doit pas dépasser cinq. Le numéro REN du modem est indiqué sur
l’étiquette produit située à l’arrière de l’équipement.
Les compagnies de téléphone constatent que les surtensions électriques, en particulier celles dues à la foudre,
entraînent d'importants dégâts sur les terminaux privés connectés à des sources d’alimentation CA. Il s’agit-là d’un
problème majeur d’échelle nationale. En conséquence, il vous est recommandé de brancher un parasurtenseur dans
la prise de courant à laquelle l’équipement est connecté. Utilisez un parasurtenseur répondant à des caractéristiques
nominales satisfaisantes et certifié par le laboratoire d’assureurs UL (Underwriter’s Laboratories), un autre laboratoire
agréé de type NRTL (Nationally Recognized Testing Laboratory) ou un organisme de certification agréé dans votre région
ou pays. Ceci prévient tout endommagement de l’équipement causé par les orages et autres surtensions électriques.
Cet équipement utilise des prises de téléphone CA11A.

Notice to users of the New Zealand telephone network
The following are special conditions for the Facsimile User Instructions. The grant of a telepermit for any item of terminal
equipment indicates only that Telecom has accepted that the item complies with minimum conditions for connection
to its network. It indicates no endorsement of the product by Telecom, nor does it provide any sort of warranty. Above
all, it provides no assurance that any item will work correctly in all respects with another item of telepermitted
equipment of a different make or model, nor does it imply that any product is compatible with all of Telecom's network
services.
This equipment shall not be set up to make automatic calls to the Telecom's 111 Emergency Service.
This equipment may not provide for the effective hand-over of a call to another device connected to the same line.
This equipment should not be used under any circumstances that may constitute a nuisance to other Telecom
customers.
Some parameters required for compliance with Telecom's telepermit requirements are dependent on the equipment
associated with this device. The associated equipment shall be set to operate within the following limits for compliance
to Telecom's specifications:

• There shall be no more than 10 call attempts to the same number within any 30 minute period for any single manual
call initiation, and

• The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt and the
beginning of the next call attempt.
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• The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is not
less than 5 seconds between the end of one call attempt and the beginning of another.

Using this product in Switzerland
This product requires a Swiss billing tone filter (Lexmark part number 14B5109 or 80D1877) to be installed on any line
which receives metering pulses in Switzerland. The Lexmark filter must be used, as metering pulses are present on all
analog telephone lines in Switzerland.

Utilisation de ce produit en Suisse
Cet appareil nécessite l’utilisation d’un filtre de tonalité de facturation suisse (nº de référence Lexmark : 14B5109 ou
80D1877) devant être installé sur toute ligne recevant des impulsions de comptage en Suisse. Ce filtre doit être utilisé
pour toute installation car ces impulsions existent sur toutes les lignes téléphoniques suisses.

Verwendung dieses Produkts in der Schweiz
Für dieses Produkt muss ein schweizerischer Billing Tone Filter zur Zählzeichenübertragung (Lexmark Teilenummer
14B5109 oder 80D1877) für jede Leitung installiert werden, über die in der Schweiz Zeitsteuertakte übertragen werden.
Die Verwendung des Lexmark Filters ist obligatorisch, da in allen analogen Telefonleitungen in der Schweiz
Zeitsteuertakte vorhanden sind.

Uso del prodotto in Svizzera
Questo prodotto richiede un filtro toni Billing svizzero, (codice Lexmark 14B5109 o 80D1877) da installare su tutte le
linee che ricevono impulsi remoti in Svizzera. È necessario utilizzare il filtro Lexmark poiché gli impulsi remoti sono
presenti su tutte le linee analogiche in Svizzera.

Notice to Users in the European Union
Products bearing the CE mark are in conformity with the protection requirements of EC Council directives 2004/108/EC,
2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the Member States relating to
electromagnetic compatibility, safety of electrical equipment designed for use within certain voltage limits and on radio
equipment and telecommunications terminal equipment.
Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
Refer to the table at the end of the Notices section for further compliance information.
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Regulatory notices for wireless products
This section contains the following regulatory information pertaining to wireless products that contain transmitters,
for example, but not limited to, wireless network cards or proximity card readers.

Exposure to radio frequency radiation
The radiated output power of this device is far below the radio frequency exposure limits of the FCC and other regulatory
agencies. A minimum separation of 20 cm (8 inches) must be maintained between the antenna and any persons for
this device to satisfy the RF exposure requirements of the FCC and other regulatory agencies.

Notice to users in Brazil
Este equipamento opera em carater secundario, isto e, nao tem direito a protecao contra interferencia prejudicial,
mesmo de estacoes do mesmo tipo, e nao pode causar interferencia a sistemas operando em carater primario.
(Res.ANATEL 282/2001).

Industry Canada (Canada)
This device complies with Industry Canada specification RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that
may cause undesired operation of the device.
This device has been designed to operate only with the antenna provided. Use of any other antenna is strictly prohibited
per regulations of Industry Canada.
To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to
licensing.
The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF
fields in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health
Canada's Web site www.hc-sc.gc.ca/rpb.
The term "IC:" before the certification/registration number only signifies that the Industry Canada technical
specifications were met.

Industry Canada (Canada)
Cet appareil est conforme à la norme RSS-210 d'Industry Canada. Son fonctionnement est soumis aux deux conditions
suivantes :
(1) cet appareil ne doit pas provoquer d'interférences et (2) il doit accepter toute interférence reçue, y compris celles
risquant d'altérer son fonctionnement.
Cet appareil a été conçu pour fonctionner uniquement avec l'antenne fournie. L'utilisation de toute autre antenne est
strictement interdite par la réglementation d'Industry Canada.
En application des réglementations d'Industry Canada, l'utilisation d'une antenne de gain supérieur est strictement
interdite.
Pour empêcher toute interférence radio au service faisant l'objet d'une licence, cet appareil doit être utilisé à l'intérieur
et loin des fenêtres afin de garantir une protection optimale.
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Si le matériel (ou son antenne d'émission) est installé à l'extérieur, il doit faire l'objet d'une licence.
L'installateur de cet équipement radio doit veiller à ce que l'antenne soit implantée et dirigée de manière à n'émettre
aucun champ HF dépassant les limites fixées pour l'ensemble de la population par Santé Canada. Reportez-vous au
Code de sécurité 6 que vous pouvez consulter sur le site Web de Santé Canada www.hc-sc.gc.ca/rpb.
Le terme « IC » précédant le numéro de d'accréditation/inscription signifie simplement que le produit est conforme
aux spécifications techniques d'Industry Canada.

Taiwan NCC RF notice statement

India emissions notice
This device uses very low power low range RF communication that has been tested and found not to cause any
interference whatsoever. The manufacturer is not responsible in case of any disputes arising out of requirement of
permissions from any local authority, regulatory bodies or any organization, required by the end-user to install and
operate this product at his premises.

Notice to users in the European Union
This product is in conformity with the protection requirements of EC Council directives 2004/108/EC, 2006/95/EC and
2005/32/EC on the approximation and harmonization of the laws of the Member States relating to electromagnetic
compatibility, safety of electrical equipment designed for use within certain voltage limits and the ecodesign of energyusing products.
Compliance is indicated by the CE marking.

The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
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This product satisfies the Class A limits of EN 55022 and safety requirements of EN 60950.
Products equipped with 2.4GHz Wireless LAN option are in conformity with the protection requirements of EC Council
directives 2004/108/EC, 2006/95/EC, and 1999/5/EC on the approximation and harmonization of the laws of the
Member States relating to electromagnetic compatibility, safety of electrical equipment designed for use within certain
voltage limits and on radio equipment and telecommunications terminal equipment.
Compliance is indicated by the CE marking.

Operation is allowed in all EU and EFTA countries, but is restricted to indoor use only.
The manufacturer of this product is: Lexmark International, Inc., 740 West New Circle Road, Lexington, KY, 40550 USA.
The authorized representative is: Lexmark International Technology Hungária Kft., 8 Lechner Ödön fasor, Millennium
Tower III, 1095 Budapest HUNGARY, A declaration of conformity to the requirements of the Directives is available upon
request from the Authorized Representative.
This product may be used in the countries indicated in the table below.
AT

BE

BG

CH

CY

CZ

DE

DK

EE

EL

ES

FI

FR

HR

HU

IE

IS

IT

LI

LT

LU

LV

MT

NL

NO

PL

PT

RO

SE

SI

SK

TR

UK

Česky

Společnost Lexmark International, Inc. tímto prohlašuje, že výrobek tento výrobek je ve shodě se základními
požadavky a dalšími příslušnými ustanoveními směrnice 1999/5/ES.

Dansk

Lexmark International, Inc. erklærer herved, at dette produkt overholder de væsentlige krav og øvrige relevante
krav i direktiv 1999/5/EF.

Deutsch

Hiermit erklärt Lexmark International, Inc., dass sich das Gerät dieses Gerät in Übereinstimmung mit den
grundlegenden Anforderungen und den übrigen einschlägigen Bestimmungen der Richtlinie 1999/5/EG
befindet.

Ελληνική

ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Η LEXMARK INTERNATIONAL, INC. ΔΗΛΩΝΕΙ ΟΤΙ ΑΥΤΟ ΤΟ ΠΡΟΪΟΝ
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

English

Hereby, Lexmark International, Inc., declares that this type of equipment is in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

Español

Por medio de la presente, Lexmark International, Inc. declara que este producto cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/CE.

Eesti

Käesolevaga kinnitab Lexmark International, Inc., et seade see toode vastab direktiivi 1999/5/EÜ
põhinõuetele ja nimetatud direktiivist tulenevatele muudele asjakohastele sätetele.

Suomi

Lexmark International, Inc. vakuuttaa täten, että tämä tuote on direktiivin 1999/5/EY oleellisten vaatimusten
ja muiden sitä koskevien direktiivin ehtojen mukainen.

Français

Par la présente, Lexmark International, Inc. déclare que l'appareil ce produit est conforme aux exigences
fondamentales et autres dispositions pertinentes de la directive 1999/5/CE.

Magyar

Alulírott, Lexmark International, Inc. nyilatkozom, hogy a termék megfelel a vonatkozó alapvetõ
követelményeknek és az 1999/5/EC irányelv egyéb elõírásainak.
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Íslenska

Hér með lýsir Lexmark International, Inc. yfir því að þessi vara er í samræmi við grunnkröfur og aðrar
kröfur, sem gerðar eru í tilskipun 1999/5/EC.

Italiano

Con la presente Lexmark International, Inc. dichiara che questo questo prodotto è conforme ai requisiti
essenziali ed alle altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE.

Latviski

Ar šo Lexmark International, Inc. deklarē, ka šis izstrādājums atbilst Direktīvas 1999/5/EK būtiskajām
prasībām un citiem ar to saistītajiem noteikumiem.

Lietuvių

Šiuo Lexmark International, Inc. deklaruoja, kad šis produktas atitinka esminius reikalavimus ir kitas
1999/5/EB direktyvos nuostatas.

Malti

Bil-preżenti, Lexmark International, Inc., jiddikjara li dan il-prodott huwa konformi mal-ħtiġijiet
essenzjali u ma dispożizzjonijiet oħrajn relevanti li jinsabu fid-Direttiva 1999/5/KE.

Nederlands Hierbij verklaart Lexmark International, Inc. dat het toestel dit product in overeenstemming is met de essentiële
eisen en de andere relevante bepalingen van richtlijn 1999/5/EG.
Norsk

Lexmark International, Inc. erklærer herved at dette produktet er i samsvar med de grunnleggende krav og
øvrige relevante krav i direktiv 1999/5/EF.

Polski

Niniejszym Lexmark International, Inc. oświadcza, że niniejszy produkt jest zgodny z zasadniczymi
wymogami oraz pozostałymi stosownymi postanowieniami Dyrektywy 1999/5/EC.

Português

A Lexmark International Inc. declara que este este produto está conforme com os requisitos essenciais e outras
disposições da Diretiva 1999/5/CE.

Slovensky Lexmark International, Inc. týmto vyhlasuje, že tento produkt spĺňa základné požiadavky a všetky
príslušné ustanovenia smernice 1999/5/ES.
Slovensko Lexmark International, Inc. izjavlja, da je ta izdelek v skladu z bistvenimi zahtevami in ostalimi
relevantnimi določili direktive 1999/5/ES.
Svenska

Härmed intygar Lexmark International, Inc. att denna produkt står i överensstämmelse med de väsentliga
egenskapskrav och övriga relevanta bestämmelser som framgår av direktiv 1999/5/EG.

STATEMENT OF LIMITED WARRANTY FOR LEXMARK LASER PRINTERS,
LEXMARK LED PRINTERS, AND LEXMARK MULTIFUNCTION LASER PRINTERS
Lexmark International, Inc., Lexington, KY
This limited warranty applies to the United States and Canada. For customers outside the U.S., refer to the countryspecific warranty information that came with your product.
This limited warranty applies to this product only if it was originally purchased for your use, and not for resale, from
Lexmark or a Lexmark Remarketer, referred to in this statement as “Remarketer.”

Limited warranty
Lexmark warrants that this product:
—Is manufactured from new parts, or new and serviceable used parts, which perform like new parts
—Is, during normal use, free from defects in material and workmanship
If this product does not function as warranted during the warranty period, contact a Remarketer or Lexmark for repair
or replacement (at Lexmark's option).
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If this product is a feature or option, this statement applies only when that feature or option is used with the product
for which it was intended. To obtain warranty service, you may be required to present the feature or option with the
product.
If you transfer this product to another user, warranty service under the terms of this statement is available to that user
for the remainder of the warranty period. You should transfer proof of original purchase and this statement to that
user.

Limited warranty service
The warranty period starts on the date of original purchase as shown on the purchase receipt and ends 12 months later
provided that the warranty period for any supplies and for any maintenance items included with the printer shall end
earlier if it, or its original contents, are substantially used up, depleted, or consumed. Fuser Units, Transfer/Transport
Units, Paper Feed items, if any, and any other items for which a Maintenance Kit is available are substantially consumed
when the printer displays a “Life Warning” or “Scheduled Maintenance” message for such item.
To obtain warranty service you may be required to present proof of original purchase. You may be required to deliver
your product to the Remarketer or Lexmark, or ship it prepaid and suitably packaged to a Lexmark designated location.
You are responsible for loss of, or damage to, a product in transit to the Remarketer or the Lexmark designated location.
When warranty service involves the exchange of a product or part, the item replaced becomes the property of the
Remarketer or Lexmark. The replacement may be a new or repaired item.
The replacement item assumes the remaining warranty period of the original product.
Replacement is not available to you if the product you present for exchange is defaced, altered, in need of a repair not
included in warranty service, damaged beyond repair, or if the product is not free of all legal obligations, restrictions,
liens, and encumbrances.
As part of your warranty service and/or replacement, Lexmark may update the firmware in your printer to the latest
version. Firmware updates may modify printer settings and cause counterfeit and/or unauthorized products, supplies,
parts, materials (such as toners and inks), software, or interfaces to stop working. Authorized use of genuine Lexmark
products will not be impacted.
Before you present this product for warranty service, remove all print cartridges, programs, data, and removable storage
media (unless directed otherwise by Lexmark).
For further explanation of your warranty alternatives and the nearest Lexmark authorized servicer in your area contact
Lexmark on the World Wide Web.
Remote technical support is provided for this product throughout its warranty period. For products no longer covered
by a Lexmark warranty, technical support may not be available or only be available for a fee.

Extent of limited warranty
Lexmark does not warrant uninterrupted or error-free operation of any product or the durability or longevity of prints
produced by any product.
Warranty service does not include repair of failures caused by:
—Modification or unauthorized attachments
—Accidents, misuse, abuse or use inconsistent with Lexmark user’s guides, manuals, instructions or guidance
—Unsuitable physical or operating environment
—Maintenance by anyone other than Lexmark or a Lexmark authorized servicer
—Operation of a product beyond the limit of its duty cycle
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—Use of printing media outside of Lexmark specifications
—Refurbishment, repair, refilling or remanufacture by a third party of products, supplies or parts
—Products, supplies, parts, materials (such as toners and inks), software, or interfaces not furnished by Lexmark
TO THE EXTENT PERMITTED BY APPLICABLE LAW, NEITHER LEXMARK NOR ITS THIRD PARTY SUPPLIERS OR
REMARKETERS MAKE ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED, WITH
RESPECT TO THIS PRODUCT, AND SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND SATISFACTORY QUALITY. ANY WARRANTIES THAT
MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE WARRANTY PERIOD. NO
WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. ALL INFORMATION, SPECIFICATIONS, PRICES,
AND SERVICES ARE SUBJECT TO CHANGE AT ANY TIME WITHOUT NOTICE.

Limitation of liability
Your sole remedy under this limited warranty is set forth in this document. For any claim concerning performance or
nonperformance of Lexmark or a Remarketer for this product under this limited warranty, you may recover actual
damages up to the limit set forth in the following paragraph.
Lexmark's liability for actual damages from any cause whatsoever will be limited to the amount you paid for the product
that caused the damages. This limitation of liability will not apply to claims by you for bodily injury or damage to real
property or tangible personal property for which Lexmark is legally liable. IN NO EVENT WILL LEXMARK BE LIABLE FOR
ANY LOST PROFITS, LOST SAVINGS, INCIDENTAL DAMAGE, OR OTHER ECONOMIC OR CONSEQUENTIAL DAMAGES.
This is true even if you advise Lexmark or a Remarketer of the possibility of such damages. Lexmark is not liable for any
claim by you based on a third party claim.
This limitation of remedies also applies to claims against any Suppliers and Remarketers of Lexmark. Lexmark's and its
Suppliers' and Remarketers' limitations of remedies are not cumulative. Such Suppliers and Remarketers are intended
beneficiaries of this limitation.

Additional rights
Some states do not allow limitations on how long an implied warranty lasts, or do not allow the exclusion or limitation
of incidental or consequential damages, so the limitations or exclusions contained above may not apply to you.
This limited warranty gives you specific legal rights. You may also have other rights that vary from state to state.

Patent acknowledgment
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Elliptic Curve Cryptography (ECC) Cipher Suites for Transport
Layer Security (TLS) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Elliptic Curve Cipher Suites with SHA-256/382 and AES Galois
Counter Mode (GCM) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for TLS Suite B Profile for Transport Layer Security (TLS) implemented
in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Addition of the Camellia Cipher Suites to Transport Layer Security
(TLS) implemented in the product or service.
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The use of certain patents in this product or service is subject to the reasonable, non-discriminatory terms in the
Intellectual Property Rights (IPR) Disclosure of Certicom Corp. at the IETF for AES-CCM ECC Cipher Suites for TLS
implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for IKE and IKEv2 Authentication Using the Eliptic Curve Digital
Signature Algorithm (ECDSA) implemented in the product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Suite B Cryptographic Suites for IPSec implemented in the
product or service.
The use of this product or service is subject to the reasonable, non-discriminatory terms in the Intellectual Property
Rights (IPR) Disclosure of Certicom Corp. at the IETF for Algorithms for Internet Key Exchange version 1 (IKEv1)
implemented in the product or service.
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Index
Numerics
1,150‑‑sheet tray
loading 58
1565 Emulation error, load
emulation option 233
2,000‑sheet dual input trays
installing 35
loading 58
2,000‑sheet high capacity feeder
installing 35
2000‑sheet high capacity feeder
loading 56
298.01 Scanner Missing 233
30 Invalid refill, change
cartridge 226
31.yy Replace defective or missing
cartridge 227
32 Cartridge part number
unsupported by device 227
34 Incorrect media, check <input
src> guides 227
34 Short paper 227
35 Insufficient memory to support
Resource Save feature 227
37 Insufficient memory for Flash
Memory Defragment
operation 228
37 Insufficient memory to collate
job 227
37 Insufficient memory, some Held
Jobs were deleted 228
37 Insufficient memory, some held
jobs will not be restored 228
38 Memory full 228
39 Complex page, some data may
not have printed 228
50 PPDS font error 228
500‑sheet tray (standard or
optional)
loading 53
500‑sheet trays
installing 35
51 Defective flash detected 229
52 Not enough free space in flash
memory for resources 229
53 Unformatted flash detected 229
54 Network <x> software error 229
54 Serial option <x> error 229

54 Standard network software
error 229
55 Unsupported option in slot 230
56 Parallel port <x> disabled 230
56 Serial port <x> disabled 230
56 Standard parallel port
disabled 230
56 Standard USB port disabled 230
56 USB port <x> disabled 231
57 Configuration change, held jobs
were not restored 231
58 Too many bins attached 231
58 Too many disks installed 231
58 Too many flash options
installed 231
58 Too many trays attached 232
61 Remove defective disk 232
62 Disk full 232
63 Unformatted disk 232
80 Routine maintenance
needed 232
84 Insert photoconductor 232
84 Photoconductor abnormal 233
84 Photoconductor low 233
84 Replace photoconductor 233
850‑sheet tray
loading 58
88 Cartridge low 233
88 Replace cartridge to
continue 233

Symbols
“scan to computer” screen
options 126, 127, 128

A
Active NIC menu 142
address book, fax
using 113
ADF
copying using 85
adjusting toner darkness 84
An error has occurred with the flash
drive 218
AppleTalk menu 148
attaching cables 36
Automatic Document Feeder
(ADF) 13

B
Bin Setup menu 139
Booklet Adjustments menu 195
brightness, adjusting 215
buttons, home screen 15
buttons, printer control panel 14
buttons, touch screen 17

C
cables
Ethernet 36
USB 36
canceling
print job, from computer 81
canceling a job
from the printer control panel 81
canceling a print job
from a computer 81
card stock
loading 60
tips 76
Change <input src> to <Custom
String> 218
Change <input src> to <Custom
String> load <orientation> 219
Change <input src> to <Custom
Type Name> 218
Change <input src> to <Custom
Type Name> load
<orientation> 218
Change <input src> to <size> 219
Change <input src> to <size> load
<orientation> 219
Change <input src> to <type>
<size> 219
Change <input src> to <type> <size>
load <orientation> 220
Check <input src> guides 220
Check <input src> orientation or
guides 220
checking an unresponsive
printer 217
checking an unresponsive
scanner 265
checking device status
on Embedded Web Server 215
checking virtual display
on Embedded Web Server 214

Index

cleaning
exterior of the printer 198
scanner glass 199
cleaning kit
ordering 202
clearing jams
289 staple error 251
Close cover <x> 220
Close door <x> 220
Close surface H 220
collating copies 90
color documents
e‑mailing 102
Confidential print jobs 77
printing from Macintosh
computer 78
printing from Windows 77
Confidential Print menu 151
configuration information
wireless network 40
configurations
printer 11
Configure MP menu 133
configuring port settings 48
configuring the e‑mail settings 99
connecting the printer to
distinctive ring service 108
regional adapters 109
conservation settings
Power Saver 22
Quiet Mode 22
conserving supplies 200
contacting customer support 285
control panel, printer 14
copy quality
adjusting 89
improving 97
copy screen
options 94, 95
Copy Settings menu 158
copy troubleshooting
copier does not respond 263
partial document or photo
copies 265
poor copy quality 264
poor scanned image quality 266
scanner unit does not close 263
copying
adding a date and time stamp 92
adding an overlay message 93
adjusting quality 89
canceling a copy job 93
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collating copies 90
custom job (job build) 92
document containing mixed paper
sizes 88
enlarging 89
from one size to another 87
improving copy quality 97
making transparencies 86
multiple pages on one sheet 91
on both sides of the paper
(duplexing) 89
photos 86
placing separator sheets between
copies 90
quick copy 85
reducing 89
selecting a tray 87
to letterhead 87
using the ADF 85
using the scanner glass
(flatbed) 86
Custom Bin Names menu 138
Custom Names menu 137
custom paper type
assigning 63
Custom Scan Sizes menu 138
Custom Type <x>
changing name 63
Custom Types menu 137
customer support
contacting 285

D
date and time
setting 110
Default Source menu 130
directory list, printing 80
Disk corrupted 221
Disk Full ‑ Scan Job Canceled 221
Disk Wiping menu 152
display troubleshooting
display is blank 217
display shows only diamonds 217
display, printer control panel 14
adjusting brightness 215
distinctive ring service
connecting to 108
documents, printing
for Macintosh users 72
for Windows users 72
duplex unit
installing 35

duplexing 89

E
Embedded Web Server 214
administrator settings 214
checking device status 215
does not open 217
networking settings 214
setting up e‑mail alerts 215
Embedded Web Server
Administrator's Guide 214
emission
notices 289, 292, 293, 297, 298
Empty hole punch box 221
enlarging a copy 89
envelopes
loading 60
tips 75
environmental settings
Power Saver 22
Quiet Mode 22
Ethernet network setup
using Macintosh 45
using Windows 45
Ethernet networking
Macintosh 45
Windows 45
Ethernet port 36
exterior of the printer
cleaning 198
e‑mail
canceling 102
notice of low supply level 215
notice of paper jam 215
notice of paper needed 215
notice that different paper is
needed 215
e‑mail function
setting up 98
e‑mail screen
advanced options 104
options 102, 103
E‑mail Settings menu 171
e‑mailing
adding message line 101
adding subject line 101
changing output file type 101
color documents 102
configuring the e‑mail settings 99
creating shortcuts using the
Embedded Web Server 99

Index

creating shortcuts using the touch
screen 99
setting up e‑mail function 98
using shortcut numbers 100
using the address book 100
using the touch screen 100

F
factory defaults, restoring
printer control panel menus 216
fax connection
connecting the printer to the wall
jack 107
connecting to a DSL line 107
connecting to a PBX or ISDN 108
fax connections
distinctive ring service 108
regional adapters 109
Fax memory full 221
Fax Mode (Analog Fax Setup)
menu 162
Fax Mode (Fax Server Setup)
menu 170
fax quality, improving 117
fax screen
advanced options 117
options 116, 117
Fax server 'To Format' not set up.
Contact system administrator. 221
Fax Station Name not set up 221
Fax Station Number not set up 221
fax troubleshooting
blocking junk faxes 115
caller ID is not shown 267
can receive but not send
faxes 270
can send but not receive
faxes 269
cannot send or receive a fax 268
received fax has poor print
quality 270
faxing
canceling a fax job 115, 116
changing resolution 114
choosing a fax connection 106
creating shortcuts using the
Embedded Web Server 111, 112
creating shortcuts using the touch
screen 112
fax setup 105
forwarding faxes 118
holding faxes 118

306

improving fax quality 117
making a fax lighter or darker 114
sending a fax at a scheduled
time 114
sending using the computer 111
sending using the printer control
panel 110
setting the date and time 110
setting the outgoing fax name and
number 110
using shortcuts 113
using the address book 113
viewing a fax log 115
FCC notices 289, 293, 297
finding more information about the
printer 9
finisher
finishing features 82
supported paper sizes 82
Finishing menu 186
firmware card
installing 29
flash drive 79
Flash Drive menu 179
flash memory card
installing 29
troubleshooting 273
font sample list
printing 80
forwarding faxes 118
FTP
address book 121
FTP quality, improving 124
FTP screen
advanced options 123
options 122, 123
FTP Settings menu 176

G
General Settings menu 154
green settings
Power Saver 22

H
hard disk
installing 31
hard disk with adapter
troubleshooting 273
held jobs 77
printing from Macintosh
computer 78

printing from Windows 77
Help menu 196
holding faxes 118
home screen
buttons 15
HTML menu 194

I
Image menu 195
Insert Tray <x> 222
installing on a wireless network
using Windows 41
installing options
order of installation 34
installing printer
on wireless network 41
installing printer on a network
Ethernet networking 45
installing printer on a wireless
network
using Macintosh 42
installing printer software
adding options 39
installing printer software
(Windows) 38
internal print server
installing 30
troubleshooting 273
Internal Solutions Port
changing port settings 48
troubleshooting 273
IPv6 menu 147

J
jams
avoiding 233
locating jam areas 234
locations 234
numbers 234
jams, clearing
200–201 236
202 237
203 238
230 238
231 238
24x 244
250 248
280–281 248
282 248
283 251
284 254

Index

285–286 254
287–288 254
290–294 257
293 259

L
labels, paper
tips 76
letterhead
copying to 87
loading, 2000‑sheet high capacity
feeder 56
loading, multipurpose tray 73
loading, trays 73
tips 73
letterhead, printing on
for Macintosh users 73
for Windows users 73
LexLink menu 149
light, indicator 14
linking trays 62
Load <input src> with <Custom
String> 222
Load <input src> with <Custom
Type Name> 222
Load <input src> with <size> 223
Load <input src> with <type>
<size> 222
Load <src> with <x> 222
Load Manual Feeder with <Custom
String> 223
Load Manual Feeder with <Custom
Type Name> 223
Load Manual Feeder with
<size> 224
Load Manual Feeder with <type>
<size> 224
Load manual feeder with <x> 223
Load Staples 224
loading
1,150‑sheet tray 58
2,000‑sheet dual input trays 58
2000‑sheet high capacity
feeder 56
500‑sheet tray (standard or
optional) 53
850‑sheet tray 58
card stock 60
envelopes 60
letter or A4 size 62
letterhead in 2000‑sheet high
capacity feeder 56
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letterhead in multipurpose
tray 73
letterhead in trays 73
multipurpose feeder 60
transparencies 60

M
maintenance kit
ordering 201
memory card
installing 27
troubleshooting 273
Memory full, cannot print
faxes 224
menu settings page
printing 37
menus
Active NIC 142
AppleTalk 148
Bin Setup 139
Booklet Adjustments 195
Confidential Print 151
Configure MP 133
Copy Settings 158
Custom Bin Names 138
Custom Names 137
Custom Scan Sizes 138
Custom Types 137
Default Source 130
diagram of 129
Disk Wiping 152
E‑mail Settings 171
Fax Mode (Analog Fax Setup) 162
Fax Mode (Fax Server Setup) 170
Finishing 186
Flash Drive 179
FTP Settings 176
General Settings 154
Help 196
HTML 194
Image 195
IPv6 147
LexLink 149
Miscellaneous 151
NetWare 149
Network <x> 142
Network Card 145
Network Reports 145
Paper Loading 136
Paper Size/Type 130
Paper Texture 134
PCL Emul 191

PDF 190
PostScript 191
Quality 188
Reports 140
Security Audit Log 153
Set Date/Time 153
Setup 184
SMTP Setup menu 149
Standard Network 142
Standard USB 144
Substitute Size 134
TCP/IP 146
Universal Setup 138
Utilities 189
Wireless 148
XPS 195
Miscellaneous menu 151
moving the printer 209, 213
multiple pages on one sheet 91
multipurpose feeder
loading 60

N
NetWare menu 149
Network <x> menu 142
Network Card menu 145
Network Reports menu 145
network setup page 38
Networking Guide 214
noise
reducing 22
noise emission levels 289
notices 288, 289, 290, 291, 292,
293, 294, 295, 296, 297, 298, 299

O
options
2,000‑sheet dual input trays 35
2,000‑sheet high capacity
feeder 35
500‑sheet trays 35
duplex unit 35
fax card 25
firmware card 29
firmware cards 25
flash memory card 29
hard disk 31
internal 25
internal print server 30
memory card 27
memory cards 25

Index

networking 25
port interface card 30
ports 25
updating in printer driver 39
options, touch‑screen
copy 94, 95
e‑mail 102, 103, 104
fax 116, 117
FTP 122, 123
scan to computer 126, 127, 128
ordering
cleaning kit 202
maintenance kit 201
photoconductors 201
staple cartridges 202
ordering supplies
toner cartridge 201
output file type
changing 101

P
paper
A5 55
B5 56
characteristics 65
Executive 56
finishing features 82
letterhead 66
preprinted forms 66
recycled 21
selecting 66
setting size 52
setting type 52
Statement 55
storing 67
unacceptable 66
Universal Paper Size 138
Universal size setting 52
paper feed troubleshooting
message remains after jam is
cleared 274
paper jams
avoiding 233
paper jams, clearing
200–201 236
202 237
203 238
230 238
231 238
24x 244
250 248
280–281 248
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282 248
283 251
284 254
285–286 254
287–288 254
290–294 257
293 259
Paper Loading menu 136
Paper Size/Type menu 130
paper sizes, supported 67
Paper Texture menu 134
paper type
custom 63
paper types
supported by printer 70
where to load 70
paper weights
supported by printer 70
PCL Emul menu 191
PDF menu 190
photoconductor
replacing 204
photoconductors
ordering 201
photos
copying 86
port interface card 30
port settings
configuring 48
PostScript menu 191
Power Saver
adjusting 22
print job
canceling, from computer 81
print quality
cleaning the scanner glass 199
print quality test pages, printing 80
print quality troubleshooting
blank pages 275
clipped images 276
ghost images 276
gray background 277
poor transparency quality 285
print irregularities 278
print is too dark 279
print is too light 280
print quality test pages 275
repeating defects 281
skewed print 281
solid black streaks 281
solid white streaks 281
streaked horizontal lines 282

streaked vertical lines 283
toner fog or background
shading 283
toner rubs off 284
toner specks 285
print troubleshooting
error reading USB drive 260
held jobs do not print 261
incorrect characters print 262
incorrect margins 277
jammed page does not
reprint 274
job prints from wrong tray 262
job prints on wrong paper 262
job takes longer than
expected 261
jobs do not print 260
Large jobs do not collate 262
multiple‑language PDFs do not
print 260
paper curl 278
paper frequently jams 274
tray linking does not work 262
unexpected page breaks
occur 263
printer
configurations 11
minimum clearances 10
models 11
moving 209, 213
selecting a location 10
shipping 213
printer control panel 14
factory defaults, restoring 216
printer information
where to find 9
printer messages
1565 Emulation error, load
emulation option 233
298.01 Scanner Missing 233
30 Invalid refill, change
cartridge 226
31.yy Replace defective or missing
cartridge 227
32 Cartridge part number
unsupported by device 227
34 Incorrect media, check <input
src> guides 227
34 Short paper 227
35 Insufficient memory to support
Resource Save feature 227

Index

37 Insufficient memory for Flash
Memory Defragment
operation 228
37 Insufficient memory to collate
job 227
37 Insufficient memory, some
Held Jobs were deleted 228
37 Insufficient memory, some held
jobs will not be restored 228
38 Memory full 228
39 Complex page, some data may
not have printed 228
50 PPDS font error 228
51 Defective flash detected 229
52 Not enough free space in flash
memory for resources 229
53 Unformatted flash
detected 229
54 Network <x> software
error 229
54 Serial option <x> error 229
54 Standard network software
error 229
55 Unsupported option in
slot 230
56 Parallel port <x> disabled 230
56 Serial port <x> disabled 230
56 Standard parallel port
disabled 230
56 Standard USB port
disabled 230
56 USB port <x> disabled 231
57 Configuration change, held jobs
were not restored 231
58 Too many bins attached 231
58 Too many disks installed 231
58 Too many flash options
installed 231
58 Too many trays attached 232
61 Remove defective disk 232
62 Disk full 232
63 Unformatted disk 232
80 Routine maintenance
needed 232
84 Insert photoconductor 232
84 Photoconductor abnormal 233
84 Photoconductor low 233
84 Replace photoconductor 233
88 Cartridge low 202, 233
88 Replace cartridge to
continue 202, 233
88.yy Replace cartridge 202
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an error has occurred with the
flash drive 218
Change <input src> to <Custom
String> 218
Change <input src> to <Custom
String> load <orientation> 219
Change <input src> to <Custom
Type Name> 218
Change <input src> to <Custom
Type Name> load
<orientation> 218
Change <input src> to <size> 219
Change <input src> to <size> load
<orientation> 219
Change <input src> to <type>
<size> 219
Change <input src> to <type>
<size> load <orientation> 220
Check <input src> guides 220
Check <input src> orientation or
guides 220
Close cover <x> 220
Close door <x> 220
Close surface H 220
Disk corrupted 221
Disk Full ‑ Scan Job Canceled 221
Empty hole punch box 221
Fax memory full 221
Fax server 'To Format' not set up.
Contact system
administrator. 221
Fax Station Name not set up 221
Fax Station Number not set
up 221
Insert Tray <x> 222
Load <input src> with <Custom
String> 222
Load <input src> with <Custom
Type Name> 222
Load <input src> with <size> 223
Load <input src> with <type>
<size> 222
Load <src>with <x> 222
Load Manual Feeder with
<Custom String> 223
Load Manual Feeder with
<Custom Type Name> 223
Load Manual Feeder with
<size> 224
Load Manual Feeder with <type>
<size> 224
Load manual feeder with <x> 223

Load Staples 224
Memory full, cannot print
faxes 224
Remove paper from <linked bin
set name> 224
Remove paper from all bins 224
Remove paper from bin <x> 224
Remove paper from standard
output bin 225
Replace all originals if restarting
job. 225, 226
Restore Held Jobs? 225
Scan Document Too Long 226
Scanner ADF Cover Open 226
scanner jam 226
Scanner Jam Access Cover
Open 226
Serial <x> 226
SMTP server not set up. Contact
system administrator. 221
Some held jobs were not
restored 226
printer options troubleshooting
2,000‑sheet drawer 272
flash memory card 273
hard disk with adapter 273
internal print server 273
Internal Solutions Port 273
memory card 273
option not working 271
paper tray problems 272
USB/parallel interface card 274
printer problems, solving basic 217
printer software, installing
(Windows) 38
printing
directory list 80
font sample list 80
for Macintosh users 72
for Windows users 72
from flash drive 79
menu settings page 37
network setup page 38
print quality test pages 80
printing confidential and other held
jobs
from Macintosh computer 78
from Windows 77
printing on
A5 paper 55
B5 paper 56
Executive paper 56

Index

Statement paper 55
publications
where to find 9

Q
Quality menu 188
Quiet Mode 22

R
recycled paper
using 21
recycling
Lexmark products 23
toner cartridges 24
WEEE statement 290
reducing a copy 89
registration
scanner 199
Remove paper from <linked bin set
name> 224
Remove paper from all bins 224
Remove paper from bin <x> 224
Remove paper from standard
output bin 225
removing the optional trays 209
Repeat print jobs 77
printing from Macintosh
computer 78
printing from Windows 77
Replace all originals if restarting
job. 225, 226
replacing
photoconductor 204
reports
viewing 215
Reports menu 140
Reserve print jobs 77
printing from Macintosh
computer 78
printing from Windows 77
resolution, fax
changing 114
Restore Held Jobs? 225

S
safety information 7, 8
Scan Document Too Long 226
scan quality, improving 128
scan troubleshooting
cannot scan from a computer 267
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partial document or photo
scans 267
scan was not successful 266
scanner unit does not close 263
scanning takes too long or freezes
the computer 266
scanner
Automatic Document Feeder
(ADF) 13
functions 12
registration 199
scanner glass 13
Scanner ADF Cover Open 226
scanner glass
cleaning 199
scanner glass (flatbed)
copying using 86
scanner jam 226
Scanner Jam Access Cover
Open 226
scanning to a computer 125
improving scan quality 128
scanning to a flash drive 126
scanning to an FTP address
creating shortcuts using the
computer 121
creating shortcuts using the touch
screen 122
improving FTP quality 124
using shortcut numbers 121
using the address book 121
using the keypad 120
Security Audit Log menu 153
Serial <x> 226
serial printing
setting up 49
Set Date/Time menu 153
setting
paper size 52
paper type 52
TCP/IP address 146
Universal Paper Size 52
setting up serial printing 49
setting up the printer
on an Ethernet network
(Macintosh only) 45
on an Ethernet network (Windows
only) 45
Setup menu 184
shipping the printer 213
shortcuts, creating
e‑mail 99

fax destination 111, 112
FTP destination 121, 122
SMTP server not set up. Contact
system administrator. 221
SMTP Setup menu 149
Some held jobs were not
restored 226
Standard Network menu 142
standard tray
loading 53
Standard USB menu 144
staple cartridges
ordering 202
staple jam
289 staple error 251
status of supplies, checking 200
storing
paper 67
supplies 200
subject and message information
adding to e‑mail 101
Substitute Size menu 134
supplies
conserving 200
status of 200
storing 200
supplies, ordering 201
cleaning kit 202
maintenance kit 201
photoconductors 201
staple cartridges 202
system board
accessing 26
reinstalling 33

T
TCP/IP menu 146
telecommunication
notices 293, 294, 295, 296
tips
card stock 76
envelopes 75
labels, paper 76
letterhead 73
transparencies 75
toner cartridges
recycling 24
replacing 202
toner darkness
adjusting 84
touch screen
buttons 17

Index

transparencies
loading 60
making 86
tips 75
tray linking 63
tray unlinking 63
trays
linking 62, 63
unlinking 62, 63
troubleshooting
checking an unresponsive
printer 217
checking an unresponsive
scanner 265
solving basic printer
problems 217
troubleshooting, copy
copier does not respond 263
partial document or photo
copies 265
poor copy quality 264
poor scanned image quality 266
scanner unit does not close 263
troubleshooting, display
display is blank 217
display shows only diamonds 217
troubleshooting, fax
blocking junk faxes 115
caller ID is not shown 267
can receive but not send
faxes 270
can send but not receive
faxes 269
cannot send or receive a fax 268
received fax has poor print
quality 270
troubleshooting, paper feed
message remains after jam is
cleared 274
troubleshooting, print
error reading USB drive 260
held jobs do not print 261
incorrect characters print 262
incorrect margins 277
jammed page does not
reprint 274
job prints from wrong tray 262
job prints on wrong paper 262
job takes longer than
expected 261
jobs do not print 260
Large jobs do not collate 262
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multiple‑language PDFs do not
print 260
paper curl 278
paper frequently jams 274
tray linking does not work 262
unexpected page breaks
occur 263
troubleshooting, print quality
blank pages 275
clipped images 276
ghost images 276
gray background 277
poor transparency quality 285
print irregularities 278
print is too dark 279
print is too light 280
print quality test pages 275
repeating defects 281
skewed print 281
solid black streaks 281
solid white streaks 281
streaked horizontal lines 282
streaked vertical lines 283
toner fog or background
shading 283
toner rubs off 284
toner specks 285
troubleshooting, printer options
2,000‑sheet drawer 272
flash memory card 273
hard disk with adapter 273
internal print server 273
Internal Solutions Port 273
memory card 273
option not working 271
paper tray problems 272
USB/parallel interface card 274
troubleshooting, scan
cannot scan from a computer 267
partial document or photo
scans 267
scan was not successful 266
scanner unit does not close 263
scanning takes too long or freezes
the computer 266

U
Universal Paper Size
setting 52
Universal Setup menu 138
unlinking trays 62

updating options in printer
driver 39
USB port 36
Utilities menu 189

V
Verify print jobs 77
printing from Macintosh
computer 78
printing from Windows 77
viewing
reports 215
virtual display
how to access 214

W
Wireless menu 148
wireless network
configuration information 40
installation, using Macintosh 42
installation, using Windows 41
wireless network setup
in Windows 41
wireless printer setup
in Macintosh 42

X
XPS menu 195

